## You’ll Learn How To

<table>
<thead>
<tr>
<th>TASK</th>
<th>PAGES</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save files in different formats</td>
<td>24</td>
</tr>
<tr>
<td>View document statistics</td>
<td>80, 82</td>
</tr>
<tr>
<td>Correct spelling and grammar</td>
<td>91</td>
</tr>
<tr>
<td>Add a drop cap to a paragraph</td>
<td>163</td>
</tr>
<tr>
<td>Enhance documents with styles and themes</td>
<td>226, 242, 243</td>
</tr>
<tr>
<td>Set line and paragraph spacing and alignment</td>
<td>177, 191</td>
</tr>
<tr>
<td>Create a border around a paragraph</td>
<td>203</td>
</tr>
<tr>
<td>Insert headers, footers, and page watermarks</td>
<td>262, 274</td>
</tr>
<tr>
<td>Work with multiple columns and tables</td>
<td>277, 332, 367</td>
</tr>
<tr>
<td>Create your own document templates</td>
<td>297</td>
</tr>
<tr>
<td>Print labels, envelopes, note cards, and banners</td>
<td>323, 318, 327, 317</td>
</tr>
<tr>
<td>Insert pictures and apply picture styles and effects</td>
<td>382, 402</td>
</tr>
<tr>
<td>Create lines, shapes, and WordArt objects</td>
<td>421, 453</td>
</tr>
<tr>
<td>Work with charts and SmartArt diagrams</td>
<td>475, 524</td>
</tr>
<tr>
<td>Create math formulas with the Equation Editor</td>
<td>542</td>
</tr>
<tr>
<td>Merge letters with Mail Merge and create custom merges</td>
<td>553, 584</td>
</tr>
<tr>
<td>Insert hyperlinks and bookmarks</td>
<td>594, 601</td>
</tr>
<tr>
<td>Link to data in other files</td>
<td>612</td>
</tr>
<tr>
<td>Create forms with content controls and legacy form fields</td>
<td>650, 656, 625</td>
</tr>
<tr>
<td>Work with outlines and master documents</td>
<td>673, 691</td>
</tr>
<tr>
<td>Use sources and citations and generate a bibliography</td>
<td>703, 713</td>
</tr>
<tr>
<td>Work with footnotes, endnotes, and cross-references</td>
<td>717, 726</td>
</tr>
<tr>
<td>Create a table of contents and an index</td>
<td>731, 749</td>
</tr>
<tr>
<td>Use comments and revision tracking to collaborate with others</td>
<td>776, 773</td>
</tr>
<tr>
<td>Compare different versions of a document</td>
<td>778</td>
</tr>
<tr>
<td>Restrict access to a document</td>
<td>794</td>
</tr>
<tr>
<td>Create and save a web page</td>
<td>818</td>
</tr>
<tr>
<td>Use Office Web Apps and SkyDrive online</td>
<td>851, 937</td>
</tr>
<tr>
<td>Record macros and edit macro code in VBA</td>
<td>858, 873</td>
</tr>
<tr>
<td>Assign a macro to a keyboard shortcut or toolbar button</td>
<td>860</td>
</tr>
<tr>
<td>Customize the Ribbon and Quick Access Toolbar</td>
<td>884, 885</td>
</tr>
<tr>
<td>Recovering files and repairing Word</td>
<td>901</td>
</tr>
</tbody>
</table>

---

### About the Author

FAITHE WEMPEN, M.A., is a Microsoft Office Master Instructor and the author of more than 120 books on computer hardware and software. An adjunct instructor of Computer Information Technology at Purdue University, she specializes in Office applications and PC hardware architecture. She has also written and taught online technology courses that have educated more than a quarter of a million students. Faithe is also an A+ certified PC technician and the author of several textbooks on PC repair and maintenance. In her spare time (!) she owns and operates a small bed and breakfast in central Indiana.
## CONTENTS AT A GLANCE

### I Working with Text
1. Creating and Saving Documents  
2. Typing and Editing Text  
3. Correcting and Printing Documents  

### II Formatting a Document
4. Applying Character Formatting  
5. Formatting Paragraphs and Lists  
6. Creating and Applying Styles and Themes  
7. Formatting Documents and Sections  
8. Working with Templates and NonStandard Layouts  

### III Tables and Graphics
9. Creating and Formatting Tables  
10. Working with Pictures and Videos  
11. Working with Drawings, WordArt, and Clip Art  
12. Working with Charts  
13. Working with SmartArt and Math Formulas  

### IV Collecting and Managing Data
14. Performing Mail and Data Merges  
15. Copying, Linking, and Embedding Data  
16. Working with Fields and Forms  

### V Working with Long Documents
17. Outlining and Combining Documents  
18. Citing Sources and References  
19. Creating Tables of Contents and Indexes  

### VI Collaboration and Online Sharing
20. Collaborating with Others  
21. Protecting and Securing Documents  
22. Developing Online-Delivered Content  
23. Using SkyDrive and the Word Web App  

### VII Customizing and Extending Word
24. Macros and Add-Ins  
25. Customizing the Word Interface  

### VIII Appendixes
A. Recovering Files and Repairing Word  
B. Converting from Other Word Processing Systems  
C. Setting Up and Modifying Office 2013  
D. Accessibility Issues and Word  

Index
## CONTENTS

**Introduction** 1  
- How This Book Is Organized 1  
- Part I: Working with Text 1  
- Part II: Formatting a Document 1  
- Part III: Tables and Graphics 2  
- Part IV: Collecting and Managing Data 2  
- Part V: Working with Long Documents 2  
- Part VI: Collaboration and Online Sharing 2  
- Part VII: Customizing and Extending Word 2  
- Part VIII: Appendixes 2  

**Conventions Used in This Book** 3  

### I Working with Text  

1 **Creating and Saving Documents** 5
   - Understanding the Word 2013 Interface 5  
     - Tabs and the Ribbon 5  
     - Backstage View 7  
     - The Mini Toolbar 9  
     - Galleries, Dialog Boxes, and Panels 9  
   - Working with Views 12  
     - Switching Document Views 12  
     - Showing or Hiding Onscreen Elements 14  
     - Changing the Zoom 14  
     - Displaying Multiple Documents and Windows 15  
   - Using the Help System 16  
   - Starting a New Document 18  
     - Creating a Blank Document 18  
     - Creating a Document Based on a Microsoft Template 20  
   - Saving a Document 24  
     - Choosing a Save Location 24  
     - Changing the Favorite Locations 28  
     - Selecting an Appropriate File Format 29  
     - Converting a Document to Word 2013 Format 34  
   - Opening a Document 35  
     - Opening a Recently Used Document 35  
     - Opening a Document with the Open Dialog Box 36  
     - Changing the File List View in the Open Dialog Box 37  
     - Opening Other File Types 39  
     - Opening Files in Special Modes 40  
     - Making a Document Read-Only 41  
   - Working with File Properties 41  
     - Defining Custom Properties 44  
     - Automatically Updating Custom Properties 45  
   - Setting File-Handling Preferences 45  
     - Returning to the Word 2010 Style of Saving and Opening 45  
     - Setting the Default Save Location and File Type 46  
     - Setting an AutoRecover Interval 48  

2 **Typing and Editing Text** 49  
   - Text Entry and Editing Basics 49  
     - Switching Between Insert and Overtype Modes 51  
     - Undoing, Redoing, and Repeating 51  
     - Inserting Symbols and Special Characters 52  
   - Moving Around in a Document 57  
     - Scrolling 57  
     - Moving the Insertion Point with Click and Type 58  
     - Navigating with Keyboard Shortcuts 59
Contents

3 Correcting and Printing Documents 91

Correcting Spelling and Grammatical Errors 91
  Checking the Spelling of an Individual Word 91
  Fixing Individual Grammatical Errors 93
  Performing an Interactive Spelling and Grammar Check 94
  Finding Proofing Errors 96

Customizing Spelling and Grammar Options 97
  Customizing Grammar and Style Rules 99
  Managing the Spelling Dictionaries 100
  Checking Spelling and Grammar in Multiple Languages 106

Automating Corrections with AutoCorrect 107
  Rejecting an Automatic Correction 107
  Setting AutoCorrect Options 108
  Changing or Removing an AutoCorrect Entry 110
  Adding a Plain Text AutoCorrect Entry 110
  Adding a Formatted or Graphical AutoCorrect Entry 110
  Configuring Math AutoCorrect 111

Working with Actions 112
  Performing an Action 113
  Configuring Action Settings 113

Using Research Tools 114
  Checking a Word’s Definition with a Dictionary 114
  Finding Words with a Thesaurus 116
  Translating Text into Other Languages 118
  Looking Up Information at a Research Site 122
  Customizing and Extending the Research Tools 123

Printing a Document 125
  Printing Quickly with Default Settings 125
  Printing the Current Document 125
  Using Print Preview 130
  Setting Print Options for Word Documents 131
  Setting Options for a Certain Printer 133
  Storing Different Properties for a Single Printer 134

3 Selecting Text and Other Objects 60

Moving and Copying Text and Objects 62
  Moving or Copying Text with Drag-and-Drop 62
  Using Cut, Copy, and Paste 63
  Keeping or Discarding Formatting When Pasting 64
  Pasting with Paste Special 67
  Using the Office Clipboard 68

Locating Specific Content 69
  Finding and Replacing 69
  Using Go To 78
  Displaying a Document Map 79
  Displaying Page Thumbnails 80

Evaluating Readability 80

Viewing Word Count 82

Controlling Hyphenation 82
  Enabling or Disabling Automatic Hyphenation 83
  Turning Off Automatic Hyphenation for Specific Text 84
  Hyphenating a Document Manually 85

Inserting Dummy Text 86

Working with Building Blocks 86
  Creating a Building Block 87
  Inserting a Building Block 88
  Deleting Building Blocks 90
  Changing a Building Block’s Properties 90
Using AutoFormat 168
  Setting AutoFormat As You Type Options 169
  Formatting a Document with AutoFormat 170
  Making AutoFormat Available on the Quick Access Toolbar 170
  Setting AutoFormat Options 171
  Applying AutoFormat (Automated Mode) 172
  Applying AutoFormat (Interactive Mode) 172

5 Formatting Paragraphs and Lists 175
  Setting Line Spacing 177
    Choosing a Line Spacing Multiplier 177
    Setting a Precise Line-Spacing Value 178
    Setting Spacing Before or After a Paragraph 179
  Indenting Paragraphs 180
    Setting Precise Indent Values 181
    Quick Indenting with Buttons and Shortcuts 182
  Working with Tab Stops 184
    Types of Tab Stops 186
    Placing and Removing Tab Stops on the Ruler 187
    Defining Tab Stops with the Tabs Dialog Box 188
    Changing the Default Tab Stop Interval 189
    Converting a Tabbed List to a Table 189
    Copying Tab Stop Settings Between Paragraphs 190
  Setting Paragraph Alignment 191
  Creating Numbered and Bulleted Lists 191
    Typing a Quick Numbered or Bulleted List 192
    Creating Lists with AutoFormat As You Type 192
<table>
<thead>
<tr>
<th>Contents</th>
<th>vii</th>
</tr>
</thead>
<tbody>
<tr>
<td>Restarting or Continuing List Numbering</td>
<td>193</td>
</tr>
<tr>
<td>Starting a List at a Certain Number</td>
<td>194</td>
</tr>
<tr>
<td>Changing the Number Format</td>
<td>195</td>
</tr>
<tr>
<td>Changing the Bullet Character</td>
<td>198</td>
</tr>
<tr>
<td>Changing the List Level</td>
<td>202</td>
</tr>
<tr>
<td>Adjusting Bullet or Number Spacing and Indents</td>
<td>203</td>
</tr>
<tr>
<td>Applying Paragraph Borders</td>
<td>203</td>
</tr>
<tr>
<td>Applying and Removing Borders</td>
<td>204</td>
</tr>
<tr>
<td>Formatting Borders</td>
<td>206</td>
</tr>
<tr>
<td>Applying Paragraph Shading</td>
<td>208</td>
</tr>
<tr>
<td>Preventing Paragraphs from Breaking</td>
<td>210</td>
</tr>
<tr>
<td>6 Creating and Applying Styles and Themes</td>
<td>213</td>
</tr>
<tr>
<td>Understanding Styles</td>
<td>213</td>
</tr>
<tr>
<td>Methods of Applying Styles</td>
<td>215</td>
</tr>
<tr>
<td>Methods of Creating and Modifying Styles</td>
<td>215</td>
</tr>
<tr>
<td>Working with the Style Gallery</td>
<td>216</td>
</tr>
<tr>
<td>Changing the Style Set</td>
<td>217</td>
</tr>
<tr>
<td>Using the Styles Pane</td>
<td>218</td>
</tr>
<tr>
<td>Using the Apply Styles Pane</td>
<td>220</td>
</tr>
<tr>
<td>Customizing the Styles Pane</td>
<td>221</td>
</tr>
<tr>
<td>Clearing Styles and Formatting</td>
<td>222</td>
</tr>
<tr>
<td>Viewing the Style Area</td>
<td>224</td>
</tr>
<tr>
<td>Creating and Deleting Styles</td>
<td>226</td>
</tr>
<tr>
<td>Style Naming and Alternate Names</td>
<td>226</td>
</tr>
<tr>
<td>Creating a New Style by Example</td>
<td>227</td>
</tr>
<tr>
<td>Creating a New Style by Definition</td>
<td>229</td>
</tr>
<tr>
<td>Applying a Keyboard Shortcut to a Style</td>
<td>233</td>
</tr>
<tr>
<td>Deleting a Style</td>
<td>234</td>
</tr>
<tr>
<td>Modifying Styles</td>
<td>235</td>
</tr>
<tr>
<td>Updating a Style Automatically</td>
<td>235</td>
</tr>
<tr>
<td>Updating a Style to Match a Selection</td>
<td>235</td>
</tr>
<tr>
<td>Modifying a Style Definition</td>
<td>236</td>
</tr>
<tr>
<td>Redefining the Normal (Default) Style</td>
<td>236</td>
</tr>
<tr>
<td>Renaming Styles</td>
<td>236</td>
</tr>
<tr>
<td>Working with Cascading Styles</td>
<td>237</td>
</tr>
<tr>
<td>Modifying the Styles in the Current Template</td>
<td>238</td>
</tr>
<tr>
<td>Modifying Styles in the Manage Styles Dialog Box</td>
<td>238</td>
</tr>
<tr>
<td>Sorting the Styles List</td>
<td>239</td>
</tr>
<tr>
<td>Filtering the Styles List</td>
<td>241</td>
</tr>
<tr>
<td>Copying Styles Between Documents</td>
<td>242</td>
</tr>
<tr>
<td>Working with Themes</td>
<td>243</td>
</tr>
<tr>
<td>Applying a Theme</td>
<td>243</td>
</tr>
<tr>
<td>Resetting to the Template Theme</td>
<td>244</td>
</tr>
<tr>
<td>Creating New Themes</td>
<td>244</td>
</tr>
<tr>
<td>Applying a Color Set</td>
<td>245</td>
</tr>
<tr>
<td>Creating a New Color Set</td>
<td>245</td>
</tr>
<tr>
<td>Applying a Font Set</td>
<td>247</td>
</tr>
<tr>
<td>Creating a New Font Set</td>
<td>248</td>
</tr>
<tr>
<td>7 Formatting Documents and Sections</td>
<td>249</td>
</tr>
<tr>
<td>Working with Section Breaks</td>
<td>250</td>
</tr>
<tr>
<td>Inserting a Section Break</td>
<td>251</td>
</tr>
<tr>
<td>Deleting a Section Break</td>
<td>251</td>
</tr>
<tr>
<td>Changing a Section Break’s Type</td>
<td>251</td>
</tr>
<tr>
<td>Changing Page Margins</td>
<td>252</td>
</tr>
<tr>
<td>Selecting a Margin Preset</td>
<td>252</td>
</tr>
<tr>
<td>Entering Precise Margin Values</td>
<td>253</td>
</tr>
<tr>
<td>Setting Up Gutters and Book Folds</td>
<td>254</td>
</tr>
<tr>
<td>Setting Page Orientation</td>
<td>255</td>
</tr>
<tr>
<td>Setting Paper Size</td>
<td>256</td>
</tr>
<tr>
<td>Setting Vertical Alignment</td>
<td>257</td>
</tr>
</tbody>
</table>
Using Line Numbering 258
Inserting Page Breaks 259
Inserting Cover Pages 260
Saving Content as a New Cover Page 261
Creating Headers and Footers 262
Understanding the Header and Footer Areas 263
Inserting a Header or Footer Building Block 264
Understanding Header/Footer Field Codes 265
Deleting a Field Code 265
Adding and Formatting a Page-Numbering Code 265
Setting the Format for a Page-Numbering Code 267
Inserting a Date or Time Code 268
Inserting a Document Property 270
Adjusting Header and Footer Positioning 270
Inserting a Picture in a Header or Footer 271
Working with Multiple Headers/Footers 272
Repeating Elements on Every Page 272
Applying a Page Watermark 274
Inserting a Built-In Watermark 275
Inserting a Custom Text Watermark 275
Creating a Picture Watermark 276
Working with Multiple Columns 277
Applying a Column Preset 279
Creating Manual Column Breaks 279
Applying Custom Column Settings 280
Using Different Column Settings for Selected Text 280
Applying a Page Background 281
Using Page Borders 283

8 Working with Templates and NonStandard Layouts 285

About Templates 285
Types of Template Files 286
Determining What Template a Document Is Using 286
Starting a New Document Based on a Template 287
Using a Microsoft Template 287
Using a Personal or Custom Template 291
Saving an Existing Document as a Template 292
Modifying Templates 293
Understanding Template Storage Locations 293
Opening a Template for Editing 293
Storing and Accessing Workgroup Templates 294
Modifying a Template by Modifying the Current Document 296
Protecting Templates 296
Creating Your Own Templates 297
Changing a Document’s Template 298
Applying Global Templates 299
Enabling Global Templates at Startup 300
Preventing a Template from Loading at Startup 300
Automatically Changing the Template of All Documents Opened 300
Troubleshooting Problems with Normal.dotm 302
Creating Text Box Layouts 303
Inserting a Text Box 304
Moving and Resizing a Text Box 306
Applying and Removing Text Box Borders and Fills 307
Changing the Text Box Shape 308
Setting Text Box Margins and Vertical Alignment 310
Wrapping Text Around a Text Box 311
Linking Text Boxes 312
Changing the Text Direction 313
Tips for Creating Text Box Layouts 314

Working with Frames 315
Creating Banners 317
Addressing Envelopes 318
Adding an Envelope to a Letter 318
Setting the Envelope Size 319
Changing the Address Position 320
Changing the Envelope Font 320
Printing an Envelope 321
Controlling How Envelopes Feed into
Your Printer 321
Storing and Retrieving Addresses 322
Adding Graphics to an Envelope 322
Using E-Postage with Word 323

Creating Labels 323
Printing a Full Page of the Same
Label 324
Printing a Single Label 325
Creating a Custom Label
Specification 325
Fine-Tuning the Label Appearance 326

Creating Folded Note Cards 327
Using Card Templates 328
Specifying the Paper Size and Type 328
Creating Upside-Down Text 329

III Tables and Graphics

9 Creating and Formatting Tables 331

Creating a Table 332
Inserting a Table from the Table
Menu 332
Inserting a Table via the Insert Table
Dialog Box 333
Drawing a Table 334

Entering Data in a Table 335

Editing a Table 336
Selecting Cells 336
Selecting Rows, Columns, or Tables 338
Inserting Rows, Columns, or Cells 339
Deleting Rows, Columns, or Cells 341
Deleting an Entire Table 342
Moving and Copying Rows and
Columns 342
Merging and Splitting Cells 343
Splitting a Table 345
Creating a Nested Table 345

Sizing a Table 346
Changing the AutoFit Setting 346
Resizing by Dragging 347
Specifying an Exact Size 348
Distributing Column Widths Evenly 350
Resizing the Entire Table 350

Formatting a Table 350
Applying Table Styles 350
Setting the Default Table Style 351
Creating or Modifying Table Styles 352
Changing the Cell Background
Color 354
Working with Cell Borders 355
Setting Cell Margins 358
Setting Overall Internal Margins for the
Table 358
Setting Internal Margins for an Individual
Cell 359
Setting Text Alignment Within a
Cell 360
Changing Text Direction 361
Repeating Headings on Each Page 361
Preventing a Row from Breaking Across
Pages 361

Orienting the Table on the Page 361
Setting Table Alignment 362
Setting Table Text Wrap 362

Creating a Table Caption 364

Sorting Tabular Data 366
Performing Math Calculations in a Table 367
- Setting the Order of Operations 371
- Referencing Values Outside the Table 372

Getting Data Into or Out of Tabular Format 372
- Converting Text to a Table 373
- Converting a Table to Regular Text 374
- Pasting Tables from Other Office Applications 375
- Embedding Excel Worksheets as Tables 376

10 Working with Pictures and Videos 377
- Understanding Digital Photography 377
  - Understanding Color Models 379
  - Understanding Color Depth 379
  - Understanding File Formats 380
  - Understanding Image Resolution 381
- Understanding Clip Art 381
- Inserting Pictures 382
  - Inserting a Picture from a File 383
  - Inserting a Picture from Your SkyDrive 384
  - Inserting a Photo or Clip Art from Office.com 385
  - Inserting a Picture from a Bing Search 386
  - Capturing and Inserting Screenshots 387
- Setting Text Wrap 388
- Setting Picture Position 390
  - Manually Positioning a Picture 390
  - Working with Anchors 390
  - Changing a Picture’s Anchor Point 391
  - Locking an Anchor 391
  - Choosing a Position Preset 391
  - Specifying a Custom Position 392
- Resizing Pictures 393
- Cropping Pictures 395
- Compressing Pictures 397
- Setting the Brightness, Contrast, and Color Mode 398
  - Adjusting Brightness and Contrast 398
  - Sharpening or Softening a Picture 399
  - Changing the Color Mode 399
  - Removing a Picture Background 401
  - Applying Artistic Effects 402
- Applying Picture Styles and Effects 402
  - Applying a Picture Style 403
  - Applying a Picture Preset 403
  - Applying a Shadow Effect 404
  - Applying Reflection 406
  - Applying Glow 406
  - Applying Soft Edges 406
  - Applying a Beveled Edge and Other 3-D Formatting 406
  - Rotating a Picture 407
  - Manually Rotating a Picture 408
  - Rotating a Picture by a Specified Amount 408
  - Applying 3-D Rotation 409
  - Applying a Picture Border 410
  - Applying Picture Layouts (SmartArt) 410

Using Figure Captions 412
- Adding Alt Text Descriptions 414

Inserting Videos and Interactive Content 414
- Inserting a Video from an Online Source 415
- Inserting Video Clips from Your Own Files 416
## 11 Working with Drawings, WordArt, and Clip Art 419

### Understanding Vector Graphics 419

### Drawing Lines and Shapes 421
- Drawing a Shape 421
- Drawing a Straight or Curved Line 422
- Drawing a Freeform Polygon 423
- Working with the Drawing Canvas 424

### Adding Text to a Shape 427

### Modifying Drawn Objects 427
- Modifying a Straight Line 427
- Adding and Removing Arrow Heads 427
- Modifying an Elbow or Curved Connector 428
- Modifying Curves and Scribbles 429
- Modifying Shapes 430
- Rotating and Flipping Objects 431

### Sizing and Positioning Objects 431
- Sizing Objects 431
- Anchoring Lines to Shapes 433
- Layering Objects and Text 435
- Grouping Shapes 436
- Aligning and Distributing Objects 437

### Formatting Drawn Objects 438
- Applying Shape Styles 438
- Formatting Borders 439
- Applying Solid Fills 440
- Applying a Picture Fill 443
- Cropping a Picture to a Shape 445
- Applying a Gradient Fill 445
- Applying a Texture Fill 448
- Applying a Pattern Fill 450
- Applying Shadows 452
- Applying 3-D Effects 452

### Creating and Modifying WordArt 453
- Editing and Formatting WordArt Text 454

### Setting Text Wrap Properties for Clip Art 460
- Wrapping Text Tight Against Clip Art 462
- Editing Text Wrap Points 462

### Modifying a Clip Art Image 463
- Setting Clip Size and Position 463
- Cropping and Color-Adjusting Clip Art 463
- Applying Clip Art Background Fill 464
- Setting the Transparent Color 465
- Applying a Border 466
- Applying Shadow Effects to Clip Art 468
- Rotating Clip Art 468
- Flipping Clip Art 468

### Editing Clip Art 469
- Selecting and Moving Clip Art Shapes 470
- Recoloring Clip Art Shapes 470
- Editing Clip Art Shapes 470
- Moving and Resizing a Modified Clip 470

## 12 Working with Charts 473

### Understanding the Parts of a Chart 473

### Creating a New Chart 475
- Creating a Chart in a Word Document 476
- Creating a Legacy Chart 477
<table>
<thead>
<tr>
<th>Working with Chart Templates</th>
<th>478</th>
</tr>
</thead>
<tbody>
<tr>
<td>Creating a Chart Template</td>
<td>478</td>
</tr>
<tr>
<td>Starting a New Chart Based on a User Template</td>
<td>478</td>
</tr>
<tr>
<td>Managing Stored Chart Templates</td>
<td>479</td>
</tr>
<tr>
<td>Modifying Chart Data</td>
<td>480</td>
</tr>
<tr>
<td>Editing the Data</td>
<td>480</td>
</tr>
<tr>
<td>Changing the Charted Data Range</td>
<td>481</td>
</tr>
<tr>
<td>Switching Between Rows and Columns</td>
<td>483</td>
</tr>
<tr>
<td>Controlling How the Chart and Document Interact</td>
<td>483</td>
</tr>
<tr>
<td>Setting Text Wrapping</td>
<td>483</td>
</tr>
<tr>
<td>Positioning a Chart</td>
<td>483</td>
</tr>
<tr>
<td>Changing the Chart Type</td>
<td>485</td>
</tr>
<tr>
<td>Creating a Combination Chart</td>
<td>487</td>
</tr>
<tr>
<td>Working with Chart Elements</td>
<td>489</td>
</tr>
<tr>
<td>Applying a Quick Layout</td>
<td>490</td>
</tr>
<tr>
<td>Adding a Chart Title</td>
<td>490</td>
</tr>
<tr>
<td>Working with Legends</td>
<td>492</td>
</tr>
<tr>
<td>Using Data Labels</td>
<td>493</td>
</tr>
<tr>
<td>Applying Axis Titles</td>
<td>496</td>
</tr>
<tr>
<td>Modifying Axis Properties</td>
<td>497</td>
</tr>
<tr>
<td>Turning an Axis’s Text On or Off</td>
<td>497</td>
</tr>
<tr>
<td>Adjusting the Axis Scale</td>
<td>498</td>
</tr>
<tr>
<td>Changing the Axis Number Type</td>
<td>501</td>
</tr>
<tr>
<td>Using Gridlines</td>
<td>501</td>
</tr>
<tr>
<td>Adding Trendlines</td>
<td>502</td>
</tr>
<tr>
<td>Adding Error Bars</td>
<td>505</td>
</tr>
<tr>
<td>Adding Up/Down Bars</td>
<td>507</td>
</tr>
<tr>
<td>Adding and Formatting a Data Table</td>
<td>508</td>
</tr>
<tr>
<td>Applying Chart Styles and Colors</td>
<td>509</td>
</tr>
<tr>
<td>Formatting Individual Chart Elements</td>
<td>510</td>
</tr>
<tr>
<td>Selecting Chart Elements</td>
<td>510</td>
</tr>
<tr>
<td>Clearing Manually Applied Formatting</td>
<td>511</td>
</tr>
<tr>
<td>Applying a Shape Style</td>
<td>511</td>
</tr>
<tr>
<td>Applying Shape Outlines and Fills</td>
<td>512</td>
</tr>
<tr>
<td>Applying Shape Effects</td>
<td>512</td>
</tr>
<tr>
<td>Applying Shadow Effects</td>
<td>513</td>
</tr>
<tr>
<td>Applying Reflection Effects</td>
<td>514</td>
</tr>
<tr>
<td>Applying Glow Effects</td>
<td>514</td>
</tr>
<tr>
<td>Applying Soft Edge Effects</td>
<td>515</td>
</tr>
<tr>
<td>Applying Bevel Effects</td>
<td>515</td>
</tr>
<tr>
<td>Changing the Shape of a Series</td>
<td>516</td>
</tr>
<tr>
<td>Adjusting Data Spacing</td>
<td>517</td>
</tr>
<tr>
<td>Formatting Chart Text</td>
<td>518</td>
</tr>
<tr>
<td>Changing the Font, Size, and Text Attributes</td>
<td>518</td>
</tr>
<tr>
<td>Applying a WordArt Style</td>
<td>519</td>
</tr>
</tbody>
</table>

13 Working with SmartArt and Math Formulas 521

<table>
<thead>
<tr>
<th>Types of SmartArt</th>
<th>521</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inserting a SmartArt Diagram</td>
<td>524</td>
</tr>
</tbody>
</table>

| Changing the Diagram’s Layout | 525 |
| Choosing a Different Layout   | 526 |
| Changing the Flow Direction   | 526 |
| Adding Shapes                 | 526 |
| Removing Shapes               | 527 |
| Promoting or Demoting a Shape | 528 |
| Adding Bulleted Lists          | 528 |
| Positioning Organization Chart Branches | 528 |

| Working with Chart Text       | 529 |
| Adding and Editing Text       | 529 |
| Formatting Diagram Text       | 530 |
| Changing the Font by Applying a Font Set | 530 |
| Changing the Font, Size, and Text Attributes Manually | 531 |
| Applying WordArt Styles to Text | 532 |
| Using the Text Pane           | 532 |
| Setting Text Positioning Within a Shape | 534 |

| Formatting a Diagram          | 535 |
| Applying SmartArt Styles      | 535 |
| Changing the Theme Effects for the Entire Document | 536 |
| Changing Diagram Colors       | 537 |
Choosing an Excel Data Source 562
Choosing a Word Data Source 563
Choosing a Delimited Text Data Source 564
Setting Up an Oracle or SQL Database as a Data Source 564
Using an ODBC Data Source 565
Creating a New Data Source in Word 567
Customizing Fields 568
Editing the Data Source 569
Preparing the Main Document 569
Inserting Merge Fields 570
Inserting Single Fields 570
Inserting Address Blocks 571
Inserting Greeting Lines 573
Creating an Advanced Filter 578
Sorting the Records 579
Finding a Recipient 580
Finding Duplicate Entries 581
Validating Addresses 581
Previewing and Printing the Merge 581
Checking for Errors 582
Merging to a New Document 582
Merging to a Printer 583
Merging to Email 584
Creating Custom Merges with Word Fields 584
Collecting Information with a Fill-In Field 585
Collecting and Storing Information with an Ask Field 587
Setting Up Conditions with an If...Then...Else Field 589
Using a Field to Set Bookmark Text 590
Assigning Numbers to Merge Records 590
Advancing to the Next Record (or Not) 591

15 Copying, Linking, and Embedding Data 593

Working with Hyperlinks 594
  Automatically Creating Hyperlinks by Typing 594
  Following a Hyperlink 595
  Creating a Text Hyperlink 596
  Adding a Hyperlink to an Image 597
  Creating an Email Hyperlink 598
  Creating and Hyperlinking to a New Document 598
  Editing a Hyperlink 599
  Removing a Hyperlink 600
  Changing Hyperlink Underlining and Color 600

Working with Bookmarks 601
  Creating a Bookmark 602
  Jumping to a Bookmark 603
  Inserting a Hyperlink to a Bookmark 603
  Hyperlinking to a Bookmark in the Same Document 604
  Hyperlinking to a Bookmark in Another Document 604
  Inserting a Cross-Reference to a Bookmark 606

Embedding Data 607
  Embedding an Entire Existing File 607
  Embedding a Data Selection 610
  Embedding a New Object 611

Linking to Data in Other Files 612
  Creating a Link 612
  Linking to an Entire File 612
  Linking to a Portion of a File 613
  Managing Link Update Settings 614
  Manually Updating a Link 615
  Changing the Linked File’s Location or Range 616
  Breaking a Link 616

Inserting Content with \{IncludeText\} and \{IncludePicture\} 617
  Inserting Text with \{IncludeText\} 617
  Creating an \{IncludeText\} Field with Insert Text from File 617
  Creating an \{IncludeText\} Field by Inserting a Field Code 618
  Updating an \{IncludeText\} Field 620
  Inserting a Picture with \{IncludePicture\} 620
  Creating an \{IncludePicture\} Field with Insert Picture 620
  Creating an \{IncludePicture\} Field by Inserting a Field Code 621

16 Working with Fields and Forms 623

How Word Uses Fields 623

Inserting Fields 625
  Specifying Field Properties and Options 626
  Manually Typing Field Codes 627
  Common Syntax Errors in Field Codes 628
  Toggling Between Data and Field Code Views 629
  Editing Field Code Strings 629
  Nesting Fields 630

Selecting the Right Field 631
  Date and Time Fields 631
  Document Information Fields 632
  User Information Fields 633
  Numbering Fields 633
  Equation and Formula Fields 634
  Index and Table Fields 635
  Link and Reference Fields 636
  Document Automation Fields 637
  Mail Merge Fields 638
Updating and Editing Fields 639
  Updating a Field 639
  Locking Fields Against Updates 641
  Updating Fields for Printing 641
  Finding and Moving Between Fields 641
  Converting Fields to Plain Text 641

Formatting Fields 642
  Preventing the Formatting from Changing 642
  Specifying Font Formatting for a Field 642
  Specifying a Numbering Type 643
  Constructing a Custom Numeric Format 643
  Constructing a Custom Date or Time Format 644

Understanding Forms 646
  Designing a Form 646
  Saving a Form as a Template 648
  Differentiating Between Content Controls and Legacy Fields 648
  Displaying the Developer Tab 649

Creating a Form with Content Controls 650
  Inserting a Content Control 650
  Configuring a Control 651
  Settings Common to All Control Types 651
  Style Options 652
  Multiparagraph Text Options 652
  List Options 653
  Date Options 654
  Check Box Options 654
  Building Block Options 655
  Editing Placeholder Text 655

Creating a Form with Legacy Form Fields 656
  Inserting a Legacy Field 656
  Configuring Legacy Text Field Options 658
  Inserting the Current Date or Time 658

Setting Up a Calculation in a Legacy Field 659
  Configuring Legacy Check Box Options 659
  Configuring Legacy List Options 661
  Setting a Macro to Run on Entry or Exit for a Legacy Field 661
  Enabling or Disabling a Legacy Field 662
  Assigning a Bookmark to a Legacy Field 662
  Adding Help Text for a Legacy Field 662

Protecting a Form 664
  Filling Out a Form 665
  Filling Out a Form with Content Controls 665
  Filling Out a Legacy Form 666

Saving and Printing a Form 666
  Saving Only the Form Data 666
  Printing Only the Form Data 667
  Tips for Creating Printed Forms 667

V Working with Long Documents

17 Outlining and Combining Documents 669

Outline Basics 669
  Typing an Outline in Outline View 670
  Demoting and Promoting Outline Items 671
  Creating an Outline from an Existing Document 672

Viewing and Organizing the Outline 673
  Rearranging Outline Topics 674
  Setting a Style’s Outline Level 675
  Setting an Individual Paragraph’s Outline Level 677
18 Citing Sources and References 703

Understanding Sources and Citations 703

Selecting a Citation Style 704

Entering Sources 706
  Editing a Source 708
  Deleting a Source 709
  Transferring Sources to and from the Master List 709

Inserting Inline References to Sources 710
  Creating a New Source When Entering a Citation 711
  Inserting Temporary Placeholders for Later Entry of Sources 711
  Editing a Citation 712
  Converting a Citation to Plain Text 713

Generating a Bibliography 713
  Inserting a Bibliography from the Bibliography Gallery 714
  Working with a Bibliography Field 715
  Saving a Bibliography as a New Gallery Entry 716
  Removing a Bibliography from the Gallery 717

Working with Footnotes and Endnotes 717
  Inserting a Footnote 719
  Inserting an Endnote 720
  Moving a Reference Mark 720
  Deleting a Note 721
  Jumping to the Note That Corresponds to a Reference Mark 721
  Moving Between Notes 721
  Switching Between Footnotes and Endnotes 722
  Changing the Positioning of the Notes 722
  Changing the Note Numbering or Symbols 723
  Modifying Note Styles 723
  Changing the Note Separator Line 725
  Managing Footnote Continuations 725

Numbering Outline Items 678
  Applying a Multilevel List 678
  Creating Your Own Multilevel Lists and List Styles 681
  Creating a Multilevel List 681
  Including Numbers from Higher Outline Levels 684
  Adding a Custom Multilevel List to the Gallery 685
  Creating a List Style 685
  Deleting a Multilevel List or List Style 687

Printing or Copying an Outline 688

Understanding Master Documents 688
  Master Documents and Styles 689
  Master Documents and Headers/Footers 690
  Master Documents and TOCs and Indexes 690
  Master Documents and Numbered Notes or Captions 691

Creating a Master Document 691
  Inserting Existing Documents into a Master Document 691
  Separating an Existing Document into Subdocuments 693

Viewing and Collapsing Subdocuments 694

Editing Subdocuments 695

Modifying the Master Document’s Structure 696
  Moving a Subdocument 696
  Removing a Subdocument 697
  Unlinking a Subdocument 697
  Renaming a Subdocument 697
  Merging Subdocuments 698
  Nesting Subdocuments 698
  Splitting a Subdocument 698
  Locking and Unlocking a Subdocument 700

Paginating and Printing a Master Document 702

Word 2013 In Depth
Creating Cross-References 726
  Cross-Referencing Options 728
  Cross-Reference Context 728
  Footnote and Endnote
  Cross-References 729
  Caption Cross-References 729

19 Creating Tables of Contents and Indexes 731

Creating a Table of Contents 731
  Checking Style Outline Levels 732
  Creating a TOC from a Preset 733
  Updating a TOC 734
  Removing a TOC 735
  Manually Marking Entries for the TOC 735
  Including an Entire Paragraph with Add Text 735
  Using {TC} Fields to Manually Mark Entries 736
  Creating Custom TOCs 737
  Starting a Custom TOC 737
  Setting Basic TOC Options 738
  Choosing Which Styles and Entries Are Included 738
  Defining the Appearance of the TOC 740
  Understanding the {TOC} Field Code 740
  Creating a Custom TOC Preset 741

Working with Multiple TOCs 742
  Adding a Second TOC for the Entire Document 742
  Adding a TOC That Covers Only Part of a Document 742
  Building a TOC Across Multiple Documents 743

Creating a Table of Figures 744
  Captioning Figures 744
  Generating the Table of Figures 744
  Manually Marking Captions 746

Creating Citations and Tables of Authorities 746
  Marking Citations 746
  Generating the Table of Authorities 748

Creating an Index 749
  Deciding on the Indexing Conventions 750
  Marking Index Entries 751
  Manually Marking Index Codes 751
  Creating Subentries 753
  Creating Indexing Cross-References 754
  Marking Multiple Instances of the Same Text 755
  Understanding {XE} Field Codes 755
  AutoMarking Index Entries 755
  Creating the AutoMark File 755
  AutoMarking the Main Document 757
  Working Directly with {Index} Field Codes 757

Generating the Index 758
  Updating the Index 759
  Indexing Only Selected Entries 760
  Indexing Only Selected Letters of the Alphabet 760

Formatting the Index 760
  Setting the Index Layout 761
  Type 761
  Columns 761
  Language 761
  Right Align Page Numbers 761
  Formats 762
  Defining Index Styles 762
  Controlling the Appearance of Index Headings 763

Indexing Across Multiple Documents 763

Creating Multiple Indexes in a Single Document 764
VI Collaboration and Online Sharing

20 Collaborating with Others 765

Configuring Revision Tracking Options 766
Displaying or Hiding the Revisions Pane 766
Showing or Hiding Certain Revision Types 767
Controlling the Use of Balloons 768
Changing the Colors and Markings Used for Revisions 771
Changing the Username 772

Using Revision Tracking 773
Turning Revision Tracking On or Off 773
Reviewing Revisions 773
Moving Among Revisions 773
Accepting or Rejecting Revisions 774
Preventing Others from Tampering with Revisions 775

Working with Comments 776
Inserting Comments 776
Viewing and Editing Comments 777
Deleting Comments 778
Marking a Comment as Done 778

Comparing Documents 778
Viewing Two Documents Side by Side 779
Comparing and Combining Documents 780
Comparing with Legal Blackline 780
Combining Two or More Documents 782

Working in Read Mode 783
Turning On/Off Optional Screen Elements 784
Moving Between Screens 784

Collaborating on a Shared Document 785
Sharing a Document on Your SkyDrive 785
Sharing a Document Link via Email 786
Sharing a Document Link via Social Networking 786
Creating a Hyperlink that You Can Distribute Manually 787
Creating a Sharing Group 788
Working with Someone Else’s Shared Content 790

Working with PDF and XPS Files 790
Saving a Document in PDF or XPS Format 791
Editing a PDF File in Word 792

21 Protecting and Securing Documents 793

Restricting Access to a Document 794
Password-Protecting a Document in Word 794
Saving with a Password 794
Removing a Password from a File 795
Using Windows Encryption 796
Encrypting a Folder 796
Decrypting a Folder 797
Removing Network Share Permission for a Location 798

Restricting What Users Can Do to a Document 798
Recommendating Read-Only 798
Making the Document File Read-Only 798
Setting a Read-Only Editing Restriction 799
Restricting a Document to Comments Only 801
Restricting a Document to Form Fill-In Only 801
Forcing Revision Marks to Stay On 801
Restricting Style Usage 802
Setting Up Per-User Exceptions to Restrictions 803

Marking a Document as Final 804
Creating Hyperlinks 825
  Creating a Text Hyperlink 826
  Adding a Hyperlink to an Image 827
  Creating an Email Hyperlink 827

Building Multicolumn Layouts with Tables 828

Creating Your Own Web Page Templates 830

Attaching a Cascading Style Sheet 831

Blogging with Word 831
  Understanding the Word Blogging Interface 832
  Registering Your Blog Server in Word 832
  Creating a New Blog Post 833
  Adding Pictures and Other Graphics to a Blog 833
  Categorizing Blog Entries 834
  Managing the Blog List 834
  Modifying a Blog Post 835
  Sending Email from Word 835

22 Developing Online-Delivered Content 815

Web Page Development: Word’s Strengths and Weaknesses 815
  Web Technologies Supported in Word 816
  Web Page File Formats 817
  Word Features Lost When Saving in Web Format 817
  Why You Might Not Want to Use Word 818

Creating and Saving a Web Page in Word 818
  Previewing a Web Page 818
  Saving a Web Page 819

Options for Web Page Saving 820
  Saving for Compatibility with Specific Browsers 821
  More About PNG and VML 822
  VML Graphics 822
  PNG Graphics 822
  Selecting Web Page File Options 822
  Changing Page Size 823
  Changing Language Encoding 823
  Changing the Default Fonts 824
  Working with Web Page Properties 824

23 Using SkyDrive and the Word Web App 837

Understanding SkyDrive 837
  Logging In to the SkyDrive Web Interface 838
  Working with SkyDrive for Windows 839
  Saving and Opening Files from Your SkyDrive Within Word 840
  Using the Windows 8 SkyDrive App 841

Managing Files on Your SkyDrive 843
  Uploading a File to Your SkyDrive 843
  Downloading a File from Your SkyDrive 844
  Renaming a File or Folder 846
  Moving or Copying a File or Folder 847
  Deleting a File or Folder 848
  Sharing SkyDrive Files 850
Using the Word Web App 851
   Editing an Existing File Using the Word Web App 852
   Starting a New Document Using the Word Web App 853

VII Customizing and Extending Word

24 Macros and Add-Ins 855
   Understanding Macro Basics 855
   Choosing the Macro Creation Method 856
   Planning Your Macro 857
   Recording a Macro 858
   Naming Your Macro 859
   Deciding Where to Store Your Macro 859
   Assigning a Macro to a Keyboard Shortcut or Toolbar Button 860
   Assigning a Macro to a Keyboard Shortcut 861
   Recording the Steps for Your Macro 863

Running a Macro 866
   Dealing with Macro Error Messages 867
   Making Additional Macros Available 869
   Opening Additional Templates to Run Macros 869
   Copying Macros Between Documents 869
   Renaming and Deleting Macros 870

Assigning a Keyboard Shortcut to an Existing Macro 871
   Creating a Quick Access Toolbar Button for an Existing Macro 872
   Editing Macro Code in VBA 873
      Opening a Macro for Editing 874
      Examples of Macro Command Syntax 875

Working with Macro Security 879
   Understanding Trusted Publishers and Locations 879
   Determining What Locations Are Trusted 880
   Setting Security Levels for Macro Running 880

Working with Add-Ins 881
   Enabling/Disabling COM Add-Ins 882
   Enabling/Disabling Actions 883
   Enabling/Disabling Other Add-Ins 883

25 Customizing the Word Interface 885
   Customizing the Quick Access Toolbar 885
      Repositioning the Quick Access Toolbar 885
      Add Common Commands 886
      Add Commands from the Ribbon 886
      Add Other Buttons 886
      Remove Buttons 887

Customizing the Ribbon 888
   Collapsing the Ribbon 888
   Displaying or Hiding Tabs 888

Creating or Deleting a Tab or a Custom Group 890
   Creating a Custom Tab 890
   Creating a Custom Group 890
   Deleting a Custom Tab or Group 891

Adding or Removing Commands 891
   Adding a Command 891
   Removing a Command 892
   Renaming or Reordering Tabs 893
   Resetting Customizations 893

Exporting and Importing Customization Settings 893
   Exporting Customizations 894
   Importing Customizations 894

Defining Shortcut Keys 894
## Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Changing Viewing Options</td>
<td>895</td>
</tr>
<tr>
<td>Changing the Status Bar Content</td>
<td>896</td>
</tr>
<tr>
<td>Changing Page Display and Formatting Marks</td>
<td>896</td>
</tr>
<tr>
<td>Setting General Options</td>
<td>898</td>
</tr>
<tr>
<td>Other Customization Options</td>
<td>900</td>
</tr>
</tbody>
</table>

### VIII Appendixes

#### A Recovering Files and Repairing Word 901

- Recovering Document Files | 901 |
  - Using the Document Recovery Task Pane | 901 |
  - Setting AutoRecover Options | 903 |
  - Recovering Data from an Unreadable File | 904 |
- Creating Automatic Backup Copies | 905 |
- Dealing with Word Crashes | 905 |
  - Sending Error Reports | 905 |
  - Fixing Crashes Related to a Certain Document | 906 |
  - Disabling Add-Ins and Extensions | 906 |

#### B Converting from Other Word Processing Systems | 909 |

- Converting from Previous Word Versions | 909 |
- Converting from Microsoft Works | 910 |
- Converting from WordPerfect | 910 |
- Converting from an Unsupported File Format | 911 |
- Confirming File Conversions | 911 |
- Sharing Word Documents with Other Programs | 911 |

#### C Setting Up and Modifying Office 2013 | 915 |

- Installing Office 2013 | 915 |
- Modifying or Repairing Your Office Installation | 916 |
- Optional Tools and Shared Features | 916 |

#### D Accessibility Issues and Word 919

- Types of Adaptive Technology | 919 |
- File Format and Accessibility | 920 |
- Creating Accessible Word Documents | 920 |
  - Headings and Styles | 920 |
  - Graphics | 921 |
  - Hyperlinks | 921 |
  - Tables | 922 |
  - Text Boxes and Frames | 923 |

Index | 925 |
ABOUT THE AUTHOR

Faithe Wempen, M.A., is a Microsoft Office Master Instructor and the author of more than 120 books on computer hardware and software. An adjunct instructor of Computer Information Technology at Purdue University, she specializes in Office applications and PC hardware architecture. She has also written and taught online technology courses that have educated over a quarter of a million students for corporate clients including Hewlett-Packard, CNET, and Sony. Faithe is also an A+ certified PC technician and the author of several textbooks on PC repair and maintenance. In her spare time (!), she owns and operates a small bed and breakfast in central Indiana.
Dedication

To Margaret, who makes it all possible.

Acknowledgments

Thanks to my wonderful editors at Que for another job well done. Que is a great publishing company to work for, and I’m always proud of the work that we turn out together.
TELL US WHAT YOU THINK!

As the reader of this book, you are our most important critic and commentator. We value your opinion and want to know what we’re doing right, what we could do better, what areas you’d like to see us publish in, and any other words of wisdom you’re willing to pass our way.

We welcome your comments. You can email or write to let us know what you did or didn’t like about this book—as well as what we can do to make our books better.

Please note that we cannot help you with technical problems related to the topic of this book.

When you write, please be sure to include this book’s title and author as well as your name and email address. We will carefully review your comments and share them with the author and editors who worked on the book.

Email:  feedback@quepublishing.com

Mail:  Que Publishing
ATTN: Reader Feedback
800 East 96th Street
Indianapolis, IN 46240 USA

Reader Services

Visit our website and register this book at quepublishing.com/register for convenient access to any updates, downloads, or errata that might be available for this book.
INTRODUCTION

Welcome to Word 2013 In Depth! This book is designed to be your one-stop reference for Microsoft Word 2013, from the basics of Ribbon usage to the intricacies of forms, fields, and customization tools. Whether you’re just getting started, are upgrading, or are already a Word whiz, this book can help you move up to the next level in expertise.

How This Book Is Organized

Word 2013 In Depth is organized into these parts.

Part I: Working with Text

This part explains how to create a basic document by typing and editing text, saving in various formats, correcting your mistakes, and printing your work. These basic skills pave the way to more extensive editing later in the book.

Part II: Formatting a Document

In this part, you find out how to format documents on several levels: character, paragraph, and document-wide. You discover how to automate formatting with styles and themes; how to set up sections that enable different margin, column, and header/footer information in different parts of a document; and how to use and create project templates that streamline the process of formatting documents that you frequently re-create. You also see how to create some nonstandard documents, such as banners, envelopes, and greeting cards.
Part III: Tables and Graphics
This part explains how to create and format data in tabular format and how to insert and format a variety of special-purpose graphical elements including clip art, drawings, charts, SmartArt, and mathematical equations. Most of these graphics types have formatting controls in common, so after you’ve learned how to format one type of object, the other types become much easier.

Part IV: Collecting and Managing Data
In this part, you discover how to use Word to collect data and to use data to automate tasks. You see how to mail-merge labels, letters, envelopes, and catalogs, how to use fields and data entry forms to display and collect information, and how to link and embed information.

Part V: Working with Long Documents
This part covers the many tools Word provides for managing lengthy manuscripts, such as research papers and books. You find out how to outline and summarize documents, how to create master documents that combine several files into a single unit, and how to generate tables of contents and other listings. This part also includes information about the citation management features in Word 2013 and explains how to create effective indexes.

Part VI: Collaboration and Online Sharing
In this part, you discover the tools that Word 2013 provides for sharing your work with others, both while it is in the development stages and when it is finalized. You find out how to collaborate on documents with a team, how to protect and secure your files, and how to work with Office Web Apps and your SkyDrive.

Part VII: Customizing and Extending Word
This part explains how you can make Word easier to use by adding features such as macros and add-ins and by customizing the Word interface.

Part VIII: Appendixes
The appendixes for this book provide an assortment of reference guides, including help for recovering and repairing problems, converting from other word processing systems, and setting up and modifying Office 2013. The book also includes an appendix on making your Word documents more accessible.
Conventions Used in This Book

Here’s a quick look at a few structural features designed to help you get the most out of this book. To begin with, you’ll find Tips, Notes, Cautions, and Troubleshooting boxes.

**Tip**
Tips are designed to point out especially quick ways to get the job done, good ideas, or techniques you might not discover on your own.

**Note**
Notes offer even more insight into features or issues that may be of special interest, without distracting you from the meat-and-potatoes answers you’re looking for.

**Caution**
As you’d expect, cautions warn you about potential pitfalls and problems and point out fixes for common issues.

**Troubleshooting Tips**
Troubleshooting boxes provide advice for getting back to normal when things go wrong.

Often, when a subject is covered in greater detail, you’ll find a marker like this, which points you to the location where you can find the topic:

➡️ *For more information about Word’s automated spelling and grammar checker, see “Performing an Interactive Spelling and Grammar Check,” p. 94.*

Que’s *In Depth* conventions are designed to be completely predictable. It’s easy to understand what you’re reading and what you’re supposed to do. For example, whenever you should press multiple keys together, in this book, they are written separated by a plus sign, like this shortcut for the Bold command: Ctrl+B. That means hold down the Ctrl key, press the B key, and then release both keys.

Terms introduced and defined for the first time are formatted in italic.

Text that you are supposed to type is formatted in bold type, as in the following example:

Run Setup using a command such as `setup.exe /q1 /b1`.

That’s all you need to know to get the most out of this book. Now, fire up your copy of Word 2013 and let’s have a go at it.
FORMATTING PARAGRAPHS AND LISTS

Besides the character-based formatting that you learned about in Chapter 4, “Applying Character Formatting,” there are many types of formatting that apply to entire paragraphs, such as alignment settings, indentation, line spacing, and tab stops. In this chapter, you see how to apply these and many other types of paragraph formatting. You also discover how to format paragraphs into bulleted or numbered lists and use custom bullets and number styles. How Word Handles Paragraphs

A paragraph is a block of text that ends with a paragraph marker (¶), which you create by pressing the Enter key on the keyboard. The marker symbol does not print, and it does not show up onscreen unless you have configured Word to display nonprinting characters.

Pressing Enter starts a new paragraph (and ends the previous one), but not all line breaks are paragraph breaks. You can create a line break that does not start a new paragraph by pressing Shift+Enter. A line break is represented by the nonprinting symbol . (Again, the symbol doesn’t appear onscreen unless Word is displaying nonprinting characters.) Figure 5.1 shows examples of paragraph breaks and line breaks.

Tip
To toggle between displaying nonprinting characters, such as the paragraph marker, click the Show/Hide (¶) button on the Home tab or press Ctrl+Shift+8.
Generally speaking, starting a new paragraph by pressing Enter carries over the same paragraph settings as were in the preceding paragraph. So, for example, if the preceding paragraph has a 1-inch left indent, the new paragraph will, too. (An exception would be if the style assigned to that paragraph was set up to use a different style on subsequent paragraphs.)

Paragraph formatting is stored as part of the end-of-paragraph marker. Deleting the paragraph marker between two paragraphs combines them into a single paragraph that has the paragraph formatting settings of the first of the two paragraphs. Any settings that were stored in the second paragraph’s marker are deleted, along with the marker.
Remember that paragraph formatting is stored in the marker because when you are copying or moving text, you might or might not also want to copy or move the paragraph formatting along with it. To preserve the paragraph formatting, make sure that the end-of-paragraph marker is included in your selection. To make the pasted text conform to the paragraph settings in its new destination, do not include the paragraph marker in the selection.

Each paragraph has a paragraph style applied to it from which it inherits its basic properties. These basic properties include not only paragraph characteristics such as line spacing and indentation, but character-formatting defaults such as font, size, and color.

To change a paragraph’s appearance, you can apply a different paragraph style to it, change the definition of the paragraph style that’s applied, or apply manual paragraph formatting that overrides the style’s formatting.

In this chapter, you find out how to apply manual paragraph formatting that overrides the paragraph’s style. Learning these techniques enables you to format paragraphs without worrying about style definitions. These techniques also familiarize you with the basic paragraph controls you can use to make changes to the paragraph styles in Chapter 6, “Creating and Applying Styles and Themes.”

### Setting Line Spacing

*Line spacing* is the vertical spacing of the paragraph’s lines. It can be expressed as a fixed amount in points or as a percentage of the line height. You can set line spacing to any amount you like, as described in the following sections. You can also set different line spacing for different paragraph styles. (Paragraph styles are discussed in Chapter 8, “Working with Templates and Nonstandard Layouts.”)

### Choosing a Line Spacing Multiplier

You can quickly switch a paragraph among a few common line-spacing settings with the Line and Paragraph Spacing button on the Home tab. The choices are measured in multiples of the text height: 1.0, 1.15, 1.5, 2.0, 2.5, or 3.0 (see Figure 5.2).

**Figure 5.2**

Make quick line spacing selections from the Home tab.
Because line spacing depends on the font size, it changes as the font size does. For example, if the text in the paragraph is 12 points in size, a setting of 1.5 (as in Figure 5.2) would add 6 points of extra space between lines. (The 1 is the line itself, and the .5 is the extra space.)

Setting a Precise Line-Spacing Value

The Line Spacing Options command on the Line and Paragraph Spacing button’s menu opens the Paragraph dialog box (see Figure 5.3).

The Line Spacing drop-down list in the Paragraph dialog box offers these choices:

- **Single**—Single spacing. There’s no extra space between lines. It’s the same as 1.0 on the button’s menu.

- **1.5 Lines**—One-and-a-half spacing. There’s an extra half-height blank line between each printed line of the paragraph. It’s the same as 1.5 on the button’s menu.
Setting Line Spacing

- **Double**—Double-spacing. There’s an extra blank line between each printed line of the paragraph. It’s the same as 2.0 on the button’s menu.

- **At Least**—A minimum line height to be used. (You specify the amount.) If the single-space line height is greater than the amount specified, single spacing is used for that line. Otherwise, the At Least value is used.

- **Exactly**—A precise line height to be used. (You specify the amount.) Be careful with this setting; if you specify a size that’s smaller than the largest font size used in the paragraph, the large letters become truncated on top.

- **Multiple**—A multiple of single spacing. (For example, enter 3 for triple spacing.) You can enter any value from 0 to 132, in decimal increments of 0.01. This is how the default setting of 1.15 is created.

Desktop publishing programs typically call line spacing by another name: leading (rhymes with bedding). The term *leading* technically refers to the amount of blank space between the lines, not to the total line height. For example, in a desktop publishing program, a leading value of 4 points would add 4 points of vertical space between each line of the paragraph, regardless of the total line heights.

In Word, you cannot directly set leading. The At Least and Exactly settings are the closest things to it, but they’re calculated differently. The At Least and Exactly values are expressed in total line height, not blank space height. For example, an Exactly setting of 16 pt, when used on a paragraph that has 12-point text in it, would result in a 4-point vertical space between lines. However, that same setting, when used with 10-point text, would have a 6-point vertical space between lines. And when used with 20-point text, there would be no vertical space between lines, and the tops of the larger letters would be cut off.

When the line spacing setting specifies more height than is needed for a line of text (given its largest font size), the extra spacing appears below the text. This is useful to keep in mind because it affects the amount of space that follows the paragraph. If you have two consecutive double-spaced paragraphs, there will also be double spacing between them because the extra space for the last line of the first paragraph will appear at its bottom. However, if a double-spaced paragraph follows a single-spaced one, there will only be single spacing between them because the single-spaced paragraph specified no extra space below each line.

### Setting Spacing Before or After a Paragraph

The quickest way to add spacing before or after a paragraph is to choose Add Space Before Paragraph or Remove Space After Paragraph from the Line and Paragraph Spacing button’s menu on the Home tab (refer to Figure 5.2). This adds the same amount of space, either before or after.

---

**Tip**

Because all these cumulative effects can be potentially confusing, I recommend using only After spacing (not Before spacing) when creating space between paragraphs. That’s a somewhat arbitrary decision; you could just as easily stick with the Before setting and never use the After setting. However, because line spacing applies itself below each line of a paragraph (including the last line), it makes marginally more sense to go with After.
the paragraph, as the paragraph’s largest font size. For example, if the font size is 12, choosing Add Space Before Paragraph adds 12 points of space before it.

If you need different spacing than that, use the Paragraph dialog box (refer to Figure 5.3). It has Before and After settings that add space before and after the paragraph, respectively. Enter the number of points of extra space you want.

The After setting is cumulative with the line-spacing setting. For example, if you have a paragraph with 12-point text and its line spacing is set to Double, and then you add an After value of 5 pt, there will be 17 points of space between that paragraph and the next one.

Before and After values are also cumulative with one another. If two consecutive paragraphs have Before values of 10 and After values of 10, they will have 20 points of space between them (not counting any extra space coming from the Line Spacing setting).

The Page Layout tab also has Before and After boxes that work the same as their counterparts in the Paragraph dialog box. Use the increment arrows or type values directly into the text boxes there (see Figure 5.4).

If you’re in a hurry, it can be tempting to simply create extra space between paragraphs by pressing Enter a few extra times. That technique backfires in longer documents, however, because it results in spacing that is inflexible and difficult to modify. Each time you press Enter, you get exactly one line of space—what if you want more or less than that? And each of the spaces between the paragraphs is actually its own blank paragraph, so you can’t change the spacing by applying paragraph styles to the text.

On the other hand, by applying spacing to a paragraph with the After setting (or Before, whichever you like), you make the spacing an integral part of the paragraph. That way, you can easily define that paragraph’s settings as a new style and apply that style to other paragraphs to achieve a consistent look. You can also modify the style at any time to change the amount of spacing between paragraphs to tighten up or spread out a page as needed.

To change the line spacing for a paragraph style, see “Modifying a Style Definition,” p. 236.

Indenting Paragraphs

Indentation is the amount of horizontal space between the margin and the paragraph. It is used for a variety of stylistic purposes. For example, left and right indents often set off long quotations, and first-line indents are commonly used in newspapers and magazines to help readers’ eyes track the beginnings of paragraphs.
You can set paragraph indentation with keyboard shortcuts, with buttons on the Home tab, with the Paragraph dialog box, or with the ruler. Although these methods achieve the same basic results, you create them somewhat differently.

**Setting Precise Indent Values**

For maximum control and precise numeric entry, use the Paragraph dialog box method. Select the paragraphs and then open the Paragraph dialog box by clicking the dialog box launcher icon in the bottom-right corner of the Paragraph group on either the Home tab or the Page Layout tab. As you can see in Figure 5.5, the Paragraph dialog box offers three types of indents:

- **Left**—The indentation between the left margin and the left side of the paragraph.
- **Right**—The indentation between the right margin and the right side of the paragraph.
- **Special**—A list from which you can select one of two types:
  - **First Line**—The indentation of only the first line of the paragraph, in relation to the general left indent. For example, if the paragraph has a 1-inch left indent and a 0.5-inch first-line indent, the first line starts at 1.5 inches and all other lines start at 1 inch.
  - **Hanging**—The indentation of all the lines of the paragraph except the first one. Like First Line, this setting is cumulative with the Left indent setting.

![Figure 5.5](image-url)

Set indents in the Paragraph dialog box.
The Page Layout tab also has Left and Right indent controls that correspond with the Left and Right settings in the Paragraph dialog box. Enter amounts or use the increment arrow buttons (see Figure 5.6).

Indents can be either positive or negative numbers. A negative indent forces the paragraph outside of the document margins. For example, in a document with a 1-inch left margin, a setting of –0.25 inches would place the paragraph 0.75 inches from the edge of the paper.

You can specify each indent type in increments as small as 0.01 inches. Note that indents are measured in inches, not points, as with vertical spacing. There is no fixed limit for the maximum amount of indentation you can specify, but if the indents are so large that they squeeze the text out entirely, an error message appears telling you that you have chosen indents that are too large.

**Quick Indenting with Buttons and Shortcuts**

To quickly increase or decrease the left indent of a paragraph by 0.5 inches, select the paragraphs to affect and then click the Increase Indent or the Decrease Indent button on the Home tab (see Figure 5.7).

These buttons have corresponding shortcut keys for: Ctrl+M for Increase Indent and Ctrl+Shift+M for Decrease Indent.
There are also shortcut keys for increasing or decreasing hanging indents, although there are no corresponding buttons on the tab: Ctrl+T is used to increase the hanging indent 0.5 inches, and Ctrl+Shift+T is used to decrease it.

**Visually Indenting with the Ruler**

Sometimes it is easier to set an indent by “eyeballing it” with drag-and-drop. By dragging the indent markers on the ruler, you can do just that.

The ruler has four indent markers on it (see Figure 5.8). The first three described in the following list are on the left of the rule; the last one is on the right:

- **Left indent**—Controls the left indent for all lines of the paragraph.
- **Hanging indent**—Controls all lines except the first line. On the ruler, it is inseparable from the left indent marker.
- **First-line indent**—Controls the first line of the paragraph.
- **Right indent**—Controls the right indent for all lines of the paragraph.

Indent changes apply only to the selected paragraphs, so make your selection before working with the indent markers.

You can drag the first-line indent marker separately from the others to create a different first line from the rest, just like when you enter a hanging indent value in the Paragraph dialog box. The zero mark on the ruler represents the document’s left margin; you can drag the first-line marker to the left of 0 to create a negative indent that forces the paragraph past the margin.
The hanging indent works differently on the ruler than it does in the Paragraph dialog box. With the ruler method, dragging the hanging indent marker also moves the left indent marker, so the hanging indent is not cumulative with the left indent. A paragraph’s left indent is always the same as its hanging indent; the first-line indent can either match up with them or can be offset to the left or the right.

When you drag the left indent marker (the rectangle), the first-line and hanging markers move along with it, without losing their relationship to each other. So, for example, if the hanging and left indent markers are at 1 inch and the first-line indent marker is at 0 inches, moving the left indent marker to 2 inches moves the first-line indent marker to 1 inch.

There is also an alternative method of setting the first-line indent and left indent on the ruler: Use the tab stop controls. (You see these in detail in the next section.) Here’s how that works:

1. Select the paragraphs you want to change.
2. At the far-left end of the ruler is the Tab Stop Type button. Click it until the first-line indent marker appears on the button’s face, as shown in Figure 5.9.
3. Click the ruler where you want to move the first-line indent marker.
4. Click the Tab Stop Type button again. Now the left indent marker appears on its face.
5. Click the ruler where you want to move the left indent marker (and the hanging indent marker; remember that they move together).

Figure 5.9
You can set the first-line and left indents using a tab stop method.

Working with Tab Stops

Tab stops are nonprinting markers that tell the insertion point where to stop when you press the Tab key. By default, a paragraph has tab stops every 0.5 inches in Word, but you can create your own custom tab stops to replace or supplement these.

Back in the days of the typewriter, the best (and only) way to create a multicolumn layout was to use tab stops. Word provides many alternatives to that, such as creating newspaper-style columns.
with the Columns feature and creating a multicolumn tabular layout with the Tables feature. Nevertheless, tab stops remain a viable option for simple multicolumn lists, and they even have some advantages that those other options can’t match.

To create a document with newspaper-style columns, see “Working with Multiple Columns,” p. 277.

To create a document with tabular columns, see “Creating a Table,” p. 332.

To modify a style’s tab stop settings, see “Modifying Styles,” p. 235.

When setting up a tabbed list, many beginners end up pressing Tab multiple times, moving through the default tab stops until they reach the desired position. With nonprinting characters displayed, that might look something like Figure 5.10.

A better way, though, is to simply set a custom tab stop where you want the insertion point to stop and then press Tab only once to get to it. (When you set a custom tab stop, all the default tab stops to its left disappear.) With a single tab stop creating the full amount of space, as in Figure 5.11, it’s easy to modify the list later by adjusting that one tab stop’s position.
Types of Tab Stops

The default tab stop type is Left, the traditional “typewriter-style” stop. That’s not the only type of stop available, though; here is a full list of the tab stop types. Figure 5.12 shows examples of several types.

<table>
<thead>
<tr>
<th>Sales Quarter</th>
<th>Top Salesperson</th>
<th>Total Sales</th>
</tr>
</thead>
<tbody>
<tr>
<td>Spring</td>
<td>Rodney Rodriguez</td>
<td>$150,520.00</td>
</tr>
<tr>
<td>Summer</td>
<td>Audrey Moore</td>
<td>$75,400.20</td>
</tr>
<tr>
<td>Fall</td>
<td>Sheri Henson</td>
<td>$66,000</td>
</tr>
<tr>
<td>Winter</td>
<td>Dwayne Johnson</td>
<td>$2,252,900.15</td>
</tr>
</tbody>
</table>

**Left**—Text is left-aligned and extends to the right of the stop. This general-purpose tab stop is the staple of most lists.

**Center**—Text is center-aligned with the tab stop so that half of it extends to the left of the stop and half to the right. Center tab stops work well for centering headings over columns of data.

**Right**—Text is right-aligned and extends to the left of the tab stop. This type is good for aligning text at the right margin, for example.
Decimal—The first decimal (period) in the text is aligned at the tab stop position; anything that comes before it is right-aligned, and anything that comes after it is left-aligned. This one is great for lining up columns of numbers that have differing numbers of digits before and after the decimal point.

Bar—This one is not really a tab stop in the same sense as the others. When a bar stop is set at a particular position, pressing Tab to move to that spot places a vertical line there, the height of that line of text. When several of these appear in consecutive lines, they form a solid vertical divider line, making the tabbed list resemble a table.

Placing and Removing Tab Stops on the Ruler

Each time you click the Tab Stop Type button (to the far left of the ruler), the button cycles through the tab stop types listed in the preceding section. (There are actually two other items within the cycle—First Line Indent and Hanging Indent—but they are for setting indents, not tabs.)

To learn about setting indents using the Tab Stop Type button, see “Visually Indenting with the Ruler,” p. 183.

I Can’t Place a Tab Stop over an Indent Marker

When you click on the ruler to place a tab stop, it doesn’t work if there is already an indent marker at that spot. To get around this, temporarily drag the indent marker to another location, place the tab stop, and then drag the indent marker on top of the tab stop. Alternatively, place the tab stop in a different location and then drag it on top of the indent marker.

When the Tab Stop Type button face shows the type of stop you want, click on the ruler to place it at the desired location. To remove a tab stop from the ruler, drag the stop off the ruler (up or down) and drop it.

To reposition a tab stop on the ruler, drag the stop to the left or right. As you drag, a dotted vertical line appears to help you line up the stop appropriately with the content in your document.

Tip

As you are dragging a stop to reposition it, hold down the Alt key to see measurements of the current tabbed column widths. This is useful if you need to create tabbed columns with exact width measurements. That’s different from the exact positions on the ruler you get when creating tab stops with the Tabs dialog box (covered next), because this feature tells you the width of each column individually, whereas the Tabs dialog box tells you the ruler position of each stop. (Sure, you could calculate the width of a column from the ruler positions, but why bother when Word does it for you?)
Defining Tab Stops with the Tabs Dialog Box

The Tabs dialog box is useful for setting tab stops when you need precise positions or when you need a leader character. A leader is a repeated character that extends from typed text to the next tab stop. Leaders are commonly used in tables of contents, for example, as shown in Figure 5.13.

Table of Contents

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Getting Started</td>
<td>2</td>
</tr>
<tr>
<td>2</td>
<td>Working with the Hardware</td>
<td>15</td>
</tr>
<tr>
<td>3</td>
<td>Programming the Function Buttons</td>
<td>23</td>
</tr>
<tr>
<td>4</td>
<td>Preventive Maintenance</td>
<td>40</td>
</tr>
<tr>
<td>5</td>
<td>Replacing Parts</td>
<td>51</td>
</tr>
<tr>
<td>6</td>
<td>Troubleshooting</td>
<td>72</td>
</tr>
</tbody>
</table>

Figure 5.13
A tab leader example.

To generate tables of contents in Word, see “Creating a Table of Contents,” p. 731.

There are two ways to open the Tabs dialog box:

- Double-click any custom tab stop on the ruler.
- Open the Paragraph dialog box and click the Tabs button.

The Tab Stop Position list shows all the custom tab stops that are set for the selected paragraphs. Tab stops are identified by their position on the ruler, in inches. The ruler begins with 0 inches as the left margin.

To remove a single tab stop from the list, click it and click Clear. To remove them all, click Clear All.

To create a new tab stop, enter a new value in the Tab Stop Position box, select an Alignment for it, and optionally select a leader for it (see Figure 5.14). Then, click the Set button to create the tab stop.

You can change every aspect of a tab stop. Select the stop from the Tab Stop Position list and then change its numeric value (position), its alignment, or its leader setting.

I Don’t See Some of My Custom Tab Stops on the Ruler

When multiple paragraphs are selected and they don’t all have the same tab stops, tab stops do not appear on the ruler. You can set new tab stops that then apply to all selected paragraphs, but any tab stops that are specific to only certain paragraphs within the selection are inaccessible.
Working with Tab Stops

5

CHAPTER

Changing the Default Tab Stop Interval

Word provides soft tab stops every 0.5 inches in a paragraph. By “soft,” I mean they exist only when necessary—that is, when you press the Tab key. Otherwise, you would never know they’re there.

You can change this interval for the entire document by doing the following:

1. Display the Tabs dialog box (refer to Figure 5.14).
2. In the Default Tab Stops box, increase or decrease the value.
3. Click OK to close the Tabs dialog box.

Convert a Tabbed List to a Table

Tabbed lists work great when they contain small amounts of text, but what if some text in one of the columns needs to wrap to an additional line or two? In cases like that, you’re faced with the thorny task of manually splitting up lines of text and trying to figure out how much text will fit between the tab stops.

When items of text must wrap to multiple lines in the list, go for a table instead. Fortunately, you don’t have to start from scratch when you make the discovery that you should have used a table; you can convert a tabbed list to a table easily:

1. Select the entire tabbed list.
2. On the Insert tab, click the Table button. A menu appears.
3. On the menu, click Convert Text to Table. The Convert Text to Table dialog box opens (see Figure 5.15).
4. Confirm the number of columns. If the number is not what you expected, click Cancel, check that you have an equal number of tab stops in each line, and then try again.

5. Click OK. The tabbed list is now a table, and the Table Tools tab appears.

To control the table’s size or adjust row heights or column widths, see “Sizing a Table,” p. 346.

To format the table, see “Formatting a Table,” p. 350.

Copying Tab Stop Settings Between Paragraphs

Because tab stops are somewhat time-consuming to set up, you will probably want to reuse the settings wherever possible rather than reset the stops for each paragraph. One way to facilitate this is to select multiple paragraphs before you set the tab stops in the first place. But let’s suppose for the moment that you forgot to do that.

When you start a new paragraph by pressing Enter at the end of a paragraph, the tab stops carry over automatically.

To manually copy the tab stop settings (and other paragraph formatting too) from one paragraph to another, use the Format Painter tool you learned about in Chapter 4, but instead of selecting specific text, follow these steps:

1. Click anywhere within the paragraph that contains the tab stops to be copied.

2. On the Home tab, click the Format Painter button.

3. Click anywhere within the paragraph to receive the tab stops.

If you need to copy the stops to more than one paragraph, double-click the button in step 2 rather than single-clicking, and then you can click multiple paragraphs, one by one, in step 3. Alternatively, you can drag over a group of paragraphs in step 3 instead of clicking within one.
Setting Paragraph Alignment

Alignment, also called justification, is the way that text aligns horizontally within its assigned area. In a regular paragraph, that area is the space between the right and left margins (or between the right and left indent markers, if set). In a table or text box, that area is the cell or the box.

The choices for paragraph alignment are as follows:

- Left
- Centered
- Right
- Justified

All are self-explanatory except perhaps that last one. Justified, also called Full in some programs, aligns the text at both the right and left margins. To accomplish this, Word inserts small amounts of space between words and characters so that shorter lines come out the same length as longer ones.

Left alignment is usually the best choice for business letters, reports, booklets, and other print publications. Left alignment results in the easiest-to-read text.

To set a paragraph’s alignment, select the paragraphs to affect and then click one of the alignment buttons on the Home tab.

You can also select paragraph alignment from the Paragraph dialog box, although there is no advantage to doing so unless you already happen to have that dialog box open. Use the Alignment drop-down list on the Indents and Spacing tab.

Creating Numbered and Bulleted Lists

Bulleted and numbered lists help break up text into more manageable chunks and make it easier to read and skim. Just look at the text in this book! Regular paragraphs and headings are interspersed liberally with lists to better help you understand the material being presented.

Bulleted and numbered lists almost always use hanging indents, so that the bullet or number character “hangs” to the left of the rest of the paragraph. Back in the days of the typewriter, such formatting was done rather awkwardly with tab stops, but Word’s Bullets and Numbering feature makes list making as simple as clicking a button.

To number an outline, see “Numbering Outline Items,” p. 678.

Caution

Some people use Justified alignment for all their documents, thinking it makes the documents look more polished. Well, it does make for a pretty page, which is nice in a brochure or glossy handout, but it often impedes readability. For text-heavy documents such as letters, business reports, and research papers, stick with Left alignment.

Tip

Some people use bulleted and numbered lists interchangeably, but that’s not always appropriate. When the order of the items is significant, such as in step-by-step driving directions, use numbering. When the order is not significant, such as in a grocery list, use bullets.
Typing a Quick Numbered or Bulleted List

For a quick and simple bulleted or numbered list, use the Bullets button or the Numbering button on the Home tab, as shown in Figure 5.16.

There are two ways to use these buttons:

- Type the entire list, select all the text, and then click the Bullets button or the Numbering button.
- Click one of the buttons first and then start typing the list. Each time you press Enter, a new bulleted or numbered paragraph is created. Press Enter twice in a row to turn off the list formatting and return to normal text.

The bullet character or numbering style applied with these buttons is whatever you most recently used. The default is a plain round black bullet or Arabic numerals (1, 2, 3) in the same font and size as the paragraph text. Later in this chapter, you will learn how to change the bullet character or number style. After you make such a change, Word will remember your setting and will use that new setting for all future lists.

Creating Lists with AutoFormat As You Type

Recall from Chapter 4 that AutoFormat As You Type allows Word to apply certain types of formatting for you, on-the-fly, as you work. The feature includes help for creating bulleted and numbered lists, too.

First, make sure that the options are enabled for numbered and bulleted lists by doing the following:

2. Click Proofing, and then click AutoCorrect Options. The AutoCorrect dialog box opens.
3. Click the AutoFormat As You Type tab.
4. In the Apply As You Type section, make sure that Automatic Bulleted Lists and Automatic Numbered Lists are marked.
5. Click OK to close the AutoCorrect dialog box, and then click OK to close the Word Options dialog box.
Then just start typing a list in Word. For a bulleted list, type an asterisk followed by a tab, and then the text for the paragraph. Or for a numbered list, type a number followed by a tab or period. Word automatically converts the list to use its own Bullets and Numbering feature.

To the left of the new number or bullet, an AutoCorrect Options icon appears. Open its menu and choose Undo Automatic Numbering or Undo Automatic Bullets if you did not intend for AutoFormat As You Type to kick in for that instance (see Figure 5.17). You can also press Ctrl+Z or click Undo to undo the autoformatting immediately after it occurs.

If you decide you do not like the automatic bullets and numbering, you can turn off either or both. Use the preceding steps to go back to the AutoCorrect Options dialog box and clear one or both check boxes, or on the AutoCorrect Options icon’s menu shown in Figure 5.17, choose Stop Automatically Creating Numbered Lists (or Bulleted Lists, as the case may be).

To learn more about AutoFormat As You Type, see “Setting AutoFormat As You Type Options,” p. 169.

**Restarting or Continuing List Numbering**

When one paragraph of a numbered list immediately follows another, Word continues the list without incident. But when there is intervening text, Word can sometimes get confused.

Fortunately, Word *knows* it can get confused, so it asks for your help in the form of an AutoCorrect Options icon. In Figure 5.18, Word has guessed that the new numbered item is a new list, and it has restarted the numbering at 1. But whatever Word guesses, it gives you the option of sending it the other way. Click the AutoCorrect Options icon, and on its menu, click Continue Numbering.
The AutoCorrect Options icon remains next to the paragraph after you switch to Continue Numbering, but its menu choice changes to Restart Numbering so you can go back if needed.

If you don’t see an AutoCorrect Options icon, there’s an alternate way. Follow these steps:

1. Do one of the following to open the Set Numbering Value dialog box (see Figure 5.19):
   - Click in the paragraph to affect. Then on the Home tab, click the down arrow to the right of the Numbering button, opening a menu, and then click Set Numbering Value.
   - Right-click the paragraph to affect, and on the menu that appears click Set Numbering Value.

2. Click Start New List or click Continue from Previous List.

3. Click OK.

**Starting a List at a Certain Number**

Besides starting or continuing a list, you can assign a specific number to a numbered list item. A list need not start with 1; it can start with any number you want, including 0. That can be useful when you are enumerating items that have unusual numbering or when you’re continuing a list from another document.

To set a specific number, display the Set Numbering Value dialog box (refer to Figure 5.19), as in the preceding section, and then enter a specific number in the Set Value To box.

⚠️ Caution

If you are using some other style of numbering, such as letters or Roman numerals, don’t enter that style in the Set Value To box; enter simple Arabic numbers there (1, 2, 3, and so on).
Changing the Number Format

A number format is the specification that defines how the numbering for the numbered list will appear. A number format consists of the following aspects:

- **Number style**—What type of number characters will you use? Choices include Arabic (1, 2, 3), uppercase or lowercase Roman (I, II, III or i, ii, iii), and uppercase or lowercase letters (A, B, C or a, b, c).

- **Font**—In what font, size, and color will the numbers appear? By default, they appear in whatever way is defined by the paragraph’s style, but you can modify that.

- **Extra text or symbols**—What text or symbols will precede or follow the number character? Common symbols to follow a number include a period or a closing parenthesis. Some numbered lists also have text preceding the number, as in Chapter 1, Chapter 2, Chapter 3.

- **Alignment**—What type of tab stop will be used to separate the numbers from the paragraph? The choices are left, right, and centered. The choice determines the way the numbers align.

Alignment is not much of an issue when all the numbers are the same length (such as an Arabic list of fewer than 10 items), but it’s a big issue in longer lists or lists that use Roman numerals. Figure 5.20 illustrates the difference between Left and Right number alignment.

<table>
<thead>
<tr>
<th>Figure 5.20</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alignment governs the tab stop type at which the numbers align.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Right alignment</th>
<th>Left alignment</th>
</tr>
</thead>
<tbody>
<tr>
<td>I. Introduction</td>
<td>I. Introduction</td>
</tr>
<tr>
<td>II. Overview</td>
<td>II. Overview</td>
</tr>
<tr>
<td>III. Sales Meeting Preparation</td>
<td>III. Sales Meeting Preparation</td>
</tr>
<tr>
<td>IV. Report on August Revenue</td>
<td>IV. Report on August Revenue</td>
</tr>
<tr>
<td>V. Planning for Summit</td>
<td>V. Planning for Summit</td>
</tr>
<tr>
<td>VI. Summary</td>
<td>VI. Summary</td>
</tr>
</tbody>
</table>

Selecting from the Numbering Library

The quickest way to change number formats is with the Numbering Library, available from the Numbering button’s drop-down list on the Home tab (see Figure 5.21). You can also access the Numbering Library by right-clicking the selected list and pointing to the Numbering command. Just click the number format you want.

Your number format choice remains in effect (within the current document only) until you select a different number format. Subsequent numbered lists within the document use your chosen format automatically when you create them by clicking the Numbering button on the Home tab.

When you move to a different document (or start a new one), the default numbering reverts to regular Arabic style, but your previous choice remains easily accessible from the Recently Used Number Formats area of the Numbering button’s drop-down list.
Defining a Custom Number Format

If none of the choices in the Numbering Library is right, you can define a custom number format instead. Follow these steps:

1. Select the numbered list to affect.

2. Open the drop-down menu for the Numbering button on the Home tab and click Define New Number Format. The Define New Number Format dialog box opens (see Figure 5.22).

3. Open the Number Style list and select the desired style. Notice that this list contains some additional options that were not in the Numbering Library, such as ordinals (1st, 2nd, 3rd) and text numbering (One, Two, Three).

4. Click the Font button. The Font dialog box appears.

   It is just like the regular Font dialog box, except some of the Effects check boxes are filled with solid squares. These squares indicate “no selection” for those effects. In other words, for those effects, the numbers will inherit the settings from the style. Leave these alone unless you need one of the effects to always be on or off for the numbers; if so, click the check box to cycle through its settings (see Figure 5.23).
Figure 5.22
Define your own number format here.

Figure 5.23
Specify different font formatting for the numbers if desired.
5. If desired, select a different font, font style, size, color, and so on for the numbers; then click OK to return to the Define New Number Format dialog box.

6. In the Number Format box, a code for the number appears shaded in gray. You can’t change that. Click in the Number Format box, though, and place any extra text on either side of that code, such as a period or parenthesis after it or some text such as Chapter or Section before it.

7. Open the Alignment list and select an alignment for the numbering.

8. Click OK. The new numbering format is applied to the numbered list in your document.

After you’ve defined a new number format, it appears in the Numbering Library. It continues to appear there even if you start a new document or close and reopen Word. To remove it from the gallery, right-click it and choose Remove.

### Changing the Bullet Character

With numbering formats, there’s a limit to the creativity because numbers have to be... well, numbers. And there are only so many ways of expressing them. However, with bullet characters, the sky’s the limit. Virtually anything, text or graphic, can be used as a bullet character.

The Bullets button on the Home tab has a drop-down list containing a small library of bullet characters. To apply one of these bullets to your list, select the list and then open the button’s drop-down list and click a bullet (see Figure 5.24).

If you don’t like any of the bullets in the Bullet Library, choose Define New Bullet from the menu. This opens the Define New Bullet dialog box, shown in Figure 5.25. From here, you can choose one of two types: Symbol or Picture.
Creating a Symbol (Text) Bullet

Symbols are text characters. You can select any character from any font installed on your PC—even one of the characters that doesn’t correspond to any of the keyboard keys. To select a symbol bullet, click the Symbol button and then select from the Symbol dialog box (see Figure 5.26). First, choose the desired font from the Font list, and then click the desired character within that font.

Any font is a potential source of symbols, but some are much better suited than others. You wouldn’t typically want to use a regular letter or number as a bullet, for example, and most fonts are primarily letters and numbers. Look instead at the specialty fonts such as Symbol, Wingdings,
Webdings, and Marlett. Not sure which fonts contain potential bullet characters? Open the Font drop-down list on the Home tab and scroll through, looking for fonts where sample characters appear to the right of the name. Such fonts are good candidates. After selecting a symbol as your bullet, click the Font button to change the font formatting for it. You can make all the same changes as for numbers, as you saw back in Figure 5.23. One of the most common changes is to increase or decrease the font size for the bullet, for example.

To install a font, see “Adding More Fonts to Your System,” p. 148.

The Default Bullet Character Appears as a Clock Face

The default bullet character comes from the Symbol font (symbole.fon). If that font is damaged or has been removed from the system, Word falls back on the Wingdings font. Each character within a font has a certain numeric value; when you change to a different font, the numeric value stays the same but the character changes. (That’s why, for example, you get a different-looking capital F when you change to a different font, but it doesn’t change to a capital Z.) Between fonts that contain letters and numbers, there is little difference between the characters represented by the same number, but within fonts designed primarily for use as symbols and bullet characters, there is a great difference.

As you might surmise by all that, the clock symbol in the Wingdings font happens to correspond to the plain bullet symbol in the Symbol font. So, if Symbol isn’t available, all your bullets look like clocks.

To fix the problem, look in the Fonts folder for the Symbol font (symbole.fon). To access the Fonts folder, go through the Control Panel or browse to C:\Windows\Fonts. If the Symbol font is there, delete it. If it’s not there, someone has already deleted it. Replace it by copying the font file from your Windows setup disc, or from another PC that has Windows installed, into the Fonts folder.

Creating a Picture Bullet

To use a picture bullet, click the Picture button in the Define New Bullet dialog box. The Insert Pictures dialog box opens (see Figure 5.27). This dialog box is the same one that you select other graphics from, such as clip art and files stored on your local computer.

You can choose any picture from any source as a bullet character, but you will probably want to stick to small graphics. Microsoft provides an assortment of graphics suitable for use as bullets in
its clip art collection, tagged with the keyword *bullet*. To find and select one of these, click in the Search Office.com text box, type *bullet*, and then press Enter. In the search results, click the bullet character you want and click Insert. (Ignore any images that are of actual bullets like the kind you put in a gun.)

To learn more about inserting art from the Clip Art collection, see “Working with Clip Art,” p. 458.

To use a graphic of your own design for a bullet, from the Insert Pictures dialog box, click the Browse hyperlink and choose a file. Valid graphic formats for bullets include .gif, .bmp, and .jpg (or .jpeg). Simple graphics work best because of the small size; if you use a large complex picture as a bullet, it will be unrecognizable at the size of a bullet. Unlike with a symbol bullet, you cannot directly modify the size of a picture bullet. The paragraph’s font size determines the picture bullet’s size.

**Tip**

Here’s a workaround for picture bullet size. Global settings for a paragraph are stored in its end-of-paragraph marker, so by changing the formatting on that marker, you can affect the bullet character size. Make sure that end-of-paragraph markers are displayed onscreen, so you can see what you’re doing, and then select the marker only. (Position the insertion point to the left of the marker, hold down Shift, and press the right arrow key once.) Then, change the font size from the Font Size list on the Home tab. The picture bullet’s size will change.
Changing the List Level

Word supports up to nine levels of list nesting—that is, placing a subordinate list within a list. You can combine bulleted lists and numbered lists within the same nested structure, too. For example, in Figure 5.28, a numbered procedure has a bulleted list nested under one of the steps, and one of those bullet points has its own nested numbered list.

Here’s the easiest way of creating a nested list: Start typing the main list normally, and press Enter for a new paragraph, and then press the Tab key. An indented, subordinate list item is created, ready for the text to be typed.

When the subordinate list is complete and you want to go back to the main list level, press Enter again to start a new paragraph, and then either press Enter again or press Shift+Tab. Both do the same thing: They promote that paragraph to the next-higher level.

Another way to switch among list levels is with the Change List Level submenu, found on the drop-down list for both the Bullets and the Numbering buttons on the Home tab. Open the submenu and click the desired level for the selected paragraphs, as shown in Figure 5.29.

Got Note

Tab and Shift+Tab control list levels only if you press them when the insertion point is at the beginning of the paragraph, and only when bullets or numbering is turned on. Otherwise, pressing Tab simply tabs over to the next tab stop.

For more information about multilevel numbered lists, especially when used in outlines, see “Numbering Outline Items,” p. 678.
Adjusting Bullet or Number Spacing and Indents

You can define bullet and text indents in Word 2013, but not as part of the bullet or number format. Instead, you make those changes as you would with any other paragraph, through the Paragraph dialog box or with the ruler.

To review the procedures for controlling indents, see “Indenting Paragraphs,” p. 180.

Applying Paragraph Borders

A border is a visible line around one or more sides of a paragraph (or around a group of paragraphs). Borders help create separations in the text to make it easier to read and skim. You can see borders at work in this book, for example, in the tips, notes, and cautions.

You can place a border on any or all sides of a paragraph. The most common usage is to place the border around all sides, creating a box, but you can also achieve interesting effects by applying the sides more selectively. For example, in Figure 5.30, a bottom-only border is used under each heading, and notes are marked with top and bottom borders.

To create a paragraph style, see “Creating a New Style by Example,” p. 227.
Applying and Removing Borders

For a basic border (solid, black, thin), select the paragraphs and then use the Borders drop-down menu on the Home tab. It contains options for borders on various sides of the selection (see Figure 5.31).

Table 5.1 provides a summary of the border choices, along with some notes on their usage.

Tip

Although you can manually apply borders to individual paragraphs, as you learn in this section, it is often more efficient to create a paragraph style that includes the desired border and apply that paragraph style to the desired text.
### Table 5.1  Border Types

<table>
<thead>
<tr>
<th>Menu Selection</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bottom, Top, Left, Right Border</td>
<td>These settings individually turn on a border on each side. and Settings can be combined; select Top and then reopen the menu and select Bottom, for example.</td>
</tr>
<tr>
<td>No Border</td>
<td>Removes all borders from all sides of the selected paragraphs.</td>
</tr>
<tr>
<td>All Borders</td>
<td>Turns on all borders on all available sides of the selected paragraphs. This includes the borders between each pair of paragraphs in a multiparagraph selection.</td>
</tr>
<tr>
<td>Outside Borders</td>
<td>Turns on all borders on all outer sides of the selection. If the selection is a single paragraph, the effect is the same as with All Borders. If the selection is multiple paragraphs, no lines will appear between the paragraphs.</td>
</tr>
<tr>
<td>Inside Borders</td>
<td>In a single-paragraph selection, this does nothing. In a multiparagraph selection, it places borders between the paragraphs but not around the outsides.</td>
</tr>
<tr>
<td>Inside Horizontal Border</td>
<td>In regular paragraphs, this is the same as Inside Borders. In a table, this adds the inside borders between rows only, not between columns.</td>
</tr>
<tr>
<td>Inside Vertical Border</td>
<td>In regular paragraphs, this does nothing. In a table, this adds the inside borders between columns only, not between rows.</td>
</tr>
<tr>
<td>Diagonal Down and Diagonal Up Border</td>
<td>In regular paragraphs, these settings do nothing. In a table, they draw diagonal lines through the selected cells.</td>
</tr>
</tbody>
</table>
Formatting Borders

The Borders button enables you to turn borders on and off, but it doesn’t help you format them. So, if you want a border that’s a different thickness, color, or line style (such as dotted or dashed), you must use the Borders and Shading dialog box.

To format a border, follow these steps:

1. Select the paragraphs to affect. They can already have a border applied to them or not—it doesn’t matter.
2. Open the Borders button’s drop-down list and click Borders and Shading. The Borders and Shading dialog box opens with the Borders tab displayed (see Figure 5.32).

3. Select a border type from the Setting icons along the left side of the dialog box:
   - **None**—Turns off all borders.
   - **Box**—Places an outside border in which all sides are the same thickness.
   - **Shadow**—Places an outside border, and places a shadow effect along the bottom and right sides.
   - **3-D**—Places an outside border with a 3D effect—in theory, anyway. In most cases there is no difference in the result between Box and 3D.
   - **Custom**—Enables you to select and format each side individually. (You can start with any of the other settings, and when you start to change individual sizes, the setting changes to Custom automatically.)

Tip

The Shadow effect that the Borders and Shading dialog box applies is quite limited. You can’t change its size or color, and you can’t shift it to other sides of the paragraph. If you need a more complex shadow, consider placing the text in a text box and then applying a shadow to the text box. That way you get a full range of shadow-formatting tools.
4. On the Style list, select a line style.

5. On the Color list, select a line color. (Color selection works the same here as with any other colored object.)

   For an explanation of Word’s color choices, see “Changing Font Color,” p. 150.

6. On the Width list, select a line thickness.

7. (Optional) If you want to remove the border on certain sides, click the corresponding button in the Preview area. (There is a button for each of the four sides.)

8. (Optional) To control how far the border appears from the text on each side, click the Options button and then enter values (in points) in the Border and Shading Options dialog box (see Figure 5.33). Then, click OK to return to the Borders tab.

9. Click OK to accept the new border.

After having applied border formatting as in these steps, the next borders you apply with the Border button’s drop-down list are formatted in the same way. For example, if you chose a light-green double border in the preceding steps, all new borders you apply will be light green and double until you change to something else (within the current document only).

Note

If you remove the border on one or more sides and a Shadow effect was chosen in step 3, the Shadow effect is removed and the Setting type changes to Custom.
Applying Paragraph Shading

Paragraph shading places a colored background behind the entire paragraph. Shading—like borders—helps make the text stand out from the crowd. You might make the shading on an important warning bright orange, for example, to point out its urgency.

To apply a simple solid-fill shading, follow these steps:

1. Select the paragraphs to affect.
2. On the Home tab, open the Shading button’s drop-down list and click the desired color (see Figure 5.34). To try out different colors before committing, point to a color to see a preview of it.

   For an explanation of Word’s color choices, see “Changing Font Color,” p. 150.

Applying Different Formatting on Each Side

You can create some interesting effects by varying the borders on certain sides. To do this, first turn off the sides in the Preview area of the Borders and Shading dialog box by clicking them. Next, change the formatting selected in the Style, Color, or Width lists, and then click those sides again in the Preview area to reenable them with the new formatting.

For example, for a (somewhat) 3-D effect, apply a thick solid border to the bottom and right sides, and then apply the same style and thickness to the top and left sides but in a lighter color (perhaps a tint of the same theme color you used on the bottom and right).

Note

Don’t confuse paragraph shading with highlighting (from Chapter 4). Highlighting is applied to individual characters within a paragraph; highlighting cannot exist in areas where there is no text (for example, at the ragged right margin of a paragraph). Paragraph shading, on the other hand, extends all the way to the edges of the paragraph on all sides in a neat rectangular form.

Figure 5.34
Select a solid shading color.
Patterned shading is another option. A pattern is a two-tone background that consists of one basic color (the Fill color) overlaid with a pattern of the second color. That pattern can be subtle, such as a spray of fine dots, or dramatic, such as strong stripes. The two colors can sharply contrast for a strong effect or can be very nearly the same for a subtle one.

To create a pattern fill, follow these steps:

1. Select the paragraphs to affect.
2. On the Home tab, open the Borders button's drop-down list and click Borders and Shading. The Borders and Shading dialog box opens.
3. Click the Shading tab.
4. Open the Fill drop-down list and choose the desired color.
5. Open the Style drop-down list and select the pattern style desired (see Figure 5.35).
6. Open the Color drop-down list and choose the color for the pattern.
7. Click OK to apply the pattern.
Preventing Paragraphs from Breaking

In multipage documents, paragraphs don’t always break gracefully. Sometimes, a single line of a paragraph appears either at the bottom or the top of a page. These stray lines are called *widows* and *orphans*, and you can easily prevent them from occurring.

Follow these steps to examine and change the break settings for a paragraph:

1. Select the paragraphs to affect. To affect the entire document, press Ctrl+A.
2. Open the Paragraph dialog box (by clicking the dialog box launcher in the Paragraph group on the Home tab) and click the Line and Page Breaks tab (see Figure 5.36).

3. Mark or clear any of these check boxes as desired:
   - **Widow/Orphan Control**—Ensures that if a paragraph breaks across pages, at least two lines of the paragraph will appear on each page. If this is not possible, the paragraph floats completely to the next page.
Keep with Next—Ensures that the paragraph will not be on a different page from the paragraph that follows it. This is useful for keeping a heading with the body paragraph that follows it.

Keep Lines Together—Prevents a paragraph from breaking at all. If it will not fit at the bottom of a page, the whole paragraph moves to the next page. This is especially useful in tables, where a page break that interrupts the text in a table cell can create confusion.

Page Break Before—Starts the paragraph on a new page. This is useful for chapter and section titles, for example.

4. Click OK.

To create styles, see “Creating a New Style by Example,” p. 227.

Note
If you want to change the widow/orphan setting for all text, including any new text you type later, modify the paragraph style, as you find out how to do in Chapter 6. You can specify line and page breaks in style definitions just like any other paragraph formatting.

Tip
Why use Page Break Before when you could just insert a hard page break before the paragraph? Well, if it’s a one-time instance, that would be fine, but if you are setting up a paragraph style to be reused for multiple headings, all of which should start on a new page, you can save some time by adding the formatting to the style.
This page intentionally left blank
SYMBOLS

' (apostrophes), 874
* (multiplication) operator, 368
+ (addition) operator, 368
, (commas), 100, 371, 629
- (subtraction) operator, 368
. (decimal points), 371
... (ellipsis), 52
/ (division) operator, 368
: (colon), 629, 753
; (semicolon), 629
<<>> (double angle brackets), 570-571
<> (not equal to) operator, 368
< (less than) operator, 368
<= (less than or equal to) operator, 368
= (equal to) operator, 368
> (greater than) operator, 368
>= (greater than or equal to) operator, 368
? (question marks), applying in indexes, 753
\] (curly braces), 626, 628
' (single opening quote), 52
' (single closing quote), 52
" (double opening quote), 52
" (double closing quote), 52
- (en dash), 52
— (em dash), 52
© (copyright), 52
® (registered trademark), 52
™ (trademark), 52

NUMERICS

100 percent bars, 487
1.5 line spacing, 178
2-D charts, 486
3-D charts, 486
effects, applying, 452
Format effect, 158
images, formatting, 406-407
rotation, 409
styles, applying to diagrams, 535

A

ABS() function, 370
accepting revisions, 774
accesing. See also security
adaptive technology, 919-920
AutoFormat, 170-171
AutoSave files, 7
dictionaries, 100
document
creating, 920-923
restricting, 794-798
files, formatting, 920
fonts, sizing, 144
Help
macro security settings, 880
Mini Toolbar, 9
Office 365 SharePoint, 25
privacy options, 812
Quick Access toolbar, 6
recent documents, 36
Setup, 916
SkyDrive, 838-839
templates, 291
workgroups, 294-296
accounts
blogs, managing, 834
fax, 137
Account tab, 8
acronyms, 83
actions, 906
applying, 112-114
configuring, 113-114
enabling, 883
logical conditions, 877
macros, 875. See also macros
.NET programmability
support, 918
plug-ins, 918
active documents, saving
macros, 858
ActiveX controls, 661, 918
adaptive technology, 919-920
Add Gradient Stop button, 446
adding
alt text descriptions to
documents, 414-415
images, 414-415
arrows, 427
bulleted lists, 527
buttons
to Quick Access toolbars, 886-887
to toolbars, 20
captions
to figures, 744
to tables, 364-365
columns, 480
commands, 6, 886, 890-892
comments, 92, 776-777
custom dictionaries, 105
digital signatures, 813
error bars to charts, 505-476
figure captions, 412-414
fonts, 148
graphics to envelopes, 322
help to fields, 662
hyphens to images, 414-415
indicators to status bars, 51
multiple TOCs to documents, 742
page number codes, 265-266
partial TOCs to documents, 742-743
plain text AutoCorrect entries, 110
research providers, 124
rows, 480
ScreenTips, 826
shapes, 526-527, 533
sources, 706
text
to diagrams, 529
to shapes, 427, 434
titles to charts, 490-491
trendlines, 501-504
trusted locations, 805
up/down bars to charts, 507
words to custom dictionaries, 101
add-ins, 855
applying, 881-883
disabling, 906-907
troubleshooting, 883
addition (+) operator, 368
Address Block dialog box, 555
<<AddressBlock>> field, 556, 561
inserting, 571
troubleshooting, 572
[AddressBlock] field, 638
addresses
actions, 112
blocks, inserting, 571-572
e-mail.  See also e-mail
envelopes
formatting, 318-323
positioning, 320
hyperlinks, 598, 827-828
mail merge, 555
retrieving, 322
saving, 322
validating, 581
advanced filters, creating, 578-579
Advanced Track Changes Options dialog box, 771
[Advance] field, 635
advancing records, 591
algorithms, compression, 380
aligning
hanging indent, 232
images, positioning, 390-393
legends, 492
numbers, 195
objects, 437-438
paragraphs, formatting, 191
Quick Access toolbar, 885
shapes, 434
tables, 362
text
cells, 360
Click and Type feature, 58
text boxes, 310
titles, 490
vertical alignment, 257
WordArt, 457
ALL CAPS, 156
All Fonts, 142
All Markup, 767
alternative input devices, 920
alt text descriptions, adding images, 414-415
anchors
applying, 390-391
lines to shapes, 433-434
modifying, 434
AND (x, y) function, 370
angles, formatting, 428-429
antonyms, 116-117
apostrophes (‘), 874
AppData folders, searching, 302
appearance, optimizing labels, 326-327
applications
clip art, applying in other, 459
data, embedding from other, 610
dummy text, inserting, 85
embedding data from other, 610
linking, 597
order of style, 214, 687
PaintShop Pro, 379
Photoshop, 379
tables, pasting from, 375-376
voice recognition software, 920
Windows 8 SkyDrive, 839
Word Web App, 837, 851-854
applying
3-D effects, 452
actions, 112-114
add-ins, 881-883
anchors, 390-391
Apply Styles pane, 220
artistic effects to images, 402
[Ask] fields, 587-589
AutoCorrect, 106-112
AutoFormat, 168-173
balloons, 768-771
beveled edges to images, 406-407
bookmarks, 601-606
borders, 204, 283-284
to cells, 355-358
to clip art, 466-467
to images, 410
building blocks, 85-90
clip art, 381-382, 458-460
Crop tool, 395
data labels to charts, 493-495
dictionaries, 114-116
Document Recovery task pane, 903
effects
  bevels, 515
glow, 514
reflection, 514
shadows, 513
shapes, 512
soft edges, 515

elements to charts, 489-509
e- postpone, 323
Equation Editor, 542-549
Equation Gallery, 548
element bars to charts, 506
exclusion dictionaries, 104

gradient effects
gradients, 445-448
images, 443-444
patterns, 450
shapes, 512
textures, 448-450

{FillIn} fields, 585-586
filters, 577

fixed-width data files, 560
fonts, 139-142
colors, 149-152
sets, 530
styles, 153-154

Format Painter, 165-166
frames, 315-316
glow to images, 406

Go To, 78-79
gridlines to charts, 501
hyperlinks, 594-600

lists to multilevel outlines, 678-680
mail merge to letters, 553-556

multiple columns, 277-281
multiple headers/footers, 272
multiple TOCs, 742-743
Office Clipboard, 68-69
outlines to shapes, 512, 538
page backgrounds, 281
presets
columns, 279
images, 403

Print Preview, 130
quick layouts to charts, 490
reflections to images, 406

research tools, 114-125
shading to paragraphs, 207-209
shadow effects, 452
clip art, 468
images, 404-405
shortcuts to styles, 233-234
SmartArt, 410, 521

soft edges to images, 406
solid color backgrounds, 354
solid-fills
  shading, 208
  shapes, 442
Style Gallery, 216-217
Style Inspector, 223
styles, 215
cascading, 237-238
charts, 509
citations, 704-706
default tables, 351
images, 403
lists, 681
shapes, 438, 511-512, 538
SmartArt, 535-536
tables, 350-351
Styles pane, 218-220
tab stops, 184-190
templates, 20-24, 286, 298
global, 299-300
Microsoft, 287-290
note cards, 328
text boxes, 307
themes, 243-248, 537, 678
thesauruses, 116-117
underlining to text, 154-155
views, 12-16
watermarks, 274-277
WordArt styles to text, 455, 532
WordML, 29-30
Word Web App, 851-854

Apply Styles pane, 220
areas
  charts, 486
  headers/footers, 263
  plot, 475
styles, viewing, 224
arguments, separating, 629

Arrange All shortcut, 16

arrows, 52, 421
adding, 427
scrolling, 57

artistic effects, applying to images, 402
ascending sorts, 367
ASCII, 55
{Ask} field, 587-589, 638
aspect ratios, 396

assigning. See also selecting actions, 112-114
bookmarks to fields, 662
fonts, 139
keyboard shortcuts to styles, 233-234
macros, 860-862, 871-872
numbers to mail merge records, 590-591
passwords, 795
shortcuts to symbols, 55

associating content with headers/footers, 273
At Least value (line spacing), 179

attaching CSSs, 831

Attach Template dialog box, 298
attacks, preventing macro-based, 804-807
attributes, modifying text, 531
{Author} field, 632

authorities, generating table of, 748-749

AutoCaption dialog box, 414
AutoClose macro, 865

AutoCorrect, 595
applying, 106-112

corrections, rejecting, 106-108

customizing, 108-110
dialog box, 192
entering, 55

formatting, 110-111
grammar/spell checks, 98

math, 111-112
modifying, 110

How can we make this index more useful? Email us at indexes@quepublishing.com
plain text, 110  
symbols, inserting, 59-52  
AutoCorrect, 928  
AutoExec macro, 865  
AutoFit  
modifying, 346-347  
tables, 335  
AutoFormat, 168-173  
AutoFormat As You Type, 192-193  
AutoMark, 751  
documents, generating, 756  
index entries, 755-756  
automating  
backup copies, creating, 905  
captioning, 414  
editing, applying  
AutoCorrect, 106-112  
fields, 637-638  
grammar/spelling checks, 91-97  
hyperlinks, 594-595  
hyphenation, 83-84  
micros. See macros  
stles, 229, 235  
symbols, 55  
tables, formatting TOCs, 733  
templates, modifying all open documents, 300-302  
{AutoNum} field, 634  
{AutoNumLgl} field, 634  
{AutoNumOut} field, 634  
AutoOpen macro, 865  
AutoRecover, 48, 901-903  
AutoShapes, 421  
AutoText, 85-90  
{AutoText} field, 625, 637  
{AutoTextList} field, 637  
availability, formatting  
micros, 868-870  
AVERAGE() function, 370  
averages, moving, 504  
axes  
numbers, modifying, 501  
properties, modifying, 497  
scaling, 498  
text, turning off/on, 497  
titles, 475, 496  
Axis Labels dialog box, 482  

B  
backgrounds  
cells, modifying colors, 354-355  
charts, 475  
fill effects, applying clip art, 464-465  
images, deleting, 401  
pages, applying, 281  
printing, 282  
shapes, overlapping, 435  
backing up, 905. See also saving  
Backstage view, 7-8, 35-36  
backward-compatible charts, 477  
balloons  
revisions, formatting, 768-771  
troubleshooting, 771  
banners, formatting, 317-318  
bar charts, 486  
{BarCode} field, 634  
bars  
tab stops, 187  
up/down, adding, 507  
Before or After spacing, 180  
beveled edges, applying to images, 406-407  
bevels, applying, 515  
bibliographies, 703-704. See also citations  
deleting, 717  
fields, 714  
formatting, 713-717  
generating, 704, 713-717  
saving, 716  
Bibliography Gallery, 714  
Bing searches  
images, inserting from, 386  
video, inserting, 415  
bit depth, 379-380  
bitmap images, 378, 420. See also images  
black-and-white images, 380  
blank documents. See also documents  
filtering, 577-578  
formatting, 18-20  
printing, troubleshooting, 136  
blocking files, 808-810  
blocks  
addresses, inserting, 571-572  
mail merger, 555  
blogs, 831-835  
entries, categorizing, 834  
images, inserting, 833-834  
interfaces, 832  
lists, managing, 834  
modifying, 835  
posting, 833  
servers, registering, 832-833  
.bmp files, 378, 382. See also bitmap images  
<BODY> section, 824  
body text, 673  
bold, applying to fonts, 153-154  
book folds, configuring, 254-255  
Bookmark dialog box, 562, 587  
{Bookmark} field, 601, 625  
bookmarks, 594, 920  
applying, 601-606  
{Ask} fields, 587  
cross-references, inserting, 605-606  
Error! Bookmark Not Defined message, 735  
fields, assigning, 662  
formatting, 602  
hyperlinks  
inserting, 603  
linking in documents, 604-605  
jumping to, 603
How can we make this index more useful? Email us at indexes@quepublishing.com
captions, 691
  cross-references, 729
  Figure Captions feature, 412-414
  figures, adding, 744
  marking, 746
  tables, formatting, 364-365

capturing screenshots, 386-387

cascading style sheets. See CSS

cascading styles, 237-238

case (text), 158-159

categories
  axis (X axis), 473
  blog entries, 834
  charts, 486. See also types
  Category option, 749

CCDs (charge-coupled devices), 378

cells
  backgrounds, modifying colors, 354-355
  borders, applying, 355-358
  charts, editing, 480
  deleting, 341
  inserting, 339-341
  margins
    configuring, 358
    formatting, 359-360
  merging/splitting, 343-345
  moving, 338
  nonprinting end-of-cell markers, 337
  selecting, 336-338
  shading, 354
  tables, creating, 333
  text, aligning, 360
  width, 335

center tab stops, 186

certificates, VBA projects, 918
Change Case button, 158
Change Chart Type dialog box, 485, 488
Change Colors command, 510
Change Title button, 824
Character Spacing tab, 531

characters
  bulleted lists, modifying, 198-201
  deleting, 50
  Equalize Character Height option, 518
  formatting, 139, 875
    adding fonts, 148
    adjusting spacing, 160-162
    applying font styles, 153-154
    AutoFormat, 168-173
    case (text), 158-159
    clearing, 166
    comparing/revealing, 166-167
    configuring default fonts, 146
    copying, 165-166
    creating drop caps, 163-165
    customizing font colors, 149-152
    embedding fonts, 149
    highlighting text, 158-159
    modifying fonts, 141-145
    OpenType/TrueType fonts, 147-148
    selecting fonts, 139-142
    specifying fixed default fonts, 146
    text/font effects, 156-158
    theme fonts, 146-147
    underlining text, 154-155
  nonprinting, viewing, 176
  revisions, 783
  special, 52-55. See also special characters
  styles, 214. See also styles

charge-coupled devices. See CCDs

Chart Elements icon, 489
Chart Tools Design tab, 480
Chart Tools Format tab, 484

charts, 473
  axes. See also axes
  numbers, 501
  scaling, 498-500
  titles, 496

  backward-compatible, 477
  branches, positioning, 527
  categories, 486
  combination, 487-489
  data labels, applying, 493-495
  data ranges, modifying, 481-483
  elements, 489-518
  error bars, adding, 505-476
  Excel, copying, 477
  flowcharts, 433-434
  formatting, 475-477
  gridlines, applying, 501
  legends, 492
  modifying, 480-483
  navigating, 473-475
  positioning, 483-484
  Quick Layout button, 490
  shapes. See shapes
  spacing, modifying, 517
  styles, applying, 509
  subtypes, 486
  templates, formatting, 478-480
  text
    formatting, 518-520
    wrapping, 483
  titles, 475, 490-491
  trendlines, modifying, 501-504
  types, modifying, 485-487
  up/down bars, adding, 507
  WordArt, formatting, 518-520

check boxes
  customizing, 659-660
  options, 654-655
  Tile Picture as Texture, 444

Choose Profile dialog box, 555

circles, 421

citations
  editing, 709, 712-713
  marking, 746-747
  overview of, 703-704
  plain text, converting, 713
  styles
    modifying, 723
    selecting, 704-706
Clear All Formatting command, 159
clearing, See also deleting formatting, 165
manually applied formatting, 511
styles, 222-224
Click and Type feature, 58-59
clip art, 381-382, 419. See also images
applying, 458-460
backgrounds, applying fill effects, 464-465
borders, applying to, 466-467
cropping, 463
editing, 469-471
flipping, 468
images, modifying, 463-469
moving, 470-471
Office.com, searching, 459-460
recoloring, 470
resizing, 470-471
rotating, 468
shadow effects, applying, 468
sizing, 463
text, wrapping, 460-463
transparent colors, configuring, 465-466
Clip Organizer, 458
Clipboards, 63
columns/rows, copying, 341
text, moving, 68-69
clock faces, default bullets, 200
Close tab, 8
closing
automatic hyphenation, 84
text panes, 533
clusters
charts, 486
styles, creating, 226
CMYK (Cyan/Magenta/Yellow/Black), 379
code
fields
deleting, 265
editing strings, 629
headers/footers, 265
[IncludePicture] fields, 620
inserting, 594
manually typing, 626-628
troubleshooting syntax errors, 628-629
viewing, 627
indexes, 751. See also indexes
macros
editing VBA, 873-879
troubleshooting, 868
numbering types, 643
text string, finding/replacing, 77
time, inserting, 268-270
VBA. See VBA
collaboration, 765-766
comments, 776-778. See also comments
documents, sharing, 785-790
PDF files, 790-792
Read Mode, 783-785
revision tracking options, 766-772. See also revisions
XPS files, 790-792
collapsing
groups, 7
outlines, 674
Ribbon, 888
subdocuments, 694-695
collation, 108, 127
colon (:), 629, 753
colors
borders, 356
cell backgrounds, modifying, 354-355
charts, applying, 509
clip art
modifying, 463
recoloring, 470
defining, 379, 442
diagrams, modifying, 537
fonts
applying, 531
customizing, 149-152
gradients, applying fill effects, 445-448
highlighting, 160
hyperlinks
formatting, 596
modifying, 600
images
depth, 379-380
models, 379
modifying, 399-400
legends, 492
page backgrounds, applying, 281
revisions, formatting, 771
sets
applying, 245
formatting, 245-247
solid-fills, applying, 440
transparent, configuring, 465-466
underline, 154
VML, 816
Color Saturation command, 400
Color Tone command, 400
Colors dialog box, 411
Column settings, indexes, 761
columns
adding, 480
charts, 486
copying, 341-343
customizing, 280
deleting, 341, 478, 480
hiding, 480
moving, 339-343
multicolumn layouts, formatting, 828-830
multiple, 277-281
presets, 279
resizing, 347
rows, switching between, 483
selecting, 338-339
sizing, 348
web pages, saving as, 817
width, distributing, 350

How can we make this index more useful? Email us at indexes@quepublishing.com
Columns dialog box, 11, 280
COM (common object model), 881, 907
combination charts, formatting, 487-489
combining
documents, 669, 780
multiple documents, 782
commands
adding, 6, 890-892
Change Colors, 510
Clear All Formatting, 159
Color Saturation, 400
Color Tone, 400
COM, 881
Convert, 34
Copy, 63-64
Cut, 63-64
Define New List Style, 684
deleting, 892
Edit Picture, 469
groups, populating, 892
macros. See macros
running as, 866
syntax, 875-879
More Variations, 400
Online Picture, 465
Paste, 63-66
Paste Special, 67-68
Picture Color Options, 400
Quick Access toolbar, adding, 886
Recolor, 400
Set Default Paste, 65
Set Transparent Color, 400
commas (,), 100, 371, 629
comments, 776-778
adding, 92
deleting, 778
inserting, 776-777
restricting, 801
viewing, 777-778
[Comments] field, 632
common object model. See COM
Compare, Diagnostics, and Inventory Management, 918
[Compare] field, 630, 638
comparing
2-D and 3-D charts, 486
documents, 778-784
formatting, 166-167
frames/text boxes, 316
compatibility
blogs, 832
formatting, 31
saving web pages, 821
sharing, 911-912
Compatibility Mode, 286
Compressed Macintosh PICT. See .pcz files
Compressed Windows Metafile. See .wmz files
compression, 380, 397-398
computers
default save locations, 46-48
shortcuts, 25
conditions
If...Then...Else field, 589-590
logical, macros, 877
configuring
actions, 113-114
AutoCorrect, 108-112
AutoFit, modifying, 346-347
automatic backup copies, 905
automatic hyphenation, 83-84
AutoRecover, 48, 901-903
book folds, 254-255
bookmarks, 590
cells, margins, 358
columns, 280
conditions, If...Then...Else field, 589-590
custom dictionaries, 104
default fonts, 146
default formats, saving, 912
default save locations, 46-48
envelopes, sizing, 319
fax modems, 96
file blocking, 808-810
file-handling preferences, 45-48
fonts, themes, 146-147
general options, 898-899
grammar check, 99-100
gutters, 254-255
interfaces, exporting/importing, 893-894
labels, printing, 324
macros, modifying, 807
mail merge, 552
directories, 575
envelopes, 558
labels, 559-560, 574
multicolor gradients, 446
Multiple Pages setting, 254
No Border setting, 355
nondefault settings, 19
Oracle databases, 564
page orientation, 255-256
paper sizes, 256-257
personalization, 898
presets, positioning, 432
privacy, 810-812
properties
tables, 317
printers, 134
Protected View, 808-810
rules, text boxes, 306
security, macros, 880
SQL databases, 564
styles, status, 241
tables, aligning, 362
text, wrapping, 388-390, 460-463
transparent colors, 465-466
trusted locations, 595
values
indenting, 181-182
line spacing, 178-179
vertical alignment, 257
web page resolution, 823
confirming files, converting, 911
connecting
ODBC data sources, 565
points, toggling, 434
connectors
curves, 423
modifying, 428-429, 434
shapes, joining, 433
<table>
<thead>
<tr>
<th>Customizing</th>
<th>933</th>
</tr>
</thead>
</table>

- What can we make this index more useful? Email us at indexes@quepublishing.com.

<table>
<thead>
<tr>
<th>Customizing</th>
<th>933</th>
</tr>
</thead>
</table>

- **contact lists**, 561
- **content**
  - controls, 648-649
  - configuring, 650
  - customizing, 650-651
  - formatting forms with, 650-655
  - inserting, 650-651
  - preventing accidental deletion, 666
- **document information controls**, 633
- **status bars**, modifying, 896
- **context, cross-references**, 728-729
- **continuing**
  - footnotes, 725
  - numbering, 193-194
- **Continuous section break**, 250
- **contrast, images**, 398
- **controls**
  - ActiveX, programming, 661
  - content, 648-649
  - configuring, 650
  - customizing, 650-651
  - formatting forms with, 650-655
  - inserting, 650-651
  - preventing accidental deletion, 666
  - document information content, 633
  - Height/Width, 432
- **conventions, formatting indexes**, 750
- **Convert button**, 35
- **Convert Text to Table dialog box**, 189
- **converters**, 918
- **converting**
  - citations to plain text, 713
  - documents, 34
  - fields to plain text, 641
  - files, confirming, 911
  - fonts, 149
  - frames, 316
  - images, color models, 379
  - from Microsoft Works, 910
  - objects, SmartArt, 541
  - from previous versions, 909-910
  - tabbed lists to tables, 189
  - text, formatting tables, 373-374
  - unreadable files, 904
  - from unsupported file formats, 911
  - from WordPerfect, 910-911
- **Copy command**, 63-64
- **copying**, 593
  - automatic backup copies, creating, 905
  - characters, formatting, 165-166
  - charts from Excel, 477
  - Clipboards, 68
  - columns, 341-343
  - documents, printing, 127
  - hyperlinks, 788
  - image resolution, 381
  - macros between documents, 868-870
  - modules, 870
  - outlines, 688
  - rows, 341-343
  - styles, 242
  - tab stops, 190
  - themes, 248
- **copyright**, 52
- **Correction button**, 398
- **corrections, rejecting**
  - AutoCorrect, 106-108
- **COUNT() function**, 370
- **Cover Page feature**, 260-262
- **crashes**
  - add-ins, troubleshooting, 883
  - files, recovering, 901-904
  - master documents, 689
  - troubleshooting, 905-907
- **{CreateDate} field**, 632
- **Create New Building Block dialog box**, 262
- **Create New Style from Formatting dialog box**, 227, 232
- **CSS (cascading style sheets)**, 816
  - fonts, formatting, 821
  - `<p>` (paragraph tag), 831
  - web pages, formatting, 831
- **curly braces**, ()), 626-628
- **current documents, printing**, 125-130
- **Current List section**, 680
- **Current Page option**, 752
- **Current Selection group**, 501
- **curves**
  - charts, 487
  - connectors, 423, 428-429
  - lines, drawing, 422-423
  - modifying, 429-430
- **Custom Dictionaries dialog box**, 101
- **Custom heading**, 290
- **Custom tab**, 441
- **Customize Keyboard dialog box**, 234, 861, 894
- **customizing**
  - 3-D effects, 410
  - advanced filters, 578-579
  - AutoCorrect, 108-110
  - AutoFormat, 171
  - AutoRecover, 901-903
  - bookmarks, text, 590
  - Capitalize Each Word option, 158
  - check boxes, 659-660
  - columns, 280
  - content controls, 650-651
customizing

cross-references, 727-728
data labels, 494
dates, 631, 644
date/time fields, 269
dictionaries, 98
  adding, 101, 105
  formatting, 103-104
documents, 131-134, 900
drop caps, 164
fields, 568
  properties, 626
  styles, 652
file-handling preferences,
  45-48
Find feature, 73-74
fonts, colors, 149-152
gradients, 448
grammar check, 99-100
If...Then...Else field, 589-590
images
  cropping, 395-396
  positioning, 390-393
interfaces, 885, 900
commands, 890-893
configuring general
  options, 898-899
defining shortcut keys,
  894-895
exporting/importing,
  893-894
groups, 889-890
Quick Access toolbar,
  885-887
resetting, 893
Ribbon, 888-889
viewing, 895-897
label specifications, 325-326
layers, 435
lists, 661
macros, assigning, 855
mail merge, 584-591
numbers
  defining formats, 196-198
  formatting, 643-644
paper sizes, 256-257
paragraphs, indenting,
  182-184
personalization, 898
positions, 392-393
privacy, 812
properties, 44-45
Quick Access toolbar, 20
revision tracking, 766-772
SmartArt diagrams, 525-529
spell check, 97-106
style rules, 99-100
Styles pane, 221-222
tabs, 189, 889-890
templates, 291
time, 644
TOCs, 737, 741
trendlines, 504
watermarks, inserting,
  275-276
web pages, saving, 820-825
Cut command, 63-64
Cyan/Magenta/Yellow/Black, 379
cycles, diagrams, 522

D

DAISY (Digital Accessible
  Information System), 920
data, embedding, 607-611
{Database} field, 638
databases
  data sources, selecting as,
    564-565
duplicate entries, searching,
  581
exporting, 373
mail merge, 552
data labels, 475, 493-495
data merge, 551
data points, 473
data ranges, modifying charts,
  481-483
data-recovery features,
  901-904. See also recovering
data series, 473, 517
data sources, selecting mail
  merge, 563-569
data tables, 475, 508-509
datasheets. See also charts
  editing, 480
  modifying, 478
{Date} field, 625, 631
dates
  actions, 112
customizing, 631, 644
  fields, 631-632
inserting, 268-270, 658
options, 654
sorting, 366
days, 269. See also time
dBASE databases, 565. See also
databases
decimal points (.), 371
decimal tab stops, 187
decreasing indents, 182
decrypting folders, 797
default custom dictionaries,
  100, 104
default envelope sizes, 319
default fonts, 140
colors, 149
configuring, 146
fixed, specifying, 146
web pages, modifying, 824
default formats
  modifying, 19
  saving, configuring, 912
default personal template
  locations, 291
default print settings, 125
default save locations,
  configuring, 46-48
default styles, TOCs, 738-739
default tab stops, modifying
  intervals, 189-190
default table styles, applying,
  351
default underline styles, 154
DEFINED(x) function, 370
Define New Bullet dialog box,
  198
Define New List Style
  command, 684
dialog boxes

defining
bitmap images, 378
borders, 355
colors, 152, 379, 442
custom number formats, 196-198
list formatting, 682
properties, customizing, 44
shortcuts, interfaces, 894-895
styles, 215, 229-233
indexes, 762
modifying, 235
TOCs, 740
tab stops, 187-188
workgroup template locations, 294

Delete Cells dialog box, 341

deleting
add-ins, 881
arrows, 427
AutoCorrect entries, 110
backgrounds, 401
bibliographies, 717
borders, 204
building blocks, 90
buttons, 6, 886-887
cells, 341
characters, 50
columns, 341, 478-480
commands, 892
comments, 778
cover pages, 260
dividers, 343
drawing canvases, 425
field codes, 265
files from SkyDrive, 848-850
formatting, 341
frames, 316
hyperlinks, 600
items from Clipboards, 68
keyboard shortcuts, 234
macros, 868-870
modules, 870
multilevel lists, 687
passwords, 795-796
personal information, 810
print jobs, 137
research providers, 124
rows, 341, 478-480
section breaks, 251
shapes, 527
share permissions, 798
sources, 709
styles, 217, 222-224, 234
subdocuments, 696
tabs, 890
tab stops from rulers, 187
templates, 480
text
boxes, 307
highlighting, 159
TOCs, 735
watermarks, 275
delimited data, 373
overview of, 560
sorting, 367
delimited text, selecting data sources, 564
demoting
outline items, 671-672
shapes, 527, 533
design. See also formatting
Chart Tools Design tab, 480
fonts, selecting defaults, 146
forms, 646-648
SmartArt diagram layouts, selecting, 526
Design tab, 6
Desktop (Windows), SkyDrive, 844
Developer tab, 298,
developing web pages, 815-818
devices
alternative input devices, 920
CCDs, 378
printers, 135-. See also printing
scanners. See scanners
diagrams
colors, modifying, 537
formatting, 535-540
positioning, 541
resizing, 540
SmartArt, 521-524
inserting, 524-525
modifying, 525-529
text, 529-534

dialog boxes, 9-12
Address Block, 555
Advanced Track Changes Options, 771
Attach Template, 298
AutoCaption, 414
AutoCorrect, 55, 92, 192, 595. See also AutoCorrect Axis Labels, 482
Bookmark, 372, 562, 587
Borders and Shading, 354, 357
Caption, 412
Change Chart Type, 485, 488
Choose Profile, 555
Colors, 441
Columns, 11, 280
Convert Text to Table, 189
Create New Building Block, 262
Create New Style from Formatting, 227, 232
Create Source, 707
Cross-Reference, 726
Custom Dictionaries, 101
Customize Keyboard, 234, 861, 894
Define New Bullet, 198
Delete Cells, 341
Drop Cap, 164
Encrypt Document, 795
Enter Text, 818
Envelope Options, 557
Equation Options, 546
Fax Setup, 137
Field, 626
Field Options, 626
Find Locations, 48, 294
Filter and Sort, 579
Find and Replace, 70-72, 878
Find Duplicates, 581

How can we make this index more useful? Email us at indexes@quepublishing.com
Find Font, 75
Font, 144, 518, 532
applying underlining from, 155
modifying spacing, 160
Font Substitution, 150
Frame, 316
General Options, 794
Hidden and Empty Cell Settings, 480
Index, 758
Insert Chart, 476-478, 489
Insert Field, 617
Insert Greeting Line, 573
Insert Hyperlink, 596, 826
Insert Picture, 382, 443
Insert Table, 333-334
Insert Word Field: Ask, 588
Insert Word Field: Fill-In, 586
Label Options, 323, 557
Layout, 306, 484
Log On As, 28
Macros, 866
macros, 856
Mail Merge Recipients, 554, 561
Manage Styles, 238-239, 688
Mark Citation, 746
Mark Table of Contents Entry, 736
Merge to New Document, 557
Modify Style, 235, 732, 740
New Address List, 566
New Multilevel List, 681
Object, 613
Open, 36-38, 243, 293, 909
Organizer, 869
Page Setup, 252, 257
Paragraph, 178, 677, 732
Properties, 43, 824
Recognized Math Functions, 112
Record Macro, 858
Rename, 889
Replace, 877
Research Options, 124
resizing, 26
Save As, 12, 26-27, 794, 818
Save Chart Template, 478
Select Contacts, 561
Select Data Source, 481, 566
Set Numbering Value, 194
SmartArt Graphic, 524
Source Manager, 707
Start Enforcing Protection, 800
Style Pane Options, 221, 226
Symbol, 54-55
Table of Authorities, 748
Table of Contents, 739
Table Options, 359
Table Properties, 348
Tabs, 187-188
Templates and Add-Ins, 883
Text File Connection Parameters, 564
Track Changes Options, 768, 770
Trust Center, 805
Web Options, 820, 823
Word Options, 48, 595, 772, 903, 911
grammar/spelling checks, 97
Paste command options, 65
dictionaries, 98
customizing, 105
definitions, checking with, 114-116
definitions, checking with,
editing, 101-102
exclusion, 104
languages, modifying, 102
managing, 100-105
Digital Accessible Information System. See DAISY
digital cameras, 378. See also images
digital certificates, VBA projects, 918
digital photography, overview of, 377-381
digital signatures, 813, 880
digits
options, 371
requirements, 371
directions
flow, modifying diagrams, 526
text
formatting, 497
modifying, 361
in text boxes, modifying, 313
directories, mail merge, 552
configuring, 575
formatting, 557
disabling
actions, 883
add-ins, 881, 906-907
AutoCorrect, 108
automatic hyperlink creation, 595
automatic hyphenation, 83-84
balloons, 769
custom dictionaries, 104
definitions, checking with, 114-116
dexter, 101-102
exclusion, 104
languages, modifying, 102
managing, 100-105
display mode, 548. See also viewing
distributing
column width, 350
document, formatting hyperlinks, 787-788
features, 821
revision tracking, 773
styles, 221
dividers, deleting, 343
division (/) operator, 368
.doc files, 32
.docm files, 32
{DocProperty} field, 633
document Inspector, 907
document Recovery task pane, 903
documents
accessing
creating, 920-923
restricting, 794-798
actions, applying, 112-114
active, saving macros, 858
AutoFormat, 170
AutoMark, generating, 756
automatic backup copies, creating, 905
blank, troubleshooting printing, 136
blogs, 831-835
bookmarks, applying, 601-606
building blocks, applying, 85-90
charts, formatting, 476-477
collaboration, 765-766, 785-790
combining, 669, 780
comments, restricting, 801
comparing, 778-784
converting, 34, 911
See also converting
crashes, troubleshooting, 905-907
customizing, 900
data sources, selecting as, 563
distributing, formatting hyperlinks, 787-788
dummy text, inserting, 85
faxing, 137-138
fields, automating, 637-638
file-handling preferences, 45-48
final, marking as, 804
formatting, 18-20, 249
applying page backgrounds, 281
borders, 283-284
Cover Page feature, 260-262
headers/footers, 262-272
inserting page breaks, 259-260
linking, 598-599
modifying margins, 252-255
multiple columns, 277-281
numbering lines, 257-259
paper sizes, 256-257
repeating elements on every page, 272-273
selecting, 29-33
vertical alignment, 257
watermarks, 274-277
grammar/spell checks, customizing, 97-106
indexes. See indexes
information fields, 632-633
interfaces, navigating, 5-12
iron-on transfers, printing, 135
linking, 604-605. See also linking
macros, copying between, 868-870
mail merge, 551, 582-583.
See also mail merge
preparing, 569-570
selecting main document types, 557-560
manual hyphenation, 85
mapping, 79
margins, formatting, 130
master documents, 688-691.
See also master documents modifying
automating template changes to all, 300-302
editing templates, 296
multiple
formatting indexes across, 762-764
viewing, 15-16
multiple indexes in single, 764
multiple TOCs, adding, 742
navigating, 57-60
nondefault settings, 19
online content, 815. See also online content
opening, 35-41
Outlining feature, 669. See also outlines
paragraphs, 186. See also paragraphs
partial TOCs, adding, 742-743
PDF/XPS files, saving as, 780
printing, 125-135
current documents, 125-130
customizing, 131-134
default print settings, 125
managing print settings, 135-136
properties, inserting, 270
Read-Only mode, formatting, 41
recovering, 901-904
research tools, applying, 114-125
saving, 24-34
security, 793. See also security
adding digital signatures, 813
configuring Protected, 808-810
formatting read-only, 798-801
password-protecting, 794
preventing macro-based attacks, 804-807
privacy, 810-812
saving with passwords, 794-795
sharing, 911-912
SkyDrive, 843-851. See also SkyDrive
starting, 18-24
status bars, modifying, 896
styles, copying between, 242
tables, 331. See also tables
templates. See also templates
applying, 286
formatting, 20-24, 297-298
modifying, 298-303
starting, 287-291
troubleshooting, 303
viewing, 286
themes
applying, 243-248
modifying effects, 536
translating, 118-122
usernames, modifying, 772
views, switching, 12-13
Word 2010, opening/saving, 45
Word Web App
editing, 852
starting, 853
zooming, modifying, 14-15

How can we make this index more useful? Email us at indexes@quepublishing.com
e-mail
documents, sharing, 786
hyperlinks, formatting, 598, 827-828
mail merge, 552, 557, 584
messages, creating forms within, 657
Word, sending from, 835-836
e-postage, applying, 323
edges
beveled, formatting, 406-407
soft, formatting, 406
vector graphics, 420
Edit Picture command, 469
Edit Recipient List button, 562
editing, 91
AutoCorrect entries, 110
automating, applying AutoCorrect, 106-112
blogs, 835
charts, 480
citations, 709, 712-713
clip art, 469-471
collaboration, 765-766
comments, 776-778
data ranges, 481
data sources, 569
dictionaries, 101-102
Equation Editor, 542-549
existing files, 852
grammar/spell checks
configuring, 91-97
customizing, 97-106
headers/footers, 273
hyperlinks, 599
images, cropping, 395-396
indexes, spell-checking, 759
macros, 870, 873-879
multilevel lists, 684
numbers, formatting, 371
PDF files, 792
properties, 44
Read Mode, 783-785
read-only, restricting, 799-801
records, excluding, 577
revision tracking options, 766-772
sources, 708
strings, field codes, 629
subdocuments, 695-696
tables, 336-346
templates, 293, 296
text, 49, 533
diagrams, 529
inserting special characters/symbols, 52-55
placeholders, 655
Redo feature, 51
Repeat feature, 52
switching between Insert/Overtype modes, 51
Undo feature, 51
WordArt, 453
wrapping, 462
usernames, modifying, 772

drag-and-drop text, 62-63
dragging
columns, 339-341, 347
rows, 341, 347
shapes, 431
tables, 333
drawing, 419
canvases, 424-426, 471
lines, 422-423
objects
converting SmartArt to, 541
formatting, 438-452
modifying, 427-430
polygons, 423-424
scaling, 471
shapes, 421-422
tables, 334
Drawing Tools Format tab, 438
drop caps, 163-165
dummy text, inserting, 85
duplicate entries, searching, 581

E

E

effect
3-D
applying, 452
customizing, 410
artistic, applying, 402
bevels, applying, 515
drawing. See drawing fill, 281, 538
goal, 156-158
glow, applying, 514
modifying, 536
reflection, applying, 514
shadows, applying, 404-405, 452, 513
shapes
applying, 512
viewing 3-D diagrams, 536
SmartArt. See SmartArt
soft edges, applying, 515
text, 156-158
WordArt. See WordArt
elbow connectors, modifying, 428-429

elements
charts, 489-518
pages, repeating, 272-273
viewing, 14

{EditTime} field, 632

{DocVariable} field, 638
.docx files, 32
.dot files, 32, 286
dots per inch. See dpi
d.dotx files, 32, 286
{DocVariable} field, 638
.dot files, 32, 286
{DocVariable} field, 638
.dot files, 32, 286
dots per inch. See dpi
d.dotx files, 32, 286
double angle brackets (<><>), 570-571
double closing quote ("), 52
double opening quote ("), 52
double spacing, formatting, 179
double strikethrough text, 156
downloading files from SkyDrive, 844-846
dpi (dots per inch), 381, 397
Draft view, 13, 49
drag-and-drop text, 62-63
dragging
columns, 339-341, 347
rows, 341, 347
shapes, 431
tables, 333
drawing, 419
canvases, 424-426, 471
lines, 422-423
objects
converting SmartArt to, 541
formatting, 438-452
modifying, 427-430
polygons, 423-424
scaling, 471
shapes, 421-422
tables, 334
drawing Tools Format tab, 438
drop caps, 163-165
dummy text, inserting, 85
duplicate entries, searching, 581

E

e-mail
documents, sharing, 786
hyperlinks, formatting, 598, 827-828
mail merge, 552, 557, 584
messages, creating forms within, 657
Word, sending from, 835-836
e-postage, applying, 323
edges
beveled, formatting, 406-407
soft, formatting, 406
vector graphics, 420
Edit Picture command, 469
Edit Recipient List button, 562
editing, 91
AutoCorrect entries, 110
automating, applying AutoCorrect, 106-112
blogs, 835
charts, 480
citations, 709, 712-713
clip art, 469-471
collaboration, 765-766
comments, 776-778
data ranges, 481
data sources, 569
dictionaries, 101-102
Equation Editor, 542-549
existing files, 852
grammar/spell checks
configuring, 91-97
customizing, 97-106
headers/footers, 273
hyperlinks, 599
images, cropping, 395-396
indexes, spell-checking, 759
macros, 870, 873-879
multilevel lists, 684
numbers, formatting, 371
PDF files, 792
properties, 44
Read Mode, 783-785
read-only, restricting, 799-801
records, excluding, 577
revision tracking options, 766-772
sources, 708
strings, field codes, 629
subdocuments, 695-696
tables, 336-346
templates, 293, 296
text, 49, 533
diagrams, 529
inserting special characters/symbols, 52-55
placeholders, 655
Redo feature, 51
Repeat feature, 52
switching between Insert/Overtype modes, 51
Undo feature, 51
WordArt, 453
wrapping, 462
usernames, modifying, 772

{EditTime} field, 632

drag-and-drop text, 62-63
dragging
columns, 339-341, 347
rows, 341, 347
shapes, 431
tables, 333
drawing, 419
canvases, 424-426, 471
lines, 422-423
objects
converting SmartArt to, 541
formatting, 438-452
modifying, 427-430
polygons, 423-424
scaling, 471
shapes, 421-422
tables, 334
Drawing Tools Format tab, 438
drop caps, 163-165
dummy text, inserting, 85
duplicate entries, searching, 581
ellipses (...), 52
em dash (—), 52
embedding, 593
data, 607-611
Excel, 376
files, 607-609
fonts, 149
objects, 594, 608, 611
video, 415
.eml (Windows Enhanced Metafile) files, 382
Emphasis styles, 214
en dash (-), 52
enabling
actions, 883
add-ins, 881
automatic hyphenation, 83-84
balloons, troubleshooting, 771
Click and Type feature, 58
custom dictionaries, 104
fields, 662
global templates at startup, 300
revision tracking, 772
translating, 118-122
Encapsulated PostScript. See .eps files
encoding languages, 823
Encoding tab, 823
Encrypt Document dialog box, 795
encryption, 794. See also security
applying, 796
folders, 796-797, 796-797
endnotes. See also citations
cross-references, 729
formatting, 717-726
inserting, 720
modifying, 723
navigating, 721
numbering, 691
positioning, 722
English, selecting, 92
Enter Text dialog box, 818
entering
AutoCorrect, 55, 110
comments, 776
data into tables, 334-335
field codes, 626-628
formulas, 368
mailing address blocks, 571
passwords, 795
sources, 704-709
symbols, 55, 49-50
values, margins, 253
entries
blogs, categorizing, 834
indexes
formatting AutoMark, 755-756
marking, 751-753
selecting specific, 760
TOCs
manually marking, 735-737
selecting defaults, 738-739
Envelope Options dialog box, 557
envelopes
addresses
formatting, 318-323
positioning, 320
fonts, modifying, 320
graphics, adding, 322
mail merge, 552
configuring, 558
formatting, 557
printing, 321
sizing, 319
.EPS (Encapsulated PostScript) files, 382
(Eq) field, 635
equal to (=) operator, 368
Equalize Character Height option, 518
Equation Editor, 542-549, 918
Equation Gallery, 548
Equation Options dialog box, 546
equations
fields, 634-635
formatting, 547
layouts, 545-546
objects, creating, 543
presets, inserting, 543
saving, 548
text, wrapping, 548
viewing, 545-546
Eraser tool, merging cells, 344
Error! Bookmark Not Defined message, 735
errors
bars
adding, 476-505
charts, 476-505
messages, troubleshooting
macros, 866-868
reports, sending, 905
syntax, troubleshooting, 628-629
evaluating readability, 80-81
Even Page section break, 250
Exactly value (line spacing), 179
examples, styles, 227-229
Excel
charts, copying, 477
data sources, selecting, 562-563
embedding, 376, 609
fixed-width data files, 560
syntax errors, 628
tabs, renaming, 563
worksheets, importing, 478
exceptions
AutoCorrect, managing, 109
per-user, restricting, 803
excluding records, 577
exclusion dictionaries, 104
executable files, linking, 597
existing data sources, selecting, 562
existing dictionaries, adding, 105

How can we make this index more useful? Email us at indexes@quepublishing.com
existing documents
master documents, inserting, 691-692
outlines, formatting, 672
subdocuments, separating into, 693-694
templates, saving as, 291

existing files
editing, 852
embedding, 607-609

existing macros, assigning keyboard shortcuts to, 871-872

expanding outlines, 674

expansion packs, XML, 907

exploded charts, 487

exponential trendlines, 504

Export tab, 8

exporting
from database programs, 373
interfaces, customizing, 893-894
styles, 242

Extend Selection feature, 339

extending
research tools, 123-125
selections, 60

eXtensible Markup Language.
See XML

extensions
disabling, 906-907
files
opening, 39
viewing, 31

F

Facebook, sharing documents, 786
FALSE() function, 370
Favorites lists, modifying locations, 28
Fax Setup dialog box, 137
faxing documents, 137-138
Featured heading, 290

features
fields, 623-624
master documents, outlines, 688-691
Office 2013, 916-918

feeding envelopes into printers, 321
Field dialog box, 626

Field Options dialog box, 626

fields, 623
{=}, 625, 635
{<<AddressBlock>>, 556, 561
inserting, 571
troubleshooting, 572
{Addressblock}, 638
{Advance}, 635
{Ask}, 587-589, 638
{Author}, 632
{AutoNum}, 634
{AutoNumLgl}, 634
{AutoNumOut}, 634
{AutoText}, 625, 637
{AutoTextList}, 637
{BarCode}, 634
bibliographies, 714
{Bookmark}, 601, 625
bookmarks, assigning, 662
codes
creating {IncludeText} fields, 618
deleting, 265
eediting strings, 629
headers/footers, 265
{IncludePicture} fields, 620
inserting, 594
manually typing, 626-628
troubleshooting syntax errors, 628-629
viewing, 627
{Comments}, 632
{Compare}, 630, 638
{CreateDate}, 632
customizing, 568
{Database}, 638
{Date}, 625, 631
dates, 631-632
disabling, 662
{DocProperty}, 633
documents, automating, 637-638
{DocVariable}, 638
{EditTime}, 632
enabling, 662
{Eq}, 635
equations, 634-635
{FileSize}, 632
{Fill-In}, 639
{Fillln}, 585-586
fonts, formatting, 642
formatting, 642-645
formulas, 634-635
{GoToButton}, 638
help, adding, 662
{Hyperlink}, 625, 636
{If}, 589-590, 630, 639
{If...Then...Else}, 589-590
{IncludePicture}, 620, 625, 636
{IncludeText}, 602, 610-620, 625, 636
{Index}, 625, 635, 756-758
indexes, 635-636
information
documents, 632-633
users, 633
inserting, 553, 624-631
keyboard shortcuts, 640
legacy, 648-649
{Link}, 625, 636
links, 636-637
{ListNum}, 634
{[Link], 612
{MacroButton}, 638
macros, running, 661
mail merge, 570-576, 638-639
{MergeField}, 639
{MergeRec}, 639
{MergeSeq}, 639
navigating, 623-624, 641
nesting, 629-630
{Next}, 639
{NextIf}, 639
{<<Next Record>>}, 575
{NextRecordIf}, 591
{NoteRef}, 625, 636
numbering, 633-634
numbers, specifying types, 643
How can we make this index more useful? Email us at indexes@quepublishing.com
fixed default fonts, specifying, 146
fixed-width data files, 560
Fleach-Kincaid Grade Level, 80
Fleach Reading Ease, 80
flipping
clip art, 468
objects, 430
floating images, 460. See also clip art
floors, charts, 473
flow, modifying diagrams, 526
flowcharts, 433-434
folded note cards, formatting, 327-330
folders. See also files
AppData, searching, 302
decrypting, 797
encryption, 796-797
moving, 27
My Documents as default save locations, 46-48
SkyDrive
moving, 847-848
renaming, 846
sharing, 850
templates, saving, 24
folds (book), configuring, 254-255
following hyperlinks, 595
Font dialog box, 144, 518, 532
spacing, modifying, 160
underlining, applying from, 155
Font list, 141
Font Substitution dialog box, 150
fonts, 129, 918
adding, 148
charts, modifying, 518
colors, customizing, 149-152
CSS, formatting, 821
default
configuring, 146
specifying fixed, 146
effects, 156-158
embedding, 149
envelopes, modifying, 320
fields, formatting, 642
Find Font dialog box, 75
kerning, 162
lines, spacing, 178
modifying, 141-145
numbers, 195
OpenType, 147-148
printing, 145
selecting, 139-142
sets
applying, 247
formatting, 248
styles, applying, 153-154
text, diagrams, 530-531
themes, 146-147
copying, 248
outlines, 678
TrueType, 147-148
web pages, modifying, 824
WordML, applying formatting, 141
footers
associating content, 273
formatting, 262-272
master documents, 690
web pages, saving as, 817
footnotes. See also citations
cross-references, 729
formatting, 717-726
inserting, 719
managing, 725
modifying, 723
navigating, 721
numbering, 691
positioning, 722
forecasting, trendlines, 505
Format Painter, 165-166. See also copying
Format Picture task pane, 399
Formats option, 738, 749, 762
formatting
addresses on envelopes, 318-323
advanced filters, 578-579
angles, 428-429
{Ask} fields, 587-589
AutoCorrect, 110-111
automatic backup copies, 905
AutoRecover, 901-903
balloons, 768-771
banners, 317-318
bibliographies, 703-704
blank documents, 18-20
blogs, 831-835
bookmarks, 602
borders
shapes, 439-440
tools, 356
building blocks, 86-88
cell margins, 358-360
characters, 139, 875
adding fonts, 148
adjusting spacing, 160-162
applying font styles, 153-154
AutoFormat, 168-173
case (text), 158-159
clearing, 165
comparing/revealing, 166-167
configuring default fonts, 146
copying, 165-166
creating drop caps, 163-165
customizing font colors, 149-152
embedding fonts, 149
highlighting text, 158-159
modifying fonts, 141-145
OpenType/TrueType fonts, 147-148
selecting fonts, 139-142
specifying fixed default fonts, 146
text/font effects, 156-158
theme fonts, 146-147
underlining text, 154-155
charts, 473-477
colors, 509
combination, 487-489
data labels, 493-495
data tables, 508-509
elements, 489-519
legacy, 477
legends, 492
modifying, 480-483
navigating, 473-476
positioning, 483-484
spacing, 517
styles, 509
templates, 478-480
titles, 490-491
trendlines, 501-504
types, 485-487
WordArt, 518-520
wrapping text, 483
citations, 746-747
collaboration, 766-772
color sets, 245-247
comments, 776-778
cross-references, 726-730
databases, exporting, 373
data sources, 566-568
data tables, 508-509
dates, customizing, 644
default formats, configuring, 912
diagrams, 535-540
documents, 249
accessing, 920-923
applying page
  backgrounds, 281
  borders, 283-284
  converting, 34
  Cover Page feature, 260-262
  headers/footers, 262-272
  inserting page breaks, 259-260
  linking, 598-599
  modifying margins, 252-255
  multiple columns, 277-281
  multiple indexes in single, 764
  numbering lines, 257-259
  page orientation, 255-256
  paper sizes, 256-257
  read-only, 798-801
  Read-Only mode, 41
  repeating elements on every page, 272-273
starting with templates, 287-291
templates, 20-24
vertical alignment, 257
watermarks, 274-277
drawing canvases, 425-426
e-mail hyperlinks, 594, 827-828
endnotes, 717-726
equations, 547
exclusion dictionaries, 104
fax modems, 96
fields, 642-645
fonts, 642
preventing from changing, 642
file-handling preferences, 45-48
files
  accessing, 920
  saving, 32
  selecting, 29-33
  web pages, 817
  [FillIn] fields, 585-586
folded note cards, 327-330
fonts
  charts, 518
  CSS, 821
  sets, 248
footnotes, 717-726
forms, 646-648
calculating, 659
content controls, 650-663
legacy fields, 655-663
formulas, order of operations, 371
frames, 315-316, 923
graphics, 921
gridlines, 501
hanging indents, 232
headings, 920-921
higher outline levels, numbering, 684-685
hyperlinks, 594-600, 921-922
colors, 596
creating by typing, 594-595
distributing document via, 787-788
hyphenation, 82-85

How can we make this index more useful? Email us at indexes@quepublishing.com
images
3-D, 406-407
adding alt text
descriptions, 414-415
applying styles, 403
artistic effects, 402
borders, 410
brightness, 398
contrast, 398
deleting backgrounds, 401
Figure Captions feature, 412-414
glow, 406
hyperlinks, 596-598, 827
modifying colors, 399-400
positioning, 390-393
presets, 403
reflection, 406
rotating, 407-409
shadow effects, 404-405
sharpening, 399
soft edges, 406
softening, 399
indexes, 731, 749-762
Column setting, 761
cross-references, 764-755
Formats option, 762
headings, 762
Language setting, 761
layouts, 761
marking multiple instances of text, 755
multiple documents, 762-764
multiple indexes in single documents, 764
Right Align Page
Numbers setting, 761
subentries, 753-754
Type setting, 761
labels, 323-327
line spacing, 177-180
linking, 612
lists, 175-177, 191-203, 680
AutoFormat As You Type, 192-193
bulleted, 192
pop-ups, 637
styles, 685-687
macros, 855. See also macros
assigning, 860-862, 871-872
availability, 868-870
configuring security, 880
creating Quick Access toolbar buttons for, 872-873
deleting, 870
modifying, 807
naming, 858
overview of, 855-857
planning, 857
recording, 858-865
renaming, 870
running, 866
saving, 858-860
security, 879-881
selecting creation methods, 856-857
manually applied, clearing, 511
margins, 130, 310
marks, modifying, 896-897
master documents
headers/footers, 690
indexes, 690-691
numbered notes/captions, 691
outlines, 691-694
styles, 688-890
TOCs, 690-691
math, 111-112
Mini Toolbar, 9
 multicolumn layouts, 828-830
multilevel lists, 681-684
numbers
customizing, 643-644
editing, 371
modifying, 195-198
objects, drawing, 438-452
outlines
numbering, 678-688
overview of, 669-672
theme fonts, 678
page number codes, 266-267
paragraphs, 175-177
aligning, 191
applying tab stops, 184-190
borders, 203-208
indenting, 180-184
outline levels, 677-678
preventing from breaking, 209-211
shading, 207-209
spacing lines, 177-180
Paste command with/without, 64-66
privacy, 810-812
records, 566
revision colors, 771
rulers, tab stops, 187
saving, 506
sections, 249-252
shapes, 538
SmartArt diagrams, 525-529
spaces between sentences, 100
styles, 215, 226-235. See also styles
clearing, 222-224
creating by examples, 227-229
viewing, 219
subdocuments, 694
table of authorities, 748-749
table of figures, 744
tables, 331, 350-361, 922-923
calculating, 367-372
captions, 364-365
converting text, 373-374
creating, 332-334
deleting, 341
editing, 336-346
entering data, 344-345
margins, 358-360
orientation, 361-364
sizing, 346-350
sorting, 366-367
tabs, 889-890
templates, 297-298
text
charts, 518-520
diagrams, 530, 533
directions, 497
finding/replacing, 75-76
linking, 596
shapes, 427
WordArt, 453
wrapping, 388-390
text boxes, 303-315, 923
themes, 243-248
time, customizing, 644
TOCs, 731-742
options, 738
presets from, 733-734
[TCl fields, 735-737
translating, 118-122
tusted locations, 805
unsupported file formats, 29
upside-down text, 329-330
vertical WordArt, 456-457
web pages, 818-820
CSS, 831
hyperlinks, 825-828
templates, 830
WordArt, 453-458
WordML, 904
forms, 623
calculating, formatting, 659
filling out, 665-666
fill-in only, restricting to, 801
formatting, 646-648
legacy fields, creating with, 655-663
navigating, 646-650
option buttons, applying, 660
printing, 667-668
saving, 666-667
security, 664-665
templates, saving as, 648
formulas, 521
AutoCorrect, 111-112
bookmarks, references, 372
entering, 368
Equation Editor, 542-549
fields, 634-635
order of operations, 371
tables, 368
fractions
built, creating, 163
stacked, 544
Frame dialog box, 316
frames
applying, 315-316
formatting, 923
freeform polygons, drawing, 423-424. See also polygons
French, 98
FTP (File Transfer Protocol), saving to, 28
full pages of labels, printing, 323
functions. See also commands
AutoCorrect, 111-112
math, 370
galleries, 9-12
Bibliography Gallery, 714
lists, formatting, 680
multilevel lists, adding, 685
general options, configuring, 898-899
General Options dialog box, 794
generating
AutoMark documents, 756
bibliographies, 704, 713-717
indexes, 756-760
table of authorities, 748-749
table of figures, 744-745
generation, modifying shapes, 538-539
GIF (Graphics Interchange Format), 380-382
GIF (Graphics Interchange Format). See GIF
graphs, 473. See also charts
greyscale, 380
greater than (>) operator, 368
greater than or equal to (>=) operator, 368
greeting lines, inserting, 573-574
gridlines, 14. See also lines
ts charts, applying, 501
text boxes, 315
groups
collapsing, 7
commands, populating, 892
Current Selection, 501
customizing, 889-890
shapes, 436-437
sharing, 788-789
Show, 14
gutters, configuring, 254-255
handles
line selection, 434
rotation, 431
hanging indents, 181-183, 232. See also indenting
How can we make this index more useful? Email us at indexes@quepublishing.com
hard-copy images, 378. See also images

<header> section, 824

headers
associating content, 273
master documents, 690
properties, modifying, 824
web pages, saving as, 817

headings, 920-921
bookmarks, adding, 602
cross-references, 730
indexes, formatting, 762
pages, repeating, 361
styles
applying, 216
outlines, 670
subordinate items, restarting numbering, 685
TOCs, modifying, 732
viewing, 290

height
Equalize Character Height option, 518
Picture Tools Format tab, 394
tables, formatting, 348-349

Height control, 432

Help system
fields, adding, 662
navigating, 16-17

hexagons, 441

Hidden and Empty Cell Settings dialog box, 480

hiding. See also viewing
columns, 480
elements, 14
revisions, 767-768
Revisions pane, 766
Ribbon, 6
rows, 480
styles, 241
tabs, 888-889
text, 156

hierarchies, diagrams, 522

higher outline levels, numbering, 684-685

highlighting text, 73, 158-159
Home tab, 5-6, 177
horizontal alignment, text in cells, 360
horizontal axes, 502
hours, 269. See also time
HSL (Hue/Saturation/Luminosity), 442
HTML (Hypertext Markup Language), 29, 32, 815. See also online content; web pages
round-tripping, 817
support, 816
Hue/Saturation/Luminosity. See HSL
(Hyperlink) field, 625, 636
hyperlinks, 593. See also linking
applying, 594-600
bookmarks
inserting, 603
linking in documents, 604-605
colors, modifying, 600
deleting, 600
documents, formatting, 598-599
editing, 599
e-mail, formatting, 598, 827-828
following, 595
formatting, 921-922
creating by typing, 594-595
distributing document via, 787-788
graphics, formatting, 921
images
adding, 827
formatting, 596-598
inserting, 92
text, creating, 596
web pages, creating, 825-828

Hypertext Markup Language. See HTML

hyphenation
automating, 83-84
formatting, 82-85
manual, 85

[IIF] field, 589-590, 630, 639
If...Then...Else field, 589-590
IF(x, y, z) function, 370

ignoring words (grammar/spell checks), 98

images, 377
3-D formatting, 406-407
alt text descriptions, adding, 414-415
anchors, applying, 390-391
artistic effects, applying, 402
backgrounds, deleting, 401
beveled edges, applying, 406-407
Bing searches, inserting from, 386
bitmap, 420
blogs, inserting, 833-834
borders, applying, 410
brightness, 398
bullets, formatting, 200-201
clip art, 381-382
applying, 458-460
modifying, 463-469
colors
depth, 379-380
models, 379
modifying, 399-400
compression, 397-398
contrast, 398
cropping, 395-396
diagrams, 524
digital photography, 377-381
Figure Captions feature, 412-414
files
inserting from, 382-384
types of, 380
fills, applying, 443-444
glow, applying, 406
headers/footers, inserting, 271
hyperlinks
  adding, 827
  formatting, 596-598
[IncludePicture] fields, 620
inserting, 382-387
linking, 382
Office.com, inserting from, 385
positioning, 390-393
presets, applying, 403
printing, selecting color models, 379
reflections, applying, 406
resizing, 393
resolution, 381
rotating, 407-409
scaling, 393
screenshots, inserting, 386-387
shadow effects, applying, 404-405
shapes
cropping, 445
inserting, 443-444
overlapping, 435
sharpening, 399
sizing, 378
SkyDrive, inserting from, 384
SmartArt, applying, 410
soft edges, applying, 406
softening, 399
styles, applying, 403
text, wrapping, 388-390
tiling, troubleshooting, 444
watermarks, creating, 276-277
importing
  interfaces, customizing, 893-894
  styles, 242
  worksheets, 478
[IncludePicture] field, 620, 625, 636
[IncludeText] field, 602, 610-620, 625, 636
increasing indents, 182

indenting
  hanging indents, 232
  lists, modifying, 203
  paragraphs, formatting, 180-184
[Index] field, 625, 635, 756-758
indexes, 731
  Column setting, 761
  conventions, selecting, 750
  cross-references, formatting, 754-755
  entries
    formatting AutoMark, 755-756
    generating AutoMark documents, 756
    marking, 751-753
    selecting specific, 760
  fields, 635-636
  Formats option, 762
  formatting, 749-762
  generating, 756-760
  headings, formatting, 762
  Language setting, 761
  layouts, formatting, 761
  master documents, 690-691
  multiple documents, 762-764
  multiple indexes in single documents, 764
  multiple instances, marking text, 755
  numbers, troubleshooting, 759
  Right Align Page Numbers setting, 761
  spell-checking, 759
  splitting, 760
  styles, defining, 762
  subentries, formatting, 753-754
  Type setting, 761
  updating, 759
  viewing, troubleshooting, 754
indicators, adding status bars, 51
information fields, documents, 632-633

Information Rights Management. See IRM
Info tab, 8
Ink feature, comments, 777
inline images, 388. See also images
inline mode, 548
input, alternative input devices, 920
Insert Chart dialog box, 476, 478, 489
Insert File dialog box, 617
Insert Greeting Line dialog box, 573
Insert Hyperlink dialog box, 596, 826
Insert mode, switching between Overtype mode, 51
Insert Picture dialog box, 382, 443
Insert Table dialog box, 333-334
Insert Word Field: Ask dialog box, 588
Insert Word Field: Fill-In dialog box, 586
inserting. See also adding
<<AddressBlock>> fields, 571
address blocks, 571-572
{Ask} fields, 587-589
bibliographies, 714
breaks into pages, 259-260
building blocks, 89-89
cells, 339-341
clip art, 458
columns, 339-341
comments, 776-777
content controls, 650-651
Cover Page feature, 260-262
cross-references, 605-606, 726
dates, 268-270, 658
diagrams, 524-525
dummy text, 85
dummy text, 85
dummy text, 85
endnotes, 720

How can we make this index more useful? Email us at indexes@quepublishing.com
fields, 553, 624-631

codes, 594

mail merge, 570-576

[FillIn] fields, 585-586

footnotes, 719

graphics, 875

greeting lines, 573-574

headers/footers, 264

hyperlinks, 92, 603

images, 382-387

from Bing searches, 386

blogs, 833-834

from files, 382-384

headers/footers, 271

[IncludePicture] fields, 620

from Office.com, 385

screenshots, 386-387

from SkyDrive, 384

in-text references, 704, 709-713

master documents into existing documents, 691-692

paragraphs into TOCs, 735

preset equations, 543

properties into documents, 270

reference marks, 719

rows, 339-341

section breaks, 250-251

shapes into images, 443-444

special characters, 52-55

structures, 544-545

tables

from Insert Table dialog box, 333-334

from Table menu, 332-333

temporary placeholders, 711
text

[IncludeText] fields, 610-620

text boxes, 304-305

time, 268-270, 658

video, 414-417

watermarks, 274-277

insertion points, 49, 58-59

installing

fonts, 148

Office 2013, 915
templates, 285

instances

Go To, 78
text

highlighting, 73

searching, 72

interactive content, inserting, 414-417

interactive grammar/spelling checks, 94-96

interchangeability, round-tripping, 817

interfaces

blogs, 832

commands

adding, 890-892
deleting, 892

customizing, 885, 900
calculating general options, 898-899
defining shortcut keys, 894-895

defining shortcut keys, 893-894

defining shortcut keys, 892-894

defining shortcut keys, 891-892

defining shortcut keys, 890-891

defining shortcut keys, 889-890

defining shortcut keys, 888-889

defining shortcut keys, 887-888

defining shortcut keys, 886-887

defining shortcut keys, 885-886

defining shortcut keys, 884-885

defining shortcut keys, 883-884

defining shortcut keys, 882-883

defining shortcut keys, 881-882

defining shortcut keys, 880-881

defining shortcut keys, 879-880

defining shortcut keys, 878-879

defining shortcut keys, 877-878

defining shortcut keys, 876-877

defining shortcut keys, 875-876

defining shortcut keys, 874-875

defining shortcut keys, 873-874

defining shortcut keys, 872-873

defining shortcut keys, 871-872

defining shortcut keys, 870-871

defining shortcut keys, 869-870

defining shortcut keys, 868-869

defining shortcut keys, 867-868

defining shortcut keys, 866-867

defining shortcut keys, 865-866

defining shortcut keys, 864-865

defining shortcut keys, 863-864

defining shortcut keys, 862-863

defining shortcut keys, 861-862

defining shortcut keys, 860-861

defining shortcut keys, 859-860

defining shortcut keys, 858-859

defining shortcut keys, 857-858

defining shortcut keys, 856-857

defining shortcut keys, 855-856

defining shortcut keys, 854-855

defining shortcut keys, 853-854

defining shortcut keys, 852-853

defining shortcut keys, 851-852

defining shortcut keys, 850-851

importing, 893-894

viewing, 895-897

groups, customizing, 889-890

navigating, 5-12

Quick Access toolbar, customizing, 888-887

resetting, customizing, 893

Ribbon, customizing, 888-889

SkyDrive. See SkyDrive TOCs, defining, 740

web pages, saving, 821

international support, 918

Internet, SkyDrive. See SkyDrive

Internet Explorer, 821. See also interfaces

intervals

AutoRecover, configuring, 48
default tab stops, modifying, 189-190

in-text references, inserting, 704, 709-713

INT function, 370

IRM (Information Rights Management), 296

iron-on transfers, printing, 135

italics, applying, 153-154

items

outlines
demoting/promoting, 671-672

numbering, 678-688

subordinate, numbering, 679

J

JavaScript, 816

joining

shapes, 433
tables, 346

Joint Photographic Experts Group (JPEG files), 382, 822

jumping to bookmarks, 603

justifying text, vertical alignment, 257

K

Keep Original Formatting option, 748

Keep Source Formatting option, 64

Keep Text Only formatting option, 64

kerning, 162

keyboard shortcuts, 25. See also shortcuts

Cut, Copy, Paste commands, 63
deleting, 234
fields, 640
fonts

effects, 156

sizing, 143

hyperlinks, inserting, 596

interfaces

defining, 894-895

resetting customizations, 893

macros, assigning, 860-862, 871-872

mouse. See mouse shortcuts
Label Options dialog box, 323, 557
labels charts, applying, 493-495
data, 475
formatting, 323-327
mail merge, 552
configuring, 559-560, 574
formatting, 557
optimizing, 326-327
printing, 323-325
specifications, customizing, 325-326
landscape orientation, configuring, 255
Language setting, indexes, 761
Language Settings Tool, 918
languages dictionaries, modifying, 102
encoding, modifying, 823
grammar/spell check, 106
marked as wrong, 92
text, translating, 118-122
layers objects, 434-436
text, 434-436
Layout dialog box, 306, 484
Layout tab, 6
layouts. See also formatting bibliographies, 715
book folds, configuring, 254-255
equations, 545-546
flowcharts, 434
images, applying, 410
indexes, formatting, 761
multicolumn, formatting, 828-830
nonstandard, 285
Quick Layout button, charts, 490
SmartArt diagrams, 525-529
tables, 332. See also tables
tabular, 278
text boxes, formatting, 303-315
leading, 179. See also formatting; spacing
left indents, 181-183. See also indenting
left tab stops, 186
legacy charts, 477
legacy fields, 648-649, 655-663
legal blacklines, comparing documents, 780-782
legends, charts, 473, 492
less than (<) operator, 368
less than or equal to (<=) operator, 368
letters envelopes, adding, 318
mail merge, 552
formatting, 557
Mail Merge Wizard, 553-556
printing, 557
levels lists, modifying, 201-202
outlines. See also outlines formatting, 674
modifying TOC styles, 732
numbering, 679
paragraphs, 677-678
styles, 675-677
levels, 593-600
linking, 59-60
objects, selecting, 62
Open dialog box, 36
outlines, demoting/promoting, 671
paragraphs
formatting, 181
indenting, 182-184
resetting, 862
styles, 233-234
symbols inserting, 52-59
mapping, 57
tables, navigating, 335
text, entering, 50
underline styles, 154
.lex files, opening, 105
libraries, Numbering Library, 195
licenses, Creative Commons, 386
limiting hyphenation, 84
Line and Paragraph spacing button, 177
linear gradients, 447
linear trendlines, 504
lines. See also borders; text breaks, 50
columns, 280
drawing, 422-423
first line indents, 181. See also indenting
formatting, spacing, 177-180
greeting, inserting, 573-574
numbers, 257-259
outlines, demoting/promoting, 671-672
separator, modifying, 725
shapes, anchoring, 433-434
starting, 50
straight, modifying, 427
width, VML, 816
Linked style, 230
LinkedIn, sharing documents, 786
(Link) field, 625, 636
linking, 593-600
breaking, 616
distributing documents via, 787-788
documents, 604-605
executable files, 597
fields, 636-637
files, 612-616
modifying locations, 616
portion of, 613-614
formatting, 598-599, 612
images, 382, 596-598
objects, 594
text, 596
text boxes, 312-313
updating, managing, 614-615
How can we make this index more useful? Email us at indexes@quepublishing.com
video, 415
web pages, formatting, 825-828
List Library section, 680
{ListNum} field, 634
lists, 175-177
AutoFormat As You Type, formatting, 192-193
blogs, managing, 834
bulleted, 192, 527
customizing, 661
diagrams, 521
Favorites, modifying locations, 28
Files of Type, 39, 909
Font, 141
formatting, 191-203
indenting, modifying, 203
levels, modifying, 201-202
Master List, transferring sources, 709
multilevel
deleting, 687
editing, 684
formatting, 681-684
outlines, 678-680
My Templates, 479
numbering
restarting, 193-194
starting at, 194
options, 653
Outlook contact, 561
Places, 25
pop-ups, formatting, 637
Recent Documents, 35
styles, 681
creating, 231
formatting, 685-687
sorting, 239-241
tabbed, converting to tables, 189
Lists in Current Documents section, 680
literal symbols, 371
[ILink] fields, 612
locations
default custom dictionaries, 100
default save, configuring, 46-48
Favorites lists, modifying, 28
files, modifying links, 616
FTP, saving to, 28
macros
saving, 858-860
selecting trusted publishers/locations, 879-880
networks, saving to, 27-28
saving, 24-28
templates, 22, 291-293
trusted
configuring, 595
specifying, 805-806
Lock Aspect Ratio check box, 393
locking
anchors, 391
fields, updating, 640
subdocuments, 700-701
logarithmic trendlines, 504
logical conditions, macros, 877
Log On As dialog box, 28
lossless compression, 380
lossy compression, 380
lost features, saving as web pages, 817-818
lowercase, 158-159
luminosity, 442
Macintosh PICT. See .pct/.pict files
macro-based attacks, preventing, 804-807
{MacroButton} field, 638
Macromedia Dreamweaver, 815
macros, 855
deleting, 868
disabling, 906
documents, copying between, 868-870
troubleshooting, 866-868
fields, running, 661
formatting, 855
assigning, 860-862, 871-872
availability, 868-870
creating security, 880
toolbar buttons for, 872-873
deleting, 870
planning, 857
recording, 858-865
renaming, 870
running, 866
saving, 858-860
selecting creation methods, 856-857
locations, selecting trusted publishers/locations, 879-880
overview of, 855-857
security, 879-881
templates, running, 868
VBA, editing code, 873-879
Macros dialog box, 866
Mail Merge Wizard, 551
mail merge, 551
configuring, 552
customizing, 584-591
data sources, selecting, 563-569
directories, configuring, 575
documents
preparing, 569-570
selecting main document types, 557-560
e-mail, 584
envelopes, configuring, 558
fields, 570-576, 638-639
filtering, 576-581
labels, configuring, 559-560, 574
letters, Mail Merge Wizard, 553-556
overview of, 551-553
previewing, 553, 581-584
records
advancing, 591
assigning numbers to, 590-591
starting, 553
troubleshooting, 582
Mail Merge Recipients dialog box, 554, 561
Mail Merge Wizard, 553-556
mailing addresses. See addresses
Mailings tab, 553
main document types, selecting, 557-560
Manage Styles dialog box, 238-239, 688
managing
AutoCorrect, 109
blog lists, 834
charts, 479
dictionaries, 100-105
files
Save As dialog box, 27
SkyDrive, 843-851
footnotes, 725
IRM, 296
linking, updating, 614-615
outlines, 672-678
print queues, 135-136
SkyDrive, 843-851
styles, 218
manual column breaks, creating, 279
manual entries, marking TOCs, 735
manual hyphenation, 85
manually applied formatting, clearing, 511
manually typing field code, 626-628
mapping
documents, 79
symbols, shortcuts, 57

margins
cells
configuring, 358
formatting, 359-360
formatting, 130
gutters, formatting, 254-255
modifying, 252-255
presets, selecting, 252-253
tables, 358-360
text boxes, formatting, 310
values, entering, 253
Margins button, 252
Mark Citation dialog box, 746
Mark Table of Contents Entry dialog box, 736
Mark the Legend Key check box, 495
markers
indents, 183-184
nonprinting end-of-cell, 337
tab stops, applying, 184-190
marking
AutoMark, 751, 755-756. See also AutoMark
captions, 746
citations, 746-747
comments as done, 778
documents as final, 804
formatting, modifying, 896-897
index entries, 751-753
references
inserting, 719
moving, 720
revisions, 771, 801
master documents
existing documents, inserting, 691-692
formatting, 691-694
headers/footers, 690
indexes, 690-691
numbered notes/captions, 691
outlines, 688-691
paginating, 702
printing, 702
structures, modifying, 696-701
TOCs, 690-691, 743
Master List, transferring sources, 709
matching selections, updating styles, 235
math
AutoCorrect, 111-112
calculations, formatting tables, 367-372
Equation Editor, 542-549
formulas, 521
functions, 370
vector graphics, 419-421
matrices, diagrams, 523
MAX() function, 370
measurements, entering margins, 253
menus
Shape Fill, 445
Table, inserting tables from, 332-333
{MergeField} field, 639
Merge Formatting option, 64
{MergeRec} field, 639
{MergeSeq} field, 639
Merge to New Document dialog box, 557
merging
cells, 343-345
data merge. See also data merge
cell merge, 551. See also mail merge
shapes, 426
subdocuments, 698
messages
e-mail
creating forms within, 657
formatting mail merge, 557
mail merge, 552
Error! Bookmark Not Defined, 735
troubleshooting
macros, 866-868
.mht files, 32

How can we make this index more useful? Email us at indexes@quepublishing.com
MHTML (MIME-encoded HTML), 33, 817
.mhtml files, 32
Microsoft Expression Web, 815
Microsoft Forms 2.0, .NET Programmability Support, 918
Microsoft Graph, 477, 918. See also charts
Microsoft Office 2013. See Office 2013
Microsoft Query, 918
Microsoft SharePoint Foundation Support, 918
Microsoft templates, applying, 287-290
Microsoft Works, converting from, 910
MIME-encoded HTML. See MHTML
MIN() function, 370
minimizing Ribbons, 888
Mini Toolbar, 9
Mini Translator, applying, 120
minutes, 269. See also time
Mirrored setting (Margins button), 252
models
colors, 379
COM, 881, 907
modems, fax, 96
modes
Compatibility Mode, 286
display, 548
inline, 548
Insert/Overtype, switching between, 51
Read Mode, 783-785
special, opening files in, 40
Modify button, 227
Modify Style dialog box, 235, 732, 740
modifying
anchoring, 391, 434
AutoCorrect, 110
AutoFit, 346-347
axes
properties, 497
scaling, 498-500
blogs, 835
break settings for paragraphs, 210-211
cells, selecting, 336
characters in bulleted lists, 198-201
charts, 480-483
data ranges, 481-483
editing, 480
spacing, 517
trendlines, 501-504
types, 485-487
clip art, moving, 470-471
colors
cell backgrounds, 354-355
clip art, 463
diagrams, 537
connectors, 428-429, 434
curves, 429-430
datasheets, 478
default formats, 19
default tab stop intervals, 189-190
directions, text in text boxes, 313
documents
automating template changes to all, 300-302
editing templates, 296
effects, 536
files, linking, 616
fonts, 139, 141-145
envelopes, 320
selecting colors, 149-152
headers/footers
positioning, 270-271
properties, 824
hyperlink colors, 600
images
clip art, 463-469
colors, 399-400
cropping, 395-396
index styles, 762
languages
dictionaries, 102
encoding, 623
lines
spacing multipliers, 177-178
straight, 427
linking, updating, 614-615
lists
indenting, 203
levels, 201-202
locations, Favorites lists, 28
macros, 807, 866
margins, 252-255
marks, formatting, 896-897
master documents, structures, 696-701
numbers
axes, 501
formatting, 195-198
objects, drawing, 427-430
Office 2013, 916
properties, building blocks, 90
revisions, 766
section breaks, 251
separator lines, 725
shapes, 430
graph, 538-539
series, 516-517
SmartArt diagrams, 525-529
status bars, 896
styles, 215, 235-239
citations, 723
defining, 235
Manage Styles dialog box, 238-239
sets, 217-218
templates, 238
subdocuments, editing, 695-696
table styles, 352-353
tabs, 889-890	
task panes, 12
templates, 293-303
text
case, 158-159
diagrams, 529-534
directions, 361
highlighting, 158-159
spacing, 160-162
text boxes, shapes, 307-309
themes, 440
topics, outlines, 674-675
usernames, 772
views, Open dialog box, 37-38
web pages
default fonts, 824
sizing, 823
windows, 7
zooming, 14-15
modules
copying, 870
deleting, 870
renaming, 870
MOD(x,y) function, 370
months, 269. See also time
More Variations command, 400
mouse shortcuts
drag-and-drop, 63
objects, selecting, 60-59
moving
averages, 504
cells, 338
clip art, 470-471
columns, 339-343
files, 27
headers/footers, positioning, 270-271
images
inline, 388
positioning, 390-393
rotating, 407-409
insertion points, 58-59
objects, 430
Quick Access toolbar, 885
reference marks, 720
rows, 341-343
shapes, 540
SkyDrive, 847-848
subdocuments, 696
tables, 333, 375-376
tabs, 50
text
Cut, Copy, Paste
commands, 63-64
drag-and-drop, 62-63
Office Clipboard, 68-69
text boxes, 306-307
MS-DOS names, 43
multicolor gradients,
configuring, 446
multicolumn layouts,
formatting, 828-830
multilevel lists
adding, 685
deleting, 687
editing, 684
formatting, 681-684
multilevel outlines, 669,
678-680. See also outlines
multiparagraph text options,
652
multiple columns, applying,
277-281
multiple documents
combining, 782
indexes, formatting, 762-764
viewing, 15-16, 779-780
multiple headers/footers, 272
multiple indexes in single
documents, 764
multiple instances, marking
text, 755
multiple languages, grammar/
spell check, 106
Multiple Pages setting, 254
multiple TOCs, applying,
742-743
Multiple value (line spacing),
179
multiplication (*) operator, 368
multipliers, modifying line
spacing, 177-178
multisheet banners, 317-318
multisized points, 487
My Documents folder, default
save locations, 46-48
My Templates list, 479

How can we make this index more useful? Email us at indexes@quepublishing.com
New Column section break, 250
new documents, nondefault settings, 19
new features
alignment guides, 438
Border Sampler feature, 356
New Multilevel List dialog box, 681
New tab, 8, 19
New Window shortcut, 15
newsletters, inserting dummy text, 85
newspaper columns, 278, 817. See also columns
[Next] field, 639
[NextIf] field, 639
Next Page section break, 250
<<Next Record>> field, 575
[NextRecordIf] fields, 591
No Border setting, 355
No Markup, 767
nonblank documents, filtering, 577-578
nondefault settings, new documents, 19
nonprinting characters
tab stops. See stops tabs viewing, 176
nonprinting end-of-cell markers, 337
nonstandard layouts, 285
nonsupported browser features, disabling, 821
Normal.dotm file, 20
fonts, modifying, 146
macros, saving, 858
original versions, 303
troubleshooting, 302
viewing, 302
Normal setting (Margins button), 252
Normal style, redefining, 236-237
note cards
formatting, 327-330
templates, applying, 328
Notepad, opening .lex files, 105
not equal to (<> operator, 368
(NoteRef) field, 625, 636
notes, formatting numbers, 691
NOT(x) function, 370
Numbering button, 192
Numbering Library, 195
numbers
axes, modifying, 501
built fractions, creating, 163 charts, 473. See also charts
colors, defining, 152
columns, selecting, 280
data labels, formatting, 495
datatable/footnotes,
modifying, 723
fields, 633-634, 643
figure captions, 413
formatting
customizing, 643-644
editing, 371
modifying, 195-198
indexes, troubleshooting, 759
lines, 257-259
lists
bullet, 192
restarting, 193-194
starting at, 194
lists, spacing, 203
mail merge records, assigning, 590-591
negative handling, 371
pages, 678-688
notes, 691
outlines, applying, 367-368
adding codes, 265-266
formatting codes, 266-267
sorting, 366
telephone, actions, 112
O
Object dialog box, 613
objects. See also text
aligning, 437-438
bookmarks, adding, 602
captioning, automating, 414
COM, 881, 907
drawing
formatting, 438-452
modifying, 427-430
embedding, 594, 608, 611
equations, creating, 543
layers, 434-436
linking, 594
Rotate Objects button, 408
rotating, 430
selecting, 59-62
sizing, 430-432
SmartArt, converting, 541
OCR (Optical Character Recognition), 918
ODBC (Open Database Connectivity), 565-566
Odd Page section break, 250
.odt files, 32
Office 2013
365 SharePoint, accessing, 25
Clipboard, 63, 68-69
installing, 915
modifying, 916
tables, pasting from, 375-376
tools, 916-918
Office.com
clip art, searching, 459-460
images, inserting from, 385
shapes, searching, 422
templates, applying from, 288
Office Telemetry, 918
One Page zoom, 14
online content, 815
blogs, 831-835
CSS, formatting, 831
development, 815-818
formatting, 817-820
outlines

hyperlinks, formatting, 825-828
multicolumn layouts, formatting, 828-830
saving, 820-825
templates, formatting, 830

Online Picture command, 465
online videos, inserting, 415-416
Open and Repair mode, 40
Open as Copy mode, 40
Open Database Connectivity. See ODBC
Open dialog box, 36-38, 243, 293, 909
Open in Browser mode, 40
Open in Protected View mode, 40
Open tab, 8
OpenType fonts, 147-148, 162
opening
dialog boxes, 11
documents, 18-20, 35-41, 45
dialog boxes, 11
files
recently used files, 35-36
SkyDrive, 840
special modes, 40
Find and Replace dialog box, 71
.lex files, 105
macros for editing, 874-875
other file types, 39
print queues, 136
templates, 293
unsupported file formats, 39
Word, recovering files, 902

operators
addition (+), 368
division (/), 368
equal to (=), 368
greater than (>), 368
greater than or equal to (>=), 368
less than (<), 368
less than or equal to (<=), 368
multiplication (*), 368
not equal to (<>), 368
subtraction (-), 368
tables, 368

Optical Character Recognition. See OCR

optimizing
AutoCorrect, 108-110
grammar settings, 99
labels, 326-327
text boxes, 314

options
advanced filters, 578-579
AutoCorrect, 108-110
AutoFormat, 171
AutoRecover, 901-903
bookmarks, 590
building blocks, 655
buttons, 10
Capitalize Each Word, 158
check boxes, 654-655, 659-660
cross-references, 727-728
dates, 654
date/time fields, 269
digits, 371
documents, printing, 131-134
drag-and-drop, 63
drop caps, 164
envelopes, 558
Equalize Character Height, 518
fields, 568, 626
Find feature, 73-74
general, configuring, 898-899
If...Then...Else field, 589-590
groups, 889-890
If...Then...Else field, 589-590
images, cropping, 395-396
interfaces, 885
customizing, 900
Quick Access toolbar, 885-887
viewing, 895-897
layers, 435
lists, 193-194, 653, 661
macros, assigning, 855
mail merge, 584-591
paragraph text, 652
personalization, configuring, 898
positions, 392-393
privacy, 812
revision tracking, 766-772
Ribbon, 888-889
Rotate with Shape, 447
Styles pane, 221-222
TOCs, formatting, 738
translating, 118-122
trendlines, 504
Update Page Numbers Only, 735
web pages
saving, 820-825
selecting files, 822-823

Options tab, 8
Oracle databases, 564-565. See also databases
order of operations, formulas, 371
order of style applications, 214, organization charts, 527. See also charts
Organizer, 242, 869
orientation
pages, configuring, 255-256
tables, formatting, 361-364
original versions
Normal.dotm file, 303
revisions, 767
OR(x,y) function, 370

Outline view, 13, 49, 670
outlines, 669
copying, 688
items
demoting/promoting, 671-672
numbering, 678-688
levels
modifying TOC styles, 732
paragraphs, 677-678
styles, 675-677
lists, applying, 678-680
master documents, 688-694
overview of, 669-672
printing, 688
shapes, applying, 512, 538
TOCs, modifying styles, 732

How can we make this index more useful? Email us at indexes@quepublishing.com
topics, rearranging, 674-675
typing, 670
viewing, 672-678
Outlining feature, 669. See also outlines
Outlook. See also e-mail
contact lists, selecting as mail merge data sources, 561
Word, sending from, 835-836
overlapping shapes, 435
Overtype mode, switching between Insert mode, 51

P
<p> (paragraph tag), 831
Page Border Art, 918
{Page} field, 625, 634
Page Layout tab, 182
Page Range option, 752
{PageRef} field, 625, 636
Page Setup dialog box, 252, 257
pages. See also documents;
text
 backgrounds, applying, 281
book folds, configuring, 254-255
borders, applying, 283-284
breaks inserting, 259-260
modifying for paragraphs, 210-211
elements, repeating, 272-273
headings, repeating, 361
of labels, printing, 323
margins, modifying, 252-255
numbers adding codes, 265-266
formatting codes, 266-267
orientation, configuring, 255-256
starting, 50
tables, positioning, 361-364
thumbnails, 80
viewing, 896

Pages Per Sheet setting, 130
paginating master documents, 702
PaintShop Pro, 379
panes, 9-12, 532-533
paper. See also printing
both sides of, printing, 129
folded note cards, formatting, 327-330
sizes, 130 configuring, 256-257
mail merge, 557
note cards, 328
Paragraph dialog box, 178, 677, 732
paragraphs, 175-177. See also text
 anchors, 390. See also anchors
bookmarks, adding, 602
borders, formatting, 203-208
breaks, 50
formatting aligning, 191
applying tab stops, 184-190
indenting, 180-184
preventing from breaking, 209-211
shading, 207-209
hanging indents, 232
hyphenation, 83
multiparagraph text options, 652
outline levels, 677-678
<p> (paragraph tag), 831
starting, 50
styles, 213, 231. See also styles
TOCs, inserting, 735
parallelogram shapes, 309. See also shapes
parameters, separating, 629
partial TOCs, adding, 742-743
passwords
 assigning, 795
deleting, 795-796
documents, password-protecting, 794
read-only documents, 799-801
revisions, troubleshooting, 776
templates, 296
web pages, saving as, 817
Paste command, 63-66
Paste Special command, 67-68
pasting tables from Office applications, 375-376
paths, gradients, 447
patterns, 281
cells, applying, 354
fill effects, applying, 450
legends, 492
shading, 209
Pause Recording button, 864
.pct (Macintosh PICT) files, 382
.pcz (Compressed Macintosh PICT) files, 382
PDF files, 32
collaboration, 790-792
editing, 792
people, actions, 112
permissions
images, 386
sharing, deleting, 798
personal files, inserting video, 416-417
Personal heading, 290
personalization
options, configuring, 898
templates, 291
Personalize Your Copy of Microsoft Office section, 899
personal user templates, 293
per-user exceptions, restricting, 803
photography, overview of, 377-381
Photoshop, 379
phrases, adding bookmarks, 602
.pict (Macintosh PICT) files, 382
Picture Color Options command, 400
Picture Tools Format tab, 393, 460
pictures. See images
Pictures tab, 823
pie charts, 486
pixels, 378-379. See also images
pixels per inch. See ppi
placeholders
boxes, 545
temporary, inserting, 711
text, 530, 655
places, actions, 112
Places list, 25
placing
tab stops on rulers, 187
text, Click and Type feature, 58-59
plain text, 32
Autom corrective, 110
citations, converting, 713
planning macros, 857
plot areas, 475
plug-ins, actions, 918
PNG (Portable Network Graphics), 822
allowing, 821
files, 382
graphics, 822
points
anchoring, modifying, 434
charts, 487
connecting, toggling, 434
data, 473
fonts, 143
multisized, 487
text, formatting spacing, 179
uniform, 487
polygons, 421-424
polynomial trendlines, 504
populating
fields, forms, 647
groups, commands, 892
pop-ups list, formatting, 637
Portable Network Graphics. See PNG
portion of files, linking, 613-614
portrait orientation, configuring, 255
positioning
addresses on envelopes, 320
chart branches, 527
charts, 483-484
clip art, 463
diagrams, 541
endnotes, 722
headers/footers, 270-271
images, 390-393
legends, 492
presets, 391-392, 432
Quick Access toolbar, 885
shapes, 534, 540
text, 162
titles, 490
posting blogs, 833-835
PowerPoint, merging shapes, 426
power trendlines, 504
ppi (pixels per inch), 397
precise measurements, margins, 253
pre-drawn shapes, 421. See also shapes
preferences, file-handling, 45-48
preparing documents for mail merge, 569-570
presets
3-D rotation, 409
charts, 484
chart styles, 509
columns, applying, 279
data labels, 494

equations, inserting, 543
gradients, 446
images, applying, 403
legends, 492
margins, selecting, 252-253
positioning, 432
positions, 391-392
shadow effects, 405
text boxes, selecting, 305
TOCs
customizing, 741
formatting from, 733-734
WordArt, 454
preventing
ing read-only documents, 880
in subdocuments, 701
fields from changing formatting, 642
global templates from loading at startup, 300
macro-based attacks, 804-807
paragraphs from breaking, 209-211
rows from breaking across pages, 361
previewing
mail merge, 553, 581-584
outlines, 688
Print Preview, applying, 130
styles, 221
web pages, 818
previous versions, converting from, 909-910
{PrintDate} field, 632
{Print} field, 638
Printer tab, 837
Print Layout view, 12
Print Preview, applying, 130
Print tab, 8

How can we make this index more useful? Email us at indexes@quepublishing.com
printing, 91
  backgrounds, 282
  blank documents, troubleshooting, 136
  documents, 125-135
current documents, 125-130
customizing, 131-134
default print settings, 125
envelopes, 321
fields, updating, 640
fonts, 146, 148
forms, 667-668
images, selecting color models, 379
iron-on transfers, 135
labels, 323-325
letters, 557
mail merge, previewing, 581-584
master documents, 702
nonprinting characters, viewing, 176
outlines, 688
page orientation, configuring, 255-256
queues, managing, 135-136
troubleshooting, viewing fonts, 148
privacy, 810-812
process diagrams, 521
PRODUCT() function, 370
programming ActiveX controls, 681
promoting
  outline items, 671-672
  shapes, 527, 533
proofing tools, 91-97, 918
properties
  axes, modifying, 497
  building blocks, 90
  customizing, 44-45
documents, inserting, 270
fields, specifying, 626
files, applying, 41-45
frames, 317
headers, modifying, 824
printers, configuring, 134
text wrap, configuring clip art, 460-463
web pages, 824
Properties dialog box, 43, 824
Protected View, configuring, 808-810
protecting. See also security forms, 664-665
templates, 296
protocols, FTP, 28
providers, adding/deleting research, 124
punctuation, 100. See also grammar check
purchasing Word, 915
pyramid diagrams, 524. See also shapes
question marks (?), applying in indexes, 753
queues, managing printing, 135-136
Quick Access toolbar, 6, 918
  AutoFormat, 170-171
  buttons
    adding, 886-887
    deleting, 886-887
  commands, adding, 886
customizing, 20
  interfaces, customizing, 885-887
  macros
    assigning, 860-862
    formatting, 872-873
    naming, 858
  repositioning, 885
  Ribbons, collapsing, 888
  web pages, previewing, 818
Quick Layout button, charts, 490
QuickStyles, 217
{Quote} field, 636
radar charts, 486
radial gradients, 447
ranges, modifying charts, 481-483
[RD] field, 636, 762
readability
  evaluating, 80-81
statistics, 81
tables, optimizing, 343
Read Mode, 13, 783-785
Read-Only mode, 40-41
Read-Only Recommended check box, 795, 798
Really Simple Syndication. See RSS
reapplying styles, 220
rearranging topics in outlines, 674-675
rebooting, troubleshooting, 906
Recent Documents list, 35
recently used files, opening, 35-36
Recently Used Fonts, 142
recipients, searching, 580-581
Recognized Math Functions dialog box, 112
recognizers, configuring, 113-114
Recolor command, 400
recoloring
  clip art, 470
  images, 400. See also colors
Recommend feature, 239
Record Macro button, 858, 896
Record Macro dialog box, 858
recording macros
  formatting, 858-865
  planning, 857
records. See also databases
  advancing, 591
  excluding, 577
formatting, 566
mail merge, assigning numbers to, 590-591
sorting, 579-580
recovering
AutoRecover intervals, configuring, 48
files, 901-904
unreadable files, 904
rectangles, gradients, 447
redefining Normal style, 236-237. See also defining
Red/Green/Blue. See RGB
Redo feature, 51
references
fields, 587
citing, 703
cross-references. See also cross-references
formatting, 726-730
indexes, 752-755
fields, 636-637
in-text, inserting, 704, 709-713
marks
inserting, 719
moving, 720
table values, 372
[Ref] field, 588, 625, 636
Reflection effect, 158
reflections
applying, 514
images, 406
registered trademark (®), 52
registering blog servers, 832-833
rejecting
AutoCorrect corrections, 106-108
revisions, 774
relationships, diagrams, 523
Relative to Original Picture Size check box, 393
Remove Gradient Stop button, 446
removing. See deleting
Renew dialog box, 889
renaming
files, SkyDrive, 846
macros, 870
modules, 870
styles, 236
subdocuments, 696-698
tabs, 563, 893
templates, 480
reordering tabs, 893
repairing. See troubleshooting
Repeat feature, 52
repeating
elements on every page, 272-273
headings, 361
words, 98
repetitive tasks, 856. See also macros
Replace dialog box, 877
Replace feature, 69-77
replacing
AutoCorrect entries, 110
special characters, 76-77
text, 74
diagrams, 529
formatting, 75-76
reports, sending error, 905
repositioning Quick Access toolbars, 885
requirements, digits, 371
Research Options dialog box, 124
Research pane
documents, translating, 120
searching, 122-123
research tools
applying, 114-125
dictionaries, applying, 114-116
extending, 123-125
thesauruses, applying, 116-117
resetting
interfaces, customizing, 893
keyboard shortcuts, 862
Reset Window Position shortcut, 16
resizing. See also compression
clip art, 463, 470-471
columns, 347
diagrams, 540
dialog boxes, 26
drawing canvases, 425, 471
images, 393
objects, 430-432
Ribbon, 888
rows, 347
text
balloons, 771
boxes, 306
resolution
images, 381
web pages, 823
restarting
list numbering, 193-194
numbering under headings, 685
Restrict Editing taskpane, 665
restricting
access to documents, 794-798
comments, 801
forms to fill-in only, 801
per-user exceptions, 803
read-only documents, editing, 799-801
style usage, 802-803
Resume Recorder button, 864
retrieving addresses, 322
return addresses, 322. See also addresses
Reveal Formatting button, 224
Reveal Formatting task pane, 167
revealing formatting, 166-167
reverse book folds, 255
reviewing. See also editing;
revisions
Read Mode, 783-785
revisions, 773

How can we make this index more useful? Email us at indexes@quepublishing.com
formatting read-only, 798-801
marking as final, 804
password-protecting, 794
preventing macro-based attacks, 804-807
privacy, 810-812
restricting access to, 794-798
saving with passwords, 794-795
forms, 664-665
hyperlinks, 595
macros, 866, 879-881
Protected View, configuring, 808-810
revisions, 774-776
subdocuments, preventing editing, 701
templates, 296
Select Contacts dialog box, 561
Select Data Source dialog box, 481, 566
selecting
cells, 336-338
chart elements, 510-511
clip art, 470
columns, 338-339
colors, highlighting, 160
data sources
Excel, 562-563
existing, 562
mail merge, 563-569
files, 631-639
fonts, 139-142
colors, 149-152
themes, 146-147
languages, 92, 119
line numbers, 258
macros
creation methods, 856-857
running, 866
main document types, 557-560
options, web pages files, 822-823
page backgrounds, 281
paper sizes, 256
presets
margins, 252-253
text boxes, 305
printers, 126
rows, 338-339
SmartArt diagram layouts, 526
solid-color shading, 354
styles, 216-220. See also styles
citations, 704-706
images, 403
tables, 338-339
templates, 288
text, 59-62
applying columns, 280
deleting, 50
themes, 244
trusted publishers, 806
trusted publishers/locations, 879-880
wrap text settings, 311
semicolon (;), 629
Send Backward button, 436
sending
documents, sharing, 911-912
e-mail from Word, 835-836
error reports, 905
faxing-138
sentences
case, 158
spaces between, formatting, 100
separating
arguments, 629
existing documents into subdocuments, 693-694
separator lines, modifying, 725
{Seq} field, 625, 634
series
data, 473
shapes, modifying, 516-517
servers, registering blogs, 832-833
How can we make this index more useful? Email us at indexes@quepublishing.com
services
  blogs, 831. See also blogs
  research tools, extending, 123-125
Set As Default button, 146
Set Default Paste command, 65
(Set) field, 639
Set Numbering Value dialog box, 194
Set Transparent Color command, 400, 465
sets
colors
  applying, 245
  formatting, 245-247
fonts
  applying, 247
  diagrams, 530
  formatting, 248
styles, modifying, 217-218
Setup, accessing, 916
shading
cells, 354
paragraphs, 207-209
shadow effects, 158
  applying, 452
  clip art, applying, 468
  images, applying, 404-405
Shape Fill menu, 445
shapes
  adding, 526-527, 533
  aligning, 434
  borders, formatting, 439-440
  clip art
    moving, 470
    recoloring, 470
  deleting, 527
  demoting, 527, 533
  drawing, 421-422
effects
  applying, 512
  viewing 3-D diagrams, 536
fill effects, 512, 538
formatting, 538
geometry, modifying, 538-539
groups, 436-437
images, cropping, 445
lines, anchoring, 433-434
merging, 426
modifying, 430
outlines, applying, 512, 538
positioning, 540
promoting, 527, 533
rotating, 540
searching, 422
series, modifying, 516-517
sizing, 540
styles, applying, 438, 511-512, 538
text
  adding, 427, 434
  positioning, 534
  text boxes, modifying, 307-309
  VML, 816
WordArt, transforming, 455
share permissions, deleting, 798
Share tab, 8
sharing. See also collaboration
collaboration, 785-790
documents, 911-912
files, 850
groups, 788-789
SkyDrive. See SkyDrive
sharpening images, 399
shortcuts
deleting, 234
fields, 640
fonts
  effects, 156
  sizing, 143
hyperlinks, inserting, 596
interfaces
defining, 894-895
resetting customizations, 893
keyboard. See keyboard shortcuts
macros, assigning, 860-862, 871-872
mouse. See mouse shortcuts
outlines, demoting, promoting, 671
Show First Line Only setting, 674
Show group, 14
Show/Hide button, 176
Show/Hide Detailed Summary button, 767
Show/Hide feature, 50
Show Levels option, 738
Show Page Numbers option, 738
Show Text Formatting setting, 674
signatures, digital, 813, 880
SIGN(x) function, 370
Simple Markup, 767
single closing quote (’), 52
single fields, inserting, 570-571
single labels, printing, 324
single opening quote (‘), 52
single paragraphs, applying borders to, 204
single spacing, 186
Size tab, 432
sizing. See also compression;
modifying
  clip art, 463, 470-471
  columns, 348
drawing canvases, 425, 471
  envelopes, 319
  fonts, 141-145
    diagrams, 531
    selecting defaults, 146
  images, 378, 393
  indents, 182
  multisized points, 487
  objects, 430-432
  paper, 130
    configuring, 256-257
    mail merge, 557
Ribbon, 888
shapes, 540
tables
  formatting, 346-350
  specifying, 348-349
How can we make this index more useful? Email us at indexes@quepublishing.com
starting

Word
disabling add-ins/ extensions, 906
recovering files, 902

statistics
readability, 81
word count, viewing, 82

status, configuring styles, 241

status bars
indicators, adding, 51
modifying, 896
views, switching, 13

stock charts, 486
Stop Recording button, 863, 865

stops, tabs
applying, 184-190
moving, 50

storage
macros, saving, 858-860
templates
accessing workgroups, 294-296
locations, 293

straight lines
drawing, 422-423
modifying, 427

strike-through text, 156
strings
field codes, editing, 629
text
finding, 70
spacing, 629

Strong styles, 214

structures
inserting, 544-545
master documents, modifying, 696-701

Style Gallery, 216-217, 227
Style Inspector, 223
Style Pane Options dialog box, 221, 226

{StyleRef} field, 637

styles, 213, 920-921. See also formatting
3-D, applying to diagrams, 535
applying, 215
Apply Styles pane, 220
areas, viewing, 224
automating, 229, 235
boundaries, 356
cascading, 237-238
charts, applying, 509
citations
modifying, 723
selecting, 704-706
clearing, 222-224
copying, 242
default TOCs, 738-739
default underline, 154
defining, 229-235
deleting, 217, 234
disabling, 221
drop caps, 163
elements, creating by, 227-229
fields, customizing, 652
fonts
applying, 153-154
assigning, 140
selecting defaults, 146
formatting, 219, 226-235
headings, outlines, 670
hiding, 241
images, applying, 403
indexes, defining, 762
keyboard shortcuts, 233-234
Linked, 230
lists, 681
deleting, 687
formatting, 685-687
Manage Styles dialog box, 238-239
managing, 218
master documents, 688-690
matching selections, 235
modifying, 215, 235-239
naming, 226-227
Normal, redefining, 236-237
numbers, 195
order of style applications, 214, 687
outline levels, 675-677
overview of, 213-215
paragraphs, creating, 231
previewing, 221
renaming, 236
restricting, 802-803
rules, customizing, 99-100
selecting, 216-220
sets, modifying, 217-218
shapes, applying, 438, 511-512, 538
SmartArt, applying, 535-536
Style Gallery, 216-217, 227
Styles list
sorting, 239-241
Styles pane
applying, 218-220
customizing, 221-222
table of authorities, 748-749
tables
applying, 350-351
defaults, 351
modifying, 352-353
templates, modifying, 238
themes, applying, 243-248
TOCs, defining, 740
WordArt
applying to text, 532
charts, 518-520
wrapping, 311

Styles list, sorting, 239-241

Styles pane
applying, 218-220
customizing, 221-222
examples, creating by, 227

subdocuments, 691. See also
documents
collapsing, 694-695
deleting, 696
editing, 695-696
existing documents, separating into, 693-694
formatting, 694
locking, 700-701
merging, 698
moving, 696
naming, 694
nesting, 698-699
renaming, 696-698
splitting, 699-700
viewing, 694-695
subentries, formatting indexes, 753-754
subordinate items, numbering, 679
subscript, 156
substituting fonts, 149
subtraction (-) operator, 368
subtypes, 485-486. See also types
SUM() function, 370
superscript, 156
support
round-tripping, 817
web technologies, 816
surface charts, 486
Switch Windows button, 15
switches
|IncludeText| fields, 619
|Index| field, 756-758
|TA| field, 747
|TC| fields, 735
|TOC| fields, 741
switching. See also navigating
between columns and rows, 483
between endnotes and footnotes, 722
between Inline/Display modes, 548
between Insert/Overtypemodes, 51
themes, 149
between views, 12-13, 50
Symbol dialog box, 54-55
|Symbol| field, 625, 635
symbols
automating, 55
bullets, formatting, 199
commas (,), 100
copyright (©), 52
double closing quote ("), 52
double opening quote ("), 52
ellipsis (...), 52
e m dash (--), 52
e n dash (-), 52
finding/replacing, 76-77
inserting, 52-55
line/paragraph breaks, 50
literal, 371
math, 542
numbers, 195. See also numbers
registered trademark (®), 52
closing quote (‘), 52
opening quote (‘), 52
trademark (™), 52
Synchronous Scrolling shortcut, 16, 780
synonyms, 116-117. See also cross-references
syntax
errors, troubleshooting, 628-629
macro commands, 875-879
rules, date/time fields, 269
T
Tab Leader option, 738, 748
tabbed lists, converting to tables, 189
Table menu, 332-333
table of authorities, 748-749
table of contents. See TOC
Table of Contents dialog box, 739
table of figures
formatting, 744
generating, 744-745
Table Options dialog box, 359
Table Properties dialog box, 348
Table Tools, 6
Table Tools Layout tab, 336, 346
tables
aligning, 362
automating, formatting
TOCs, 733
creating, 332-334
data, 475, 508-509
drawing, 334
Excel, embedding, 376
fields, 635-636
formatting, 331, 350-361, 922-923
calculating, 367-372
captions, 364-365
converting text, 373-374
deleting, 341
detailing, 336-346
entering data, 334-335
sizing, 346-350
sorting, 366-367
Insert Table dialog box, 333-334
inserting, 376-377
internal margins, 358-360
joining, 345
moving, pasting from Office applications, 357-356
multicolumn layouts, formatting, 828-830
nesting, 345-346
orientation, formatting, 361-364
selecting, 338-339
specifying, sizing, 348-349
splitting, 345
styles
applying, 350-351
creating, 231
defaults, 351
modifying, 352-353
Table menu, inserting from, 332-333
tab stops, 185
text, wrapping, 362-364
values, references, 372
tabs, 5-7
Backstage view, 7-8
Browser, 821
Character Spacing, 531
Chart Tools Design, 480
Chart Tools Format, 484
Custom, 441
deleting, 890
Developer, 298
drawing, 438
Encoding, 823
galleries, 10
Home, 177
Mailings, 553

How can we make this index more useful? Email us at indexes@quepublishing.com
modifying, 889-890
moving, 50
Outlining, 675
Page Layout, 182
Pictures, 823
Picture Tools Format, 393, 460
renaming, 563, 893
reordering, 893
Size, 432
Standard, 152
stops
applying, 184-190
copying, 190
default tab stop intervals, modifying, 189-190
defining, 187-188
Table Tools Layout, 336, 346
viewing, 888-889
Tabs dialog box, 187-188
Tabular layouts, 278
{TA} field, 625, 635, 747
Tag Image File Format. See TIF files
tags, <p> (paragraph tag), 831
tasks
macros. See macros
panes, modifying, 12
{TC} field, 625, 635, 735-737
technologies, support, 816
telephone numbers, actions, 112
templates, 285, 906
accessing, 291
applying, 286, 298
automating, modifying all open documents, 300-302
blank documents, 20
charts, formatting, 478-480
customizing, 291
deleting, 480
documents
formatting, 20-24
modifying, 298-303
starting, 287-291
troubleshooting, 303
editing, 293, 296
formatting, 297-298
fonts, saving as, 648
global
applying, 299-300
enabling at startup, 300
preventing from loading at startup, 300
locations, 291-293
macros
running, 868
saving, 860
mail merge, applying, 569-570
Microsoft, applying, 287-290
modifying, 293-296
note cards, applying, 328
opening, 293
overview of, 285-287
protecting, 296
renaming, 480
saving, 291, 480
styles
copying between, 242
modifying, 238
themes, resetting, 244
types of, 286
viewing, 286
web pages, formatting, 830
workgroups, accessing, 294-296
Templates and Add-Ins dialog box, 883
temporary files, recovering, 901
temporary placeholders, inserting, 711
text, 5. See also documents; files
actions, applying, 112-114
aligning, Click and Type feature, 58
axes, turning off/on, 497
balloons, troubleshooting, 771
blogs, 831-835
body, 673
bookmarks, configuring, 590
building blocks, applying, 85-90
bullets, formatting, 199
captions, formatting tables, 364-365
case, 158-159
cells, aligning, 360
characters, 139. See also characters
classifying, 139
charts
formatting, 518-520
wrapping, 483
citations, converting to plain text, 713
clip art, wrapping, 460-463
comments, adding, 776-778
converting, formatting tables, 373-374
copying, 165-166
diagrams, modifying, 529-534
directions
formatting, 497
modifying, 361
drop caps, 163-165
dummy, inserting, 85
documentation, 49, 533
grammar/spelling checks, 91-97
inserting special characters/symbols, 52-55
Redo feature, 51
Repeat feature, 52
switching between Insert/Overtype modes, 51
Undo feature, 51
effects, 156-158
entering, 49-50
equations, wrapping, 548
faxes, inserting, 137-138
fields
configuring legacy options, 658
converting to plain text, 641
file-handling preferences, 45-48
Find and Replace dialog box, 70-72
footnotes, formatting, 717
formatting
clearing, 165
finding/replacing, 75-76
links, 596
grammarspell checks, customizing, 97-106
hiding, 156
highlighting, 158-159
hyphenation, 82-85
images, wrapping, 388-390
indexes. See indexes
inserting, [IncludeText] fields, 610-620
instances
  highlighting, 73
  searching, 72
in-text references, inserting, 704, 709-713
iron-on transfers, printing, 135
layers, 434-436
linking. See linking
margins, formatting, 130
moving
  Cut, Copy, Paste commands, 63-64
drag-and-drop, 62-63
  Office Clipboard, 68-69
multiparagraph text options, 652
multiple instances, marking, 755
navigating, 57-60
navigation panes, finding, 70
numbers, 195. See also numbers
online content, 815. See also online content
panes, applying, 532-533
paragraphs, 186. See also paragraphs
placeholders, editing, 655
placing, Click and Type feature, 58-59
positioning, 162
replacing, 74
research tools, applying, 114-125
saving, 24-34
scaling, 160
searching, Find/Replace features, 69-77
selecting, 59-62, 280
shades
  adding, 427, 434
  positioning, 534
sorting, 366
spell check, 91-92
starting, 18-24
strings, spacing, 629
styles, 218. See also styles
tables, wrapping, 362-364
text boxes
  modifying directions, 313
  wrapping, 311-312
themes, applying, 243-248
  translating, 118-122
typing, 49
underlining, 154-155
upside-down, formatting, 329-330
watermarks, inserting, 274-277
web pages, linking, 826-827
WordArt, formatting, 453
  wrapping, 335, 432
text boxes
aligning, 310
applying, 307
deleting, 307
formatting, 923
inserting, 304-305
layouts, formatting, 303-315
linking, 312-313
moving, 306-307
optimizing, 314
shapes, modifying, 307-309
text
  modifying directions, 313
  wrapping, 311-312
Text File Connection
Parameters dialog box, 564
Text Fill, 157
Text Outline, 157
textures, 281, 448-450
Theme Fonts, 141
themes, 213, 918
  applying, 243-248
  copying, 248
discuments, modifying effects, 536
glyphs, 146-147, 678
modifying, 440
switching, 149
Web, 918
thesauruses, applying, 116-117
thumbnails, viewing, 80
TIF (Tag Image File Format) files, 379-382
Tight text wrapping, 462
Tile Picture as Texture check box, 444
tiling images, troubleshooting, 444
time
  actions, 112
  AutoSave, configuring intervals, 903
codes, inserting, 268-270
customizing, 631, 644
fields, 631-632
inserting, 658
{Time} field, 625, 631
titles
  charts, 475
    adding, 490-491
    axis, 496
  outlines, 671
{TOA} field, 625, 635
{TOC} field, 625, 635, 740-741
TOCs (table of contents), 731
customizing, 737
default styles, 738-739
deleting, 735
entries, manually marking, 735
formatting, 731-742
master documents, 690-691
multiple, applying, 742-743
options, formatting, 738
outline levels, modifying styles, 732
paragraphs, inserting, 735
presets
  customizing, 741
  formatting from, 733-734
  styles, defining, 740
{TC} field, 735-737
updating, 734-735

How can we make this index more useful? Email us at indexes@quepublishing.com
toggle case, 158

toggling
connection points, 434
gridlines, 501

toolbars
buttons, adding, 20
macros, assigning, 860-862
Mini Toolbar, 9
Quick Access, 6, 918
adding commands, 886
AutoFormat, 170-171
collapsing the Ribbon, 888
customizing, 20, 885-887
formatting macros, 872-873
modifying buttons, 886-887
naming macros, 858
previewing web pages, 818
repositioning, 885
Ribbon, 5-7

tools
bibliographies, 703-704
borders, formatting, 356
Chart Tools Design tab, 480
collaboration, 765-766
Crop, 395
dictionaries, applying, 114-116
drawing. See drawing
Eraser, merging cells, 344
Freeform, 424
legacy forms, 655
macros. See macros
Office 2013, 916-918
proofing, 91-97
research, applying, 114-125
revision tracking options, 766-772
thesauruses, applying, 116-117
Windows Fax and Scan utility, 137

topics, rearranging, 674-675
Track Changes button, 766
Track Changes Options dialog box, 768-770

tracking revisions
enabling/disabling, 773
options, 766-772

trademark (™), 52

transferring
sources to/from Master Lists, 709
styles, 242

transforming WordArt shapes, 455

translating text, 118-122

transparent colors,
configuring, 465-466
trendlines
charts, modifying, 501-504
types of, 504

troubleshooting
add-ins, 883
<<AddressBlock>> fields, 572
AppData folders, 302
automatic backup copies, creating, 905
AutoRecover intervals, configuring, 48
backgrounds, printing, 282
balloons, 771
building blocks, 89
crashes, 905-907
documents, templates, 302
diagrams/footnotes, 721, 726
Error! Bookmark Not Defined message, 735
fields, updating, 640
files, recovering, 901-904
Help system, navigating, 16-17
hyphenation, 85
images, tiling, 444
indexes
numbers, 759
viewing, 753-754
macros
error messages, 866-868
viewing, 860
mail merge, 582
master documents, 689
Normal.dotm file, 302
Office 2013, 916
printing, viewing fonts, 148
print queues, 136
revisions
   passwords, 776
   viewing, 773
shapes, merging, 426
subdocuments, unlocking, 701
syntax errors, 628-629
TOCs, adding styles to entries, 739

TRUE function, 370

TrueType fonts, 147-148, 162

Trust Center dialog box, 805

trusted locations
customizing, 595
specifying, 805-806

trusted publishers, 806
searching, 880
selecting, 879-880

turning off. See disabling

Twitter, sharing documents, 786

two-sided printouts, 129
.txt files, 32

typeface. See fonts

Type setting, indexes, 761

types
   of adaptive technology, 919-920
   of add-ins, 908
   of alignment, 437
   of borders, 204
   of charts, 485-487
   of connectors, 434
   of content controls, 651
   of fields, 643
   of files, 39
   of images, 380
   of indents, 181
   of legacy form fields, 655
   of lines, 422
   of main documents, 557-560
   of note cards, 328
   of numbers, 501
   of readability evaluation, 80
   of revisions, 767-768
of section breaks, 250
of SmartArt, 521-524
of styles, 213
of tab stops, 186
of templates, 286
of trendlines, 504
typing
field codes, 626-628
outlines, 670
text, 49-50
  Click and Type feature, 58-59
  hyperlinks, 594-595
typography, modifying, 160-162
underline
hyperlinks, 600
text, 154-155
undo feature, 51
Unicode, 55
uniform points, 487
unlocking subdocuments, 700-701. See also locking
unreadable files, recovering, 904
unsupported file formats
  converting from, 911
  opening, 39
Update Automatically check box, 631
Update Page Numbers Only option, 735
Update Revision Count button, 767
up/down bars, adding charts, 507
uploading files to SkyDrive, 843
upcase, 158-159
upside-down text, formatting, 329-330
Use Hyperlinks Instead of Page Numbers option, 738
U.S. English, selecting, 92
Use Passim option, 748
{UserAddress} field, 633
{UserInitials} field, 633
{UserName} field, 633
users, information fields, 633
validating addresses, 581
value axis (Y axis), 473
values
  gutters, 254
  indenting, configuring, 181-182
  line spacing, configuring, 178-179
  margins, entering, 253
  R-squared, 506
tables, references, 372
VBA (Visual Basic Applications), 855, 918
digital certificates, 918
macros
  creating, 857
  editing code, 873-879
syntax errors, 628
VBScript, 816
vector graphics, overview of, 419-421
Vector Markup Language. See VML
Venn diagrams, 523. See also diagrams
versions
  automatic backup copies, creating, 905
  files, formatting, 31
  Normal.dotm file, 303
  previous, converting from, 909-910
  recovering, 901. See also recovering
text alignment
  configuring, 257
text in cells, 360
vertical axes, 502
vertical text, 314. See also text
vertical WordArt, formatting, 456-457
video, 377, 414-417
View Side by Side shortcut, 16
View tab, 6
viewing
  3-D diagrams, 536
  add-ins, 881
  AppData folders, 302
  comments, 777-778
  Developer tabs, documents, mapping, 79
  elements, 14
  equations, 545-546
  field codes, 265, 627
  files
    embedding, 609
    extensions, 21
fonts, troubleshooting, 148
formatting, 166-167
graphics, VML, 821
headings, 290
images, troubleshooting, 444
indents, customizing with rulers, 183-184
index codes, 753-754

How can we make this index more useful? Email us at indexes@quepublishing.com
interfaces, customizing, 895-897
macros, 860
master documents, 688
multiple documents, 15-16, 779-780
nonprinting characters, 176
nonprinting end-of-cell markers, 337
Normal.dotm file, 302
outlines, 672-678
pages, 896
page thumbnails, 80
Read Mode, 784
Recommend feature, 239
revisions, 767-768, 773
Revisions pane, 766
R-squared values, 505
Style Inspector, 223
styles
areas, 224
formatting, 219
subdocuments, 694-695
Synchronous Scrolling shortcut, 780
tabs, 888-889
tab stops, 188
templates, 286
trusted locations, 805
word count, 82
Word on computers without Word, 913
views
applying, 12-16
Backstage, 7-8, 35-36
documents, switching, 12-13
Draft, 13, 49
Open dialog box, 37-38
Outline, 13, 49, 670
Print Layout, 12
Protected View, configuring, 808-810
Read Mode, 13
Web Layout, 13
wireframe view, 487
viruses, macros, 879. See also macros; troubleshooting
visited hyperlinks, formatting, 600. See also hyperlinks
Visual Basic Applications. See also VBA
VML (Vector Markup Language), 816, 821-822
voice recognition software, 920

W

wall charts, 475
watermarks. See also images
deleting, 275
documents, formatting, 274-277
images, creating, 276-277
inserting, 274
Web Layout view, 13
Web Options dialog box, 820, 823
web pages, 32
blogs, 831-835
bookmarks, applying, 601-606
CSS, formatting, 831
default fonts, modifying, 824
development, 815-818
files
formatting, 817
selecting options, 822-823
formatting, 818-820
hyperlinks, 594-600, 825-828
multicolumn layouts, formatting, 828-830
online content. See online content
previewing, 818
properties, 824
saving, 33, 817-825
sizing, 823
templates, formatting, 830
web technology support, 816
Web themes, 918
what you see is what you get. See WYSIWYG
Wide setting (Margins button), 252

width
borders, 356
cells, 335
columns, 280, 350
lines, 816
Picture Tools Format tab, 394
tables, formatting, 348-349

Width control, 432
Windows
Desktop, 844
SkyDrive, 839-840
windows
documents, viewing multiple side-by-side, 779
modifying, 7
multiple, viewing, 15-16
Windows 8, SkyDrive, 839, 844
Windows Bitmap. See .bmp files
Windows Clipboard, 63
Windows Enhanced Metafile. See .emf files
Windows Fax and Scan utility, 137
Windows Metafile. See .wmf files
Wingdings, bullets, 200
wireframe view, 487
wizards, Mail Merge Wizard, 553-556
.wmf files (Windows Metafile), 382
.wmx (Compressed Windows Metafile) files, 382
Word
buying, 915
computers without Word, viewing, 913
data sources, selecting, 563-564
e-mail, sending from, 835-836
files, 607-609. See also files
level revisions, 783
SkyDrive, 844. See also SkyDrive
starting

disabling add-ins/extensions, 906
recovering files, 902
templates, applying, 287-290
Word 97-2003 templates (.dot), 286
Word 2010 documents, opening/saving, 45
WordArt, 419
aligning, 457
charts, 518-520
formatting, 453-458
shapes, transforming, 455
styles, applying to text, 532
text, formatting, 453
vertical, formatting, 456-457
word count, viewing, 82
WordML, 904
applying, 29-30
fonts, applying formatting, 141
Word Options dialog box, 48, 595, 772, 903, 911
grammar/spelling checks, configuring, 97
Paste command options, 65
WordPerfect
converting from, 910-911
Graphics. See .wpg files
Word Web App, 837
applying, 851-854
documents
editing, 852
starting, 853
words. See also text
bookmarks, adding, 602
Capitalize Each Word option, 158
custom dictionaries
adding, 101
editing, 101-102
hyphenation, 82-85
ignoring (grammar/spell checks), 98
repeating, 98
spell check, 91-92
workgroups
accessing, 294-296
templates, 293
worksheets
data sources, selecting, 562-563
embedding, 609
importing, 478
tables, embedding, 376
.wpg (WordPerfect Graphics) files, 382
.wps files, 32, 39
wrapping
Square, 462
text, 432
charts, 483
clip art, 460-463
equations, 548
images, 388-390
tables, 335, 362-364
text boxes, 311-312
WordArt, 453
Tight text, 462
Wrap Text setting, 388-390
WYSIWYG (what you see is what you get), 816

Y

Y axis, 473
years, 269. See also time
YouTube, inserting video, 415

Z

Z axis, 473
ZIP codes, entering, 571
zooming, modifying, 14-15

X

X axis, 473
[XE] field, 625, 635, 755. See also indexes
XML (eXtensible Markup Language), 29, 32
blogs. See blogs
document information
content controls, 633
schemas, 907
support, 816
unreadable files, converting, 904
WordML. See WordML
.xps files, 32
XPS files, collaboration, 790-792
X Y (scatter) charts, 486, 503

How can we make this index more useful? Email us at indexes@quepublishing.com